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Welcome to Homepage Builder

Thank you for purchasing IBM WebSphere Homepage Builder. IBM Web-
Sphere Homepage Builder (called Homepage Builder hereafter) is an appli-
cation that assists you in creating Web pages. It offers access to advanced
functions with a simple, easy-to-use interface.

You probably already know that you must use a special language called
HTML (Hypertext Markup Language) to create Web pages. HTML tags
consists of alphabetic letters and symbols. Does that mean you need to
know HTML to create Web pages? The answer is “No” Even if you do not
know HTML at all, Homepage Builder enables you to easily create your own
Web pages. If you have used a word processor, you can use Homepage
Builder right away, because the operations of this application are similar to
those of a word processor.

Homepage Builder includes accessory tools and provides a variety of sam-
ple files. If you want to create Web pages quickly, you can use the sample
files and templates that come with Homepage Builder. If you want to create
your own original image files, you can use the accessory tools called
WebArt Designer and Web Animator.

Enjoy creating dazzling Web pages with Homepage Builder!
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What you can do with Homepage Builder

Homepage Builder is software that enables you to create your own Web pages.
With Homepage Builder, you can edit pages, create your own materials, manage
sites, and upload files. Even if you are creating Web pages for the first time, you
can easily create attractive pages by using the materials and templates offered by
Homepage Builder.

This section introduces some examples of what you can do with Homepage
Builder. For detailed instructions, see each chapter in this guide.

Editing pages

By using the materials and templates—specially
selected combinations of materials—offered by

Homepage Builder, you can easily create Web
pages even if you do not know how to write HTML.

o{\

Related chapters a7 Lo
- Nt 9

Chapter 3, "Creating Web pages" Cong

Chapter 6, "Templates and materials" oz’
WELCOME TO MY HOMEPAGE e

eeeee

Cooking page

@

Mail

&1 Opening page fe [ [y Corpm

NISE

i If you do not want to use templates, you can create a Web page from scratch.

Related chapter

Chapter 8, "Pages and sites"
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You can enter text, create tables, and insert images with Homepage Builder as if you were
using a word processing editor. You can also edit images while editing pages.

Basics of tropical fish o
M

Tropical fish, as you know, inhabit the tropical sea. You o
therefore need a water heater to keep the water in yourd

aquasium at ¢ fixed warm temperature all the year round. d
a

Because the water in a tank cannot supply enough oxygend
for yous fish, you need an air pump. &

You should always keep the water tank clean. Set a filterel

device in it Lo zemove droppings, uneaten food, and wastes.

Entering text

Things you'll need |

o Device
o Water tank
o Filter

o Tropicalfish
o Neontetta
o Blackmolly

Decorating text

Creating a list

Related chapters

Chapter 9, "Editing text"
Chapter 10, "Creating tables"
Chapter 1, "Inserting images"

Specifying the heading

Inserting a horizontal rule to divide paragraphs

Creating a table

Water tank. «

(Prepate a robust one, made of either glass or acrylic
resin. An acrylic tank is light and easy to handle, bt is
wulnerable to scratches and scrapes. A glass tank, on
lthe other hand, must be handled with care, bt stays
cleat for many years

Inserting images

J
&

Food.

Various kinds of antificial fish faod ars available at
stores. Chonse the ons that is suitabls for your fish
Take sure you buy a fresh one

\Aquatic plants. ¢

\& guatic plants contribute to the looks of your water
tank. Because plants are photosynthetic, youll need a
light, 2 CO injection system, and a CO 5 diffuser.

You can associate two pages with a link so that a visitor to your Web site can jump from one

page to another.

Setting a link on text

Related chapter

Chapter 12, "Setting links"

Neon tetra

o T ESCEH I GEEIIES  Welcome to My Aquarum

Setting multiple links
on a single image

X



By using such advanced techniques as frames and forms, you can create sophisticated
pages.

@mﬁ@&@@‘%é
ey _chamvss it

Sio Adien b | semn Foees R el
| ey

Creating a question-
naire by using a form

Creating a logo

o ) B
© CTlis Web sie roducos e base o upcl s and ()

:‘nxhﬁm:ianﬁnymw@dm-mifmw ° d
@ JrmdntmTm | ) 2858 32 8 3
h . 5 . i 0 S e | s it Ky owses rin
& j T [Ecam - s ) iy Dot torrsin e
Questionnaire
| T ———— —
 Yes € No

2 How did youfind out about web site?
Splitting the Web browser window by Fom ey o

using frames i " neresting ™ Fai. ™ Not o iarsing I Bad

s comments about the web site

[ &

subri| [t |

[@70ere [ [Ny Compuier
Related chapter

Chapter 13, "Creating sophisticated pages"

N

By using such techniques as dynamic HTML, image rollover, and events, you can create
pages with motion.

Using dynamic HTML

) C:\My Documentsir ewpage htm - Microsoft Int._. [H[=] E3 2 C:\My Documentsinewpage.htm - Microsoft Int... =] E3
J File Edit Yiew BGb Favoites Help & J File  Edit Yiew Go Favoites |Help &
- =5 @ € J . 5 2 7a} ‘ 4
Back Foriad Stop Refresh  Home Sea Hach Farard Stop Refresh  Home Sea
JAddrass I@ C:\My Docmentsinewpage: him j H Links JAdd’ESS I@ C:\My Documentshnewpagg him j “ Liks
5 : |
F!ih l [
Place the mouse pointer here Setting an event Plact the mouse pointer here
H =
|@ Dot ‘@ ‘Welcome to my Web pagel y
Creating a rollover image —

Related chapter

Chapter 14, "Creating pages with motion"



i You can use style sheets to design your page.

B

© ' Basics of tropical fish ~

« « « « «Things you'll need - - . =

Related chapter

Chapter 15, "Using style sheets"

gsgegeeeese

« « « Typesoffishfor beginners . .

i You can edit the HTML source directly.

[eoocrvee. =703/ /0TD KT 4.0 Transstional//Ei">
fers

Ee
e, nane--cemEraToR
[T Travere /e

0.0 for Windovs">

Link="#FF3335" backgeound="tray b

Related chapter

Chapter 19, "Other useful functions" ("Editing HTML e
directly") e

</mBone>
|erasie>

Creating your own materials

By using the accessory tool called WebArt Designer, you can create such images as
logos, buttons, rollover images, and photo frames.

Creating a logo Creating a rollover image

Creating a button
Decorating a photo

image with a photo
frame

Related chapter

Chapter 17, "WebArt Designer"

X1



By using the accessory tool called Web Animator, you can create an animated GIF image,
which is a combination of multiple images that causes the animation effect.

o £ Yo B Sy irdon b

L R EERREEE

Creating an animation from text

Creating an animation from images

Related chapter

Chapter 18, "Web Animator"

Managing sites

The ability to manage your Web pages by the site makes it easy to upload and update your
files. For example:

* You can always check the link status of your site.

e |f you change the name or the position of a file, all the related links are automatically
updated.

e The site information is displayed on the Site tab. If you insert an image or set a link on
your page by using the page editing area, the Site tab is automatically updated.

e You can upload files by the site; that is, you can upload all the files that constitute your
site.

Related chapters

Chapter 2, "What are Web pages?"

Chapter 4, "Creating and uploading your site"

Chapter 8, "Pages and sites" ("Using multiple sites")

Chapter 12, "Setting links" ("Checking the link status of a site")

Chapter 16, "Uploading files" ("Site upload: Supplementary information")

Chapter 19, "Other useful functions" ("Checking errors in a site" and "Creating a site map")

xii



Uploading files

1 You can upload the files related to your Web pages to the server by one of the following
methods:

e Uploading files by the site (site upload)
¢ Uploading files by the page (page upload)
e Uploading individual files (file upload)

Related chapters

Chapter 4, "Creating and uploading your site"
Chapter 16, "Uploading files"

=5\ [he materials used in this guide are contained in the sample\manual folder o8 sie i Galen |
:)J)| under the folder where Homepage Builder has been installed. To use these

Folder Bookmark Histary

~ materials, select Manual materials from the Gallery tab, which is displayed on 5
the left side of the Homepage Builder main window.

[ e fies 1)

ORI

basics. fshhtm b 2gf b 2waf

b3gt b 3wgf boom. btopgf

b_top2gil backl.gi backZgi i fishgif

foodgl Loneglf iplantal |tankgif
‘ :] :] ) || <
a8 J1 -

View Setup Irsert
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How to use this guide

This guide explains how to use Homepage Builder. It has two parts: Part 1, "Learn-
ing the basics," and Part 2, "Applying Homepage Builder." Part 1 is intended for
readers who can do the basic Windows operations but are new to Homepage
Builder. It explains the basics of how to use Homepage Builder to create Web
pages. Part 2 is intended for readers who have become acquainted with the basic
operations of Homepage Builder. It summarizes the overall functions and guides
you in using the individual functions offered by Homepage Builder.

How this guide is organized

This guide contains the following chapters and appendixes:

e S R EETO TR G TR E T For first-time Homepage Builder users

Part 1 contains important and useful information for all users. It is recommended that all users read it.

Chapter 1 Installing and starting Homepage Builder

This chapter explains how to install Homepage Builder and start it.

Chapter 2 What are Web pages?

This chapter presents basic knowledge that novice users should have before using Home-
page Builder. It explains how the Internet works, what Web pages are, and the major steps for
creating Web pages. It is recommended that you read this chapter before and after doing
steps in Chapter 3 and Chapter 4.

Chapter 3 Creating Web pages

This chapter explains how to create multiple Web pages by using a template. This chapter is
written as a tutorial. If you follow the steps in this chapter, you will be able to understand the
overall procedure for creating Web pages.

Chapter 4 Creating and uploading your site

This chapter explains how to create a site for your Web pages and upload the files in the site to
the server owned by your Internet service provider. This chapter is also written as a tutorial.
After following the steps in Chapter 3, continue doing the steps in this chapter.

xiv



Chapter 5 Tips on using Homepage Builder

This chapter introduces some methods that help you use Homepage Builder effectively—for
example, changing the element attributes, using the right-click and drag-and-drop operations,
and canceling previous operations.

Chapter 6 Templates and materials

This chapter lists the templates and materials offered by Homepage Builder and explains how
to use them.

Part 2: Applying Homepage Builder For experienced Homepage

Builder users

Part 2 summarizes the overall functions provided by Homepage Builder and explains each typical function in
detail. Depending on what you want to do with your Web pages, read the related chapters.

Chapter 7 Summary of Homepage Builder functions

This chapter summarizes all the functions and menus provided by the Homepage Builder main
program and the accessory tools—File Transfer, WebArt Designer, and Web Animator.

Chapter 8 Pages and sites

This chapter explains how to manipulate pages and sites—for example, creating a blank
page, editing multiple pages at a time, and switching to another site.

Chapter 9 Editing text

This chapter explains how to enter and arrange text, specify a heading, insert a horizontal rule,
and create a list. It also explains how to import a text document created by use of another
application and insert it into a page.

Chapter 10 Creating tables

This chapter explains how to create a table and change the attributes of a table or a cell.

Chapter 11 Inserting images

This chapter explains how to insert an image file into a page. After inserting the file, you can
change its attributes or even edit it; for example, you can make a part of the image transpar-
ent.

XV



Chapter 12 Setting links

This chapter explains how to set a link on the text or image on a page so that visitors to your
Web site can jump to another page by clicking the text or image.

Chapter 13 Creating sophisticated pages

This chapter explains how to make your page more sophisticated by use of such techniques
as frames and forms.

Chapter 14 Creating pages with motion

This chapter explains how to bring motion into your page by use of such techniques as
dynamic HTML and rollover.

Chapter 15 Using style sheets

This chapter explains how to design pages by use of style sheets.

Chapter 16 Uploading files

This chapter explains how to upload Web-page-related files by the page or by the file to the
server owned by your Internet service provider. To upload individual files, you can use the
accessory tool called File Transfer.

Chapter 17 WebArt Designer

This chapter introduces how to create logos and buttons by use of the accessory tool called
WebArt Designer.

Chapter 18 Web Animator

This chapter introduces how to create an animation from text or images by use of the acces-
sory tool called Web Animator.

Chapter 19 Other useful functions

This chapter introduces some tips on using Homepage Builder—for example, how to edit
HTML directly.
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Chapter 20 Creating Web pages accessible to everyone
This chapter explains the things you should consider to make your Web pages accessible to
persons with disabilities.

Appendix

Appendix A HTML tags supported by Homepage Builder

This appendix lists all the HTML tags supported by Homepage Builder.

Appendix B Style sheets supported by Homepage Builder

This appendix lists all the cascading style sheets (CSSs) supported by Homepage Builder.

Appendix C Image file formats supported by Homepage Builder

This appendix lists and describes the image file formats supported by the Homepage Builder
main program, WebArt Designer, and Web Animator.

Appendix D Option settings
This appendix lists the options that you can set with the Homepage Builder main program,
WebArt Designer, and Web Animator.

Appendix E Troubleshooting
This appendix contains answers to frequently asked questions. It also explains how to use the
online help.

To find the information you want

@ To learn the overall functions provided by Homepage Builder, see Chapter 7.

@ If you want to do a particular task, or if you want to know what you can do with Homepage Builder, see the
table of contents, "What you can do with Homepage Builder" in the preface, or the index.

@ For information not included in this guide, see the online help. For instructions on how to use the online
help, see Appendix E.

® Each technical term is explained where it is first used and in the glossary at the end of this guide.
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Layout of this guide

A heading indicates the —
subject.

The HTML tags listed————

here are automatically
embedded in the HTML
file if you follow the proce-
dure described in this
section.

EEEEEEEE

O m—

2 EEEEEEEEEEEEEEEEEEEEE

— These are the lead-in
statements for the
heading.

EEEEEEEEEEEEEE
3. [T]
T
EEEEEEEEEEEEE
|

4.
EEEEEEEEEEEEEN

those described in

)

The numbers indicate
the sequence of the
steps.

— These are the panels
displayed during the
operation.

Icons used in this .
- Meaning
guide

Definition of a technical term
I Notes

&
= Tips

&

this guide.

Depending on the type of personal computer you are using, panels and their items might be different from

Sample Web browser windows in this guide are based on Microsoft Internet Explorer 50 and Netscape
Navigator 4.5 or later. Any information contained on the Internet is subject to change without notification.
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Notation used in this guide

Operations using the menu bar

In this guide, an operation that uses the menu bar is
explained as follows:

1. Click File --> Save on the menu bar.
This statement actually means to do two steps:

1. Click File on the menu bar.

o wWehSphere Homepage Builder -
File Edit “iew Fomat Insertt Ta

ﬂ ﬁﬂew Clil+M

Qpen... Chil+0
| @ Open URL...
|m (e Titre Lk .
Dd Open in Mew Window r

[ Eer i Frame...

=l Save Chl+5
Save s Chrl+wf
ﬁ Save Al
. Save Frame k

2. Click Save on the File pull-down menu.

File Edit “iew Fomat Insertt Table

ﬁ [ Mew Chrl+h E
T Template L
U = DOpen.. Chl+0 | —

| @ OpenUFL =
|m eIk c

Open in Hew Window k
[ Ees it Frame. ..

[ &

.
ks
Save Az Clrl+4f
Gl Save Al

Save Frame 3

Operations using toolbar buttons

In this guide, an operation that uses a button is
explained as follows:

1. ciick E

This statement actually means to do two steps:
1. Place the mouse pointer on B on the toolbar.

2. Click the left mouse button.

If the buttons are not displayed

If the button you want to use is not displayed,
the toolbar that contains it might be hidden.
To show the toolbar, click View --> Toolbar on
the menu bar and then click the name of the
target toolbar (there are several kinds of tool-
bars). A toolbar that has a check mark beside
it is already shown in the window.
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Operations using the mouse

Mouse operations are explained as follows:

Term

Meaning

Point

Place the mouse pointer on
the target object.

Click

Point to the target object
and press the left mouse
button once.

Right-click

Point to the target object
and press the right mouse
putton once.

Double-click

Point to the target object
and rapidly press the left
mouse button twice.

Move the mouse pointer
while holding the left
mouse button down.

Drag and drop

Drag an object and then
release the mouse button
at the target point.

Abbreviations

This guide uses the following abbreviations:

Abbreviation

Windows

Microsoft Windows 95, Win-
dows 98, Windows NT 4.0,
or Windows 2000.
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Part 1. Learning the basics

For first-time Homepage Builder users

This guide is composed of two parts: Part 1, "Learning the basics,"
and Part 2, "Applying Homepage Builder." Part 1 is for users who
know the basic operations of Windows but are new to Homepage
Builder. After reading Part 1, you will have the basic knowledge
needed to create Web pages—for example, what Web pages are,
how the Internet works, and the basic operations of Homepage
Builder. Because this part contains information that is useful for all
users, it is recommended that you look through the pages even if
you are acquainted with a Web browser or have experience with
other tools for designing Web pages.

Part 1 contains the following chapters. Chapters 3 and 4 walk you
through the basic procedure for setting up a Web site, from creating
sample Web pages to uploading them to the server.

Chapter 1. Installing and starting Homepage Builder . . ... .. 3
Chapter 2. Whatare Webpages?..................... 13
Chapter 3. CreatingWebpages ...................... 23
Chapter 4. Creating and uploading yoursite. . ........... 35
Chapter 5. Tips on using Homepage Builder. . ........... 45

Chapter 6. Templatesand materials . .................. 55






Installing and starting
Homepage Builder

Before you can start using Homepage Builder, you must first install the pro-
gram on your computer. This chapter explains the system requirements for
installing and using Homepage Builder, and describes how to install, start, and

end Homepage Builder.

System requirements .. ............... .. 4
Installing Homepage Builder ............. 5

Starting and ending Homepage Builder ... .9




System requirements

To install and run Homepage Builder, you need the following:

Operating system Microsoft® Windows® 95, Windows 98, Windows 2000,
or Windows NT® 40 (English version, Intel version).

Computer A personal computer on which one of the above oper-
ating systems runs.

CPU A Pentium® processor or later is recommended.

Memory 32 MB or more; 64 MB or more is recommended.

Hard disk For a minimum installation, you will need 50 MB or

more of free hard disk space. For a full installation,
which is the standard configuration for Homepage
Builder, you will need 200 MB or more.

Depending on the sample files installed, you might
need additional disk space.

CD-ROM drive A CD-ROM drive is required to install the program.

Display A monitor capable of 640 x 480 resolution (VGA) that
can display 256 or more colors is required. 800 x 600
resolution, High Color, or more is recommended.

Sound board To play sample sound files, a sound board supported
by the operating system is required.

@ To use the Preview tab—a tab that enables you to check how a Web page you are cur-
rently editing looks on a Web browser—you must have Microsoft Internet Explorer 4.0 or
50 installed on your computer.



Turn on your computer, and start Windows.

Insert the Homepage Builder CD into the CD-
ROM drive of your computer. If AutoPlay is
enabled on your computer, the installation pro-
gram starts automatically, and the following win-
dow appears:

¥ IBM WebSphere Homepage Builder Version 5.0 for Windows

Version 5.0 for Windows®
Refore Tnstallation

“Tutoral

U

PerfectPhoto Free Trial
HotMedia V2.5

CD Contents

Exi

If AutoPlay is disabled on your computer, fol-
low these instructions:

@0

a. Double-click My Computer on the desktop.

b.Double-click the CD-ROM drive icon, and
then the setup.exe file.

In the Opening window, click Installation . The

Setup dialog appears:

4.

5.

IBM WehSphere Homepage Builder Version 5.0 for Windows Setup [x]

Learning the basics

Installing Homepage Builder

This section explains how to install Homepage Builder on your computer.

‘whelcome ta the |BM YWebSphere Homepage Builder
Wersion 5.0 for Windows Setup program. This

= program will install IBM *webS phere Homepage
Builder Version 5.0 for Windows on your computer

It iz strongly recommended that you exit all ‘windows programs
befare running this Setup program.

Click Cancel ta quit Setup and then close any programs you
have running. Click Next to continue with the Setup program.

“wARANING: This program is protected by copyright law and
intemational treaties.

Unauthorized reproduction or distribution of this program, or any

portion of it, may result in severe civil and criminal penalties, and
will be prosecuted to the maximum extent possible under law

(k

Cancel

Click the Next button. The License Agreement
dialog appears.

Read the license agreement. To scroll the page,
use the scroll bar.

If you accept the license agreement, click the
Yes button to proceed with installation. (If you
click the No button, the installation is can-
celed.) The Choose Destination Location dialog
appears:

Choose Destination Location [ x]

Setup will install IBM ‘webSphere Homepage Buider Yersion 5.0
for Windows in the following falder.

Tuoinstall b this folder, click Next.

Tainstall to & different folder, click Browse and select another
folder.

You can choose rot ta install IBM WebSphere Homepage
Builder Yersion 5.0 for Windows by olicking Cancel to exit Setup.

" Destination Folder

C:\ABM ‘WebSphere Homepage Eullda( Bowse D

N
<ga.:k(|' Hews ) Caneal |

If you are using Windows NT, log in to the system as an administrator to install Homepage Builder.
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7. Verify the name of the default destination folder. 11.Verify the settings of your current installation.
If you want to use this folder, click the Next but- Click the Next button to copy Homepage
ton. If you want to use a different folder, click the Builder files into your hard disk.

Browse button, specify the folder you want, and

then click the Next button. The Setup Type dia- 12 Atter all files are copied, the Product Registration

log appears: dialog appears. Follow the instructions
described in the dialog to register your software.

Setup Type [x]

Click the type of Setup wou prefer, then click Nest.

After product registration, the Setup Complete

e dialog appears.

€ Compact  Progiam will be installed with minimurn required 13.C||Ck the Flnlsh button
options

€ Custom  Youmay chonse the options yeu viar ta el 14.Verify that the Homepage Builder program group
Recommended for advanced users,

appears in the Programs group under the Win-
dows Start menu.

15. Click Exit to close the Opening window.

< Back I Next > I) Cancel |
S /

8. The installation program provides you with three
installation options: Typical , Compact, and
Custom . Select one of them, and click the Next
button.

@ If you want to install all of the modules, includ-
=/ ing the online manual and tutorial, select Typi-
cal.

If you select Typical or Compact , the Start
Copying Files dialog appears. Skip to Step 11

9.« you select Custom , the Select Components
dialog appears:

Select Components [ x]
Select the companents you want ta install, clear the components
you da not want ta install
LComponents
: Programs

Sample Images

Sample Data

Templates
User's Guide

Description
’VFloglams of Homepage Builder

Space Requiredt 174720 K
Space Available: FBAEK
Back | Mew> | Cancel |

10.select the components you want to install, and
click the Next button. The Start Copying Files
dialog appears.
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Learning the basics

On the Setup Type dialog, you can select Typical, Compact , or Custom . Use the following table to deter-
mine which setup type you want:

Setup type Description

Typical This is the recommended setup type. You will need 140 MB or
more of free hard disk space to install all components. For
some systems, you might need more than 240 MB.

Compact Minimum configuration. Only the programs are installed. 50
MB or more disk space is required.

Custom You can select which components you want to install.
e Programs (50MB or more)

e Sample images (Gallery: 10MB or more)

e Sample data (Gallery: 2MB or more)

e Templates (30MB or more)

¢ Online manual in PDF format (20MB or more)

e Tutorial (30MB or more)

If you select Compact , templates and sample data are not installed.

-

To add components later

To add components after installation, run the installation program again, select Custom setup type, and
select the components you want to add.

To uninstall the program

To uninstall Homepage Builder, do the following:
1. On the Windows Start menu, click Settings --> Control Panel .
2. In the Control Panel folder, double-click Add/Remove Programs .

3. If your system is Windows 95, Windows 98, or Windows NT, select IBM WebSphere Homepage Builder
V5.0 on the Install/Uninstall tab, and then click the Add/Remove button. A confirmation message
appears.

If your system is Windows 2000, click the Change or Remove Program button, select IBM WebSphere
Homepage Builder V5.0 , and then click the Change/Remove button.

4. Click the Yes button.
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How to migrate settings from TopPage

If you have ever installed TopPage on your computer, the Migration of Settings dialog appears when you
start Homepage Builder:

i Migration of Settings [ x]

Settings from TopPage have been found. You can migrate the settings to use them with
Homepage Builder. Check the items that you want to migrate.

Settings to be Migrated
¥ TopPage site and server settings

¥ TopPage option settings

Application data from TopPage has been found. Because TopPage has been deleted from
yaur PC, you san delate this data safely. Unless you want ta mirate this data, it is
recommended that you delete it. [fthere s an data you want ta save in the following folders,
yau should capy it fo anather falder before deleting it

IV Delete the following folders

CAWINDOWS Application DatsBMA T opPage

[¥ Da nat show this dialog again

] cancel

If you select check boxes for the items you want to migrate and then click the OK button, the selected items
are migrated to Homepage Builder. (If a server profile, or file upload settings, with the same name already
exists, the profile of a newer version becomes effective.)

To remove the old data—created with TopPage—that may still be on your PC, select the Delete the follow-
ing folders check box and click the OK button.

If you select the check box for Do not show this dialog again  and then click the OK button, the Migration
of Settings dialog does not appear at the next startup. To display this dialog again, run the bin\hpbmig.exe
file in the folder where Homepage Builder has been installed.

To see the version information for Homepage Builder, start Homepage Builder, and click Help --> About
WebSphere Homepage Builder on the menu bar.




Learning the basics

Starting and ending Homepage Builder

When installation is complete, the Homepage Builder startup menu is added to the
Programs menu in the Windows Start menu.

Starting Homepage Builder
1. Click the Start button in the Windows taskbar.

2. Inthe Programs menu, click IBM WebSphere
Homepage Builder V5.0 to display the Home-
page Builder submenu.

'%Wlnduws Update
@ﬁ Hetsoape Smarlpdate

(Htocessories
(S Adobe Aciabat 4.0

Favories

@ Documents
line Services

B sornse .

{8 M5-D0S Prompt
v
3] windows Esplorer

emet Explorer
tscape Communicator
» (3 User Fiegist
» & 7web Page
3 wiehnt Designer
& wieb Arimator

(% Find
& oo
.

3. Click Homepage Builder to display the Home-
page Builder main window and the Welcome to
WebSphere Homepage Builder dialog.

|
|
|
Nosteis open.

8 sic & Galey

Crste o £ Page | st e | Open Evstng i |

[ Eaasanankea
0

23 Arivaon N
3 Bamer € Ciese apagefom a tenplte
2 ten

o feen ) Semaecentpuediie

L Image fies gitipg: .

Viewing the online tutorial

It is recommended that you view the online tutorial
when you first start Homepage Builder. The online
tutorial introduces Homepage Builder functions, and
guides you through the steps for using those func-
tions. If you selected the Compact setup type dur-
ing installation, or if you selected Custom and did
not select Tutorial , you cannot view the online tuto-
rial.

1. Inthe Welcome to WebSphere Homepage
Builder dialog, click the Start Tutorial button.
The online tutorial appears.

4 Flash
File Wiew Coniol Help

with

WebSphere®

Homepagé

Create dazzling Web pages in minutes )
Version 5.0 for Windows®
Wha ntroducing

g “Introducing Functional Features”» Functional Features"?

- Demo » This animation offers simple,
easily understandable
Instructions designed to give
you a quick overview of the
*..From Editing a Page to Transferring It to a Site » strengths of Homepage Builder
: n V5.0. Six menus are provided.
N E [

diting Images» Click the menu you want to
learn about. (With narration)

2. Follow the instructions on the tutorial panel.

1ap|ing abedawoH Bunreis pue buijeisul H



-
uslng the welcome to websphere Through this dialog. pou can create a new site. =
Homepage Builder dialog

Crcate o Edi Pge  Create Site | Qen Existing Site |

When you start Homepage Builder, the Welcome to T e B e i
WebSphere Homepage Builder dialog (called the DEnpE e
Welcome dialog hereafter) appears. This dialog _ _ _

Click the [OK] button to start the 'Wizard for creating a
enables you to start the task you want to do. sie

The Welcome dialog contains three tabs. By clicking
a tab, you can switch the contents of the dialog.

e Create or Edit Page tab: This tab contains the
following items: ok | coca | nep |

Create a blank page : Creates a blank page. If you click the OK button in this dialog, a wizard

Create a page from a template : Creates a that gLudesFyog thtrou?h creatlgg atnew sﬁe
page by using a template provided by Home- a_E)pears.C(h ortlns;uc ions onhow'to create a
page Builder. (For details, see Chapter 3.) site, see Chapter 4.)
Open a recently used file : Opens a page you e Open Existing Site tab: If you click this tab, a list
have recently edited. of sites appears. To open a site you have cre-

. ated, select it from the list.
Thiough this dialog, you can create a page or open one of the =
files pou recently edited.

Through this dialog. pou can open an existing site, |f pau

: select the check box at the battom of this dialog, the site you
select automaticaly opens an every startu
Create or Edit Page | Cleate Site | Open Existing Stz | v vee
i g —— = = Cieate or Edit Page | Create Sle  Open Existing Site |
N Homepage Existing sites
7~ Create a page from a template € e
Homepige
@ © Open a recently used file
Statt Tutarial
Start Tutorial
™ Do not show this dialog again
’TI Cancel | Help | ™ Open the selected site automatically on every statup
0k | Cancel Help

e Create Site tab: If you click this tab, the following
dialog appears: If you want the site you selected on this tab to

be opened automatically every time you start

Homepage Builder, select the Open the

selected site automatically on every star-

tup check box.

e While the Welcome dialog is displayed, you cannot do any operation in the main window. If you want to
close the Welcome dialog, click the Cancel button.

¢ |f you do not want to display the Welcome dialog every time you start Homepage Builder, select the Do
not show this dialog again  check box on the Create or Edit Page tab.
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To use the Welcome dialog, do the following:

1. Clickan appropriate tab.

2. Select the task you want to do. For example,
select Create a blank page .

‘Welcome to WebSphere Homepage Builder [x]

Thiough this dialog, you can cieate a page or open one of the
files pou recently edited.

Create or Edit Page | Create Site | Open Existing Sit |

Homepage

ks
™ Create a page from a template

@ © Open a recently used file
Stert Tutorial
™ Do not show this dialog again
0K | Camed | Heb |

3. Click the OK button. An action related to the
selected task item is taken, or a dialog for pro-
ceeding with the selected item appears. For
example, if you selected Create a blank page , a
new blank page as follows is created and dis-
played:

GE2 2 @el][& | & o= =l e

EEE B rulsse| L2 FHE R
X 5 Homd | KT Souce P Sandwd | B00Y

[ s sage s s

blank page

@ If the Welcome dialog is not displayed

Learning the basics

To display the Welcome dialog, first close any open sites, and then click File --> Open Opening Dialog on

the menu bar.

To display the Welcome dialog every time you start Homepage Builder, click Tools --> Options on the

menu bar, clear the Open the previous site at startup
Display the opening dialog at startup ~ check box.

check box on the General tab, and then select the

11
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Homepage Builder main window

If you click the Cancel button in the Welcome dialog, the Homepage Builder main window appears. The main
window consists of the Site/Gallery View on the left side and the page editing area on the right side.

Menu bar : ot - newpage1.him - Cocktail bar
—_—

You can access all the DrsReBsaac[o-EEERR e BeEe| & — a9 l—Toolbar

Ve =1 |8
functions of Homepage ‘ You can access fre-
Builder from the menu quently used functions
bar. from the buttons on the
toolbar.

Site/Gallery View.
The Site tab enables
you to manage the link —|

status anld the file status J@M\_Ij i

of your site. The Gal- o e o v

lery tab enables you to !EEE

select and insert mate- 0. e 6

rials on your Web page H.@ﬁ

opened on the right b bl bl
side of the window.

Page editing area

You can use this area to
open and edit your Web
pages.

b_ari01_. b_end1 . b_on01_. b_ani0]

E!—H—H—U

Selw qun

I_WW
|— Status bar

The status bar displays useful information, which changes depend-
ing on the status of the main window.

Ending Homepage Builder

To end Homepage Builder, click File --> Exit on the menu bar, or click E at the top-right corner of the main
window.
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What are Web pages?

This chapter presents basic knowledge that novice users should have before
using Homepage Builder. It explains how the Internet works, what Web pages
are, and the major steps for creating Web pages. If you are a novice user, you
may find the concepts of the Internet and Web pages a bit difficult to under-
stand, but once you understand them, you will find that creating Web pages
becomes much easier. It is recommended that you read this chapter before
and after you try out Homepage Builder.

How the Internetworks .. .............. 14
What are Web pages? ................ 16

General flow for creating Web pages . . . .. 21




How the Internet works

The Internet is a worldwide collection of networks connecting enormous numbers
of computers so that they can communicate with one another. You can use the
Internet for various purposes, such as exchanging e-mail (text messages and com-
puter files), viewing Web pages, and presenting your own Web pages. Homepage
Builder assists you in creating your own Web pages and presenting them on the
Internet. This section explains how the Internet works with respect to Web pages.

Viewing Web pages on a Web browser

A Web browser is an application that enables you to view Web pages on the Internet. A Web page
usually contains links to other Web pages. If you click text or image containing a link, you can view
another Web page.

Microsoft's Internet Explorer and Netscape's Netscape Navigator are the best known Web brows-
ers. If both Homepage Builder and Internet Explorer Version 40 or 50 have been installed on your
computer, Homepage Builder enables you to use the Preview tab, which simulates how the page
you are editing looks and behaves on the Internet without starting a Web browser.

URL: The address of a Web page

When you view a Web page, you must first enter the address for the Web page—a text string that
consists of alphabetical characters, such as "http://www.ibm.com/". This Internet address is called
the Uniform Resource Locator (URL), and it is used by Web browsers to identify and locate Internet
resources. If you are using Internet Explorer, type a URL in the Address field; if you are using
Netscape Navigator, type a URL in the Location field.

File  Edit Wiew Favorites Took Help |

S < P A

Back  Fuwad  Stop  Refiesh  Home Mal  Pint
| Adeless [ &1 hitp: 7 auwmn b com/ =] @G0 || Liks *

ce e

Search Favoites  History

A URL typed in the Address field (Internet Explorer)

# IBM Corporation - Netscape

File Edit Wiew Go Communicator Help

é@iﬂﬁadi@m

feck Fomed  Reload  Home  Seach  Metoape  Fint  Secuty  Shop  Stop
i " Bookmarks i Location: [ritp: /A ibm com/ | 7 what's Fielated

A URL typed in the Location field (Netscape Navigator)

Let's take a look at how a URL serves as an Internet address by taking http://www.ibm.com/soft-
ware/webservers/hpbuilder/ as an example. A URL specifies the protocol to be used in accessing
a Web page (http), the name of the server on which the Web page resides (www.ibm.com), the
path to the Web page (/software/webservers/hpbuilder/), and, optionally, the file name. Because
each URL is unique, you can access the target URL from anywhere in the world.
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Learning the basics

The role of the Internet service provider

Before the Internet had spread widely, organizations such as companies and schools established
their own communication networks for information processing—to distribute documents, to get
access to databases, and to train students. The Internet extends this concept. It connects individ-
ual networks to establish a "network of networks," which encompasses a worldwide range of com-
munication networks.

To get access to the Internet, individual users generally use a service provided by an Internet ser-
vice provider—a business that supplies Internet connectivity services to individuals, businesses,
and other organizations. After you make a contract with a provider, your personal computer can get
access to the Internet by making a phone call, or "dialing up," to one of the access points specified
by the provider. Once your computer obtains a dial-up access, you can view Web pages on a Web
browser, exchange e-mail, or transfer Web pages you have created from your computer to the
server.

¢sabed gapn ale reym H

service provider

individual ’ Internet

__F

telephone wires

The role of the server

Most providers offer you the option of having your own Web site. This service enables you to use a
certain amount of the hard disk space on a server computer owned by the provider. The provider
assigns a URL for each space. By preparing your Web pages on the server, you can make your
Web site accessible to others; by entering the specified URL for your Web site, they can visit your
site and read your Web pages.

To prepare your Web pages on a server, you must connect to the server and upload all the neces-
sary files. Homepage Builder maintains the information you need for the server access (for exam-
ple, the server name, the user ID, the password, and the destination folder) as file upload settings.
Once you specify all the necessary information, you can easily send files every time you update
them by using the registered setting.

15



What are Web pages?

Homepage Builder not only enables you to create Web pages but also enables you
to manage a collection of related Web pages as a site. This section explains the
concept of a page and a site—two essential keywords for understanding Home-
page Builder.

Understanding the structure of Web pages

Let us give you a simple metaphor. A house stands in a site. If you enter the front door (top page),
you can see several rooms (pages). Each room is connected to the adjacent room by corridors
(link). The interior of each room contains some furniture (elements). Some elements, such as the
floor (text), are attached to the room, whereas other elements, such as the pictures on the walls
(graphic files), can be taken out of a room to decorate another room.

' corridor=link
-

drawing=graphics image

floor=text

| front door=top page

| site (or house)=Web Site

The term Web page generally means both the Web site and the Web page. A Web site, which is
compared to a house in the above example, contains several pages, including the top page. Each
page is associated with a file. A page generally contains text and several images. Text is included
in a page, but graphics are prepared as separate files. A single graphic file can be referred to from
several pages. These pages are connected with each other by a mechanism called links.

front door=top page

room=page

site (or house)=Web Site

16



Learning the basics

A Web page is an HTML file

"To create a Web page" is actually "to prepare a file written in HTML." A Web page consists of a
Hypertext Markup Language (HTML) file—having the file extension of .htm or .html—with associ-
ated files for graphics and other materials. Files with either extension, .htm or .html, are both
treated as HTML files, but some providers allow only one of them. Before you start creating Web
pages, be sure to check with the provider to find out which file extension is recommended.

By default, the files created by Homepage Builder have the extension .htm. For instructions on how to
change them to .html, see page 28. This guide assumes that .htm is being used.

Because an HTML file is a plain text file, you can open and edit it with a text editor. If your Web
browser is Netscape Navigator, select Page source (or Document source ) from the View menu. If
your Web browser is Internet Explorer, select Source from the View menu. The source of the HTML
file, written in HTML code, appears in a text editor window.

&) o bl 1] - Notepad

B

Q G '3‘@-5
o | T Ao

2.2 482882

</sertpr>
cHeTR WE-1D

& v B comfinkslts e B o e v s [ [ enet ;l‘/'

An HTML file viewed on a Web browser The same HTML file viewed on a text editor

7

In the source, any text enclosed with brackets < > is the HTML code (for example, <!DOCTYPE
HTML...>, <HTML>, <HEAD>). Every Web page on the Internet is written in HTML, a computer
language that consists of many tags and attributes. Does this mean that you must know HTML to
create your Web pages? The answer is NO. You can create Web pages or a Web site easily with
Homepage Builder in the same way as you create documents with a word processor, without know-
ing any HTML. HTML tags need not concern you, because the required tags are automatically
embedded into the document.

The top page: The entry page for your Web site

A top page, also called a start page, is the entry point for your Web pages and often serves as an
index. For this reason, this page is typically named "index.htm." Some providers require that you
assign a predefined file name to your top page, so be sure to check with your provider about what
name to use.

17
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There is a mechanism called a link that enables you to jump from a page to another. By using the
link function, you can jump to another page just by clicking text or a graphics image where a link
has been set.

Cocktails

Link

Link

Cocktail bar

Link

Files referred to from an HTML file

You can insert many materials, such as graphics and sounds, into a Web page. Each material is a
separate file, associated with the page. If you insert many materials, your Web page consists of
many files, which consequently increases the time it takes for a user to open the page for browsing.

~

Welcome to |
Our Homepage
Cocktail bar e i

‘

Mail

A single HTML file can be associated with several materials

18



Learning the basics

Understanding Web sites

A Web site is the location where all the HTML files, graphic files, and other files related to your Web
pages are stored. For example, the Web site for IBM is http://www.ibm.com/. A Web site is actually

a folder (or a directory) on a Web server.

A server can have many folders. The provider supplies one of them (for example,

http://xyz.ilom.com/tom/) for use as your Web site. You can upload all the files related to your Web

pages into your Web site. Other people can then access your site through the Internet.

You Provider Other users
Other users' PCs
Your PC
= Server = I
- (where your site I
‘ resides) | |
Ve —- : Internet
Upload
—IE |
- -
— — |
Access the URL
URL of your site: http://xyz.ibm.com/tom/
http://xyz.ibm.com/tom/
Create your Web pages, using . : Access your Web site and
Homepage Builder, and upload Provides hard disk space view your Web pages on
the files to the Web site on a (site) you can freely use Web browsers
Web server
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To store your Web pages on your provider's server, you must first connect to the Internet and upload
the related files. Because the number of files that make up a Web site is usually large, it is difficult
for you to determine which files to upload; and after you determine them, it takes much time to

send files one by one.

Homepage Builder makes all this much easier. The site management function of Homepage
Builder enables you to create a virtual site in your personal computer and manages all the files by
the site. All you have to do is to create a folder dedicated to a site, save all the related files in it, and
register the site information (the location of the top page and the server information) with Home-
page Builder. The advantage of a virtual site is that your computer and the provider's server have
exactly the same set of files for each site. Once you create a virtual site in your computer, Home-
page Builder manages file updates for you. When you upload files, Homepage Builder determines
which files have been updated since the last upload, and sends only the updated files.

You Provider

Your PC

- — Provider's server

-------- | o r—
= Virtual site on your PC = Your site on the server
—_— —_—

o Top page o Top page
s 1t ]| = | W EE= O
<> <mEm>
—_— -
| |

Upload the entire site

or

Page 2 Page 3

Upload only the
Page 1 Page 2 updated files
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General flow for creating Web pages

You can create your Web pages in your own

way—you can write HTML tags, imitate another Create Web pages
user's Web pages, or use an application such as

Homepage Builder. Whichever method you

choose, your goal is to upload your pages onto '

the Web server and enable anyone to access
your Web site through the Internet (or Intranet).
Therefore, anyone who creates Web pages fol-
lows the steps shown on the right:

Upload files to the server

Homepage Builder offers a rich set of functions
that assist you in creating your original Web
pages. If you are going to create your Web pages
for the first time, however, you might wonder which
Homepage Builder functions could best help you.
Chapter 3 in this guide introduces a simple way of
creating Web pages. Chapter 4 explains how to
create a (virtual) site and upload the entire site. If
you do the same operations explained in Chap- A 4
ters 3 and 4, you are following the steps shown on
the right:

Create several Web pages
using a template

h

Create a site on your PC and register the
location of the top page and the server
information with Homepage Builder

h

Upload files to the server

If you have already created your Web pages, read Create a site on your PC and register the

Chapter 4 to learn how to create a virtual site on
your PC and upload the files. If you do the opera-
tions explained in Chapter 4, you are following the N

steps shown on the right:
Upload files to the server

21

location of the top page and the server
information with Homepage Builder
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Creating Web pages

This chapter introduces the easiest way to create your Web pages. If you are
a novice user of Homepage Builder, try the steps described in this chapter. As
you go through them, you will become acquainted with the basic operations of
Homepage Builder.

® You can use templates and materials only if you have installed
Templates, Sample Images, and Sample Data. However,
depending on the installation option, not all templates and
images may be installed on your PC.

e For instructions on how to use templates and materials, see
Chapter 6.

To understand the basic flow of page creation, read
the following sections in order:

%% Creating a framework of Web pages

R LU R by using atemplate .................. 24
Addeess [BY CMy DocumenssateTidexim =1 uiks
H Jkok Editngpages . ... 29
H 9 % Previewing your pages without
B = startinga Web browser .............. .. 33
;}:b:
WELCOME TO MY HOMEPAGE !
Cooking page =
-
|
&1 Opening page e | [T [ T=g My Computer 7

Note: The number of stars indicates the importance of the task. The most important tasks are marked with %% .




Creating a framework of Web pages by using a template

Creating a framework of Web pages by
using a template

~~

| Editing pages

~

Previewing your pages without starting
a Web browser

Starting Homepage Builder

To start Homepage Builder, do the following:

1. click start --> Programs --> IBM WebSphere
Homepage Builder V5.0 --> Homepage
Builder in the Windows taskbar. Homepage
Builder starts, and the Welcome dialog appears.

Crese orEditPage | Cieate St | Open Evistng e |
D @ Create a blank pagel
€ Create a page fom ateplete
] © opmaecentpusedtie

Start Tutoril

Using a template to create multi-
ple pages

Homepage Builder provides templates for creating
multiple pages and templates for creating a single
page. This section describes how to use a template
for creating multiple pages.

1. Onthe Create or Edit Page tab of the Welcome

dialog, select Create a page from a template ,
and then click the OK button.

24

A template consists of an optimum combination
of materials, which offers the easiest way for
you to create a framework of your Web pages.
This section explains how to start Homepage
Builder and then use a template to create Web
pages.

Welcome to WebSphere Homepage Builder [X]

LCreate new pages from one of warious templates.

Create or Edit Page | Create Site | Open Existing Site |

.
j  Create a blank page
L v
é & [Create 2 page hom & tenplatd

@  Open a recentl used file

Start Tutorial
I™ Do nat show this dialog again
0K | Concel | Hen |

The Template Wizard (Select Template) dialog

Template Wizard (Select Template)
Select Select Select Page
Template  Backgiound Color  Images Seltings
Lategory: Getre: Therme: Preview:
N ~ Business Cocklails
é Personal Boulique
5 chool Ditect stare
I Pages with motion | General store
[y Multiole pages |[styte sheet Grocery store
Dthers Computers and communicatic
b Global commurication
5| User templates Human resources
Hospital
N Scheduing
S Displa
o et Menep and graphs
Sparting gonds
S Beauy sdlon
Bonus templates e
Geneiic 1
Geneiic 2
Geneiic 3
Ditections and map
N — |
Finish ikt Net> | Cancel Help

2. From Category, select Multiple pages :
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: . This dialog enables you to specify the destina-

Select Select Select Page
Jferelte Backgmnd il mas - Setbe: tion folder for saving the files related to the
£D template you selected.

Category: G The

Preview

od Dreare 5. Select a drive from Drive , and then double-click
General store . .
j Bopde a folder in the Folder list.
(Global communication
Huran resources
N Hosplal Specify Folder EHE
Display MD eduling
5 . oney and graphs
environment Sporting goods
Bonus templates Beouly soon Folder:
Catalog 2
Company profle c:hmy documents
Frame 1
Frame 2
Frame 3
oy o |
by Dlocuments
Finish GHEECR I Mext> Cancel Help Cancel |

3. From Genre, select Personal . Then, from
Theme, select Cooking . A template named

Create Folder |

Cooking is selected. Diive:

Template Wizard (Select Template) I == j
Tee Backgonitoer s Seims |
ED

1. Select a drive.

Cetegary Gerre. Theme: Preview:

Singe page b 2. Select a folder by double-clicking it.
@? b4
e pages \yl . .
) s s by A To select a folder, be sure to double-click it.
B o ® You cannot select it with a single click.
Borus templates
6. Click the Create Folder button. The Create
Folder dialog appears:
| s [ a0 ) [ | ) [ . Type a new folder name, such as sitel

Create Folder E3

On the right side of the dialog, a preview of the

template is displayed. Isim
4. Click the Finish button. The Specify Folder dia- I
' : ok Cancel
log appears: |

Falder 8. Click the OK button. In the selected folder, a
s new folder named "site1" is created.

= et - 0K I
Cancel |

j Create Folder |
Hc j

Drrive:
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Specify Folder EHE

Faolder:
c:hmy documentzhaite

= eh ;I (1] 4 |

== My Documents

o
Diriwe:
I Hc j

9. Click the OK button. A top page titled "Cooking

page" opens in the page editing area.

Title of the page

Pl Ed Voo Fara et Tate Fians Sho Tods inion Hob

|D-sp@(S[dcre o~ TEDERE @E0 | Fa- =HEL D2

[FEEB sy scw|l oot wim=d =]

7 £ Homal | HTML Souco| Preven | Stniod |00V
=T
. £az . o
AMEE YD =
j2'@lele] = (£ %
EHEHZHE‘ WELCOME TO MY HOMEPACE =
EE Casking pase
] o o e
el &9 8 14
i =
Top page Page editing area

in the page editing area.

The top page is automatically named

‘index.htm." If you have changed the file

extension, it is named "index.html." To
change the file extension, see page 28.

® The title and the file name of the page being

edited appear on the title bar.

e As soon as the top page opens, all the files
related to this template—four HTML files
and all the image files associated with them

—are saved in the folder you selected.
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This template consists of a top page (the
A\ entry page for the entire Web pages) and
three subpages. Only the top page opens

Using a template to create a sin-
gle page

This section explains how to create a single page by
using a single-page template and save it in the folder
where you saved multiple pages in the preceding
section.

1. Click File --> Template --> New Page from
Template on the menu bar. The Template Wiz-
ard (Select Template) dialog appears:

Select Select Select Page
Template  Background Color  Images Settings

8

Direct store.

General store

Shyle shest Grocery stare.

Dihers Computers and communicatic

Pages with motion
Y hullple pages he

by Global commurication
5| User templates Human resources

Hospital
: Scheduing

w Displa

éﬁ crnorment Maney and graphs
Sparling goads

b Beauty salon

Borus tempiaes Monthly calendar
Geneic 1
Geneic 2
Geneic 3

Directions and map

N I— |
Firish e Net> | Cancel Help

2. Confirm that Single page is selected in the Cat-
egory field.

3. From Genre, select Style sheet . Then, from
Theme, select Herb teas. A template named
“Herb teas” is selected.

Select Select Select Page
Template  Background Color  Images Settings

Lategory: Getre: Therme: Preview:
At

e General store
Mobie phane
Nature canservation
Shapping 1
Shapping 2
Shapping 3

e
EE Multiple pages
User templates
-Zs Display
¥ ervionment
Bonus templates

S

[

Finish ekl New> |  Cancel Help

4. Click the Finish button. A page titled “Herb
teas” opens in the page editing area. This page
has not been saved.



150
9 T £0 Yon Far o 1ot fome St Lok o Lo sl
|D-2Rd|5 sEes o [CERD@E|Ee O || & =6 L
== EEE[B 7 u[& s8] -8 (% e ]aH e
€ Womsl | 4T S | Prven | Sterded [ BODY

The page opens.

Click File --> Save As on the menu bar. The

Save As dialog appears. The folder that con-
tains the pages you have created in the preced-
ing section is selected as the default destination.

Save As [Z]=]
Savejr‘ = sitel 5 - QI

index him

sublhtm

sub2.him

sub3 htm
File hame: Save I
Sawe as fype [HTML files [t~ i, shiml.* shim] =l Cancel

A

Unlike the pages created from a multiple-page
template, a page created from a single-page
template is not saved unless you save it
explicitly.

In the File name field, replace the temporary file

name with "sub4.htm."

Save As [ 7] ]

Save jn: I = sitel

EEEE

index. htm
subl.him
sub2 htm
sub3 htm

sevs |
=l Cancel )

File hame: ( [eubd bt )

Save a3 ype: IHTML files [*html:= htm;*.shiml ;= shtm)

Click the Save button. The Save Files dialog

appears:

Save Files
File Narne | Destination [ Copy [Fr
lecf_bait C:\My Dacumentshsiel Yer
cssl7_bagf C:iMy DocumentshsiteTs Yes
css07_m.gf Cihly Dosumentshsitelt Yes
< | |
~Change the selected i
File narme [
Destinatior: |
(O Gzttt dbove dstetan Browse. |

Learning the basics

o]

ancel | Hep |

This dialog lists all the files associated with the
page you just created from a template. The
dialog enables you to specify the location and
the file name of each file to be saved. The
default location is the place where the page
(HTML file) is saved.

8. Click the OK button.

27

sabed gapn Buneald H



Changing the file extension of HTML files

The extension for an HTML file is either "htm" or "html." The operating system called UNIX, which is widely
used among Web servers, typically uses "html." Some providers, however, recommend that you use "htm."

All the pages created by Homepage Builder initially have the file extension of "htm." To change the file
extension to "html," do the following:

1. Click Tools --> Options on the menu bar. The
Options dialog appears:

Edit Saurce | Site/Gallery View | Target Browser I Misc. |
General |Appsalance | Fonts | Metwork | File | Applications

¥ Open the Athibutes dialog after form parts are inserted

¥ Display the opening dislog at startup

¥ Delete cell contents when a table is deleted
I™ Create a paragraph with the Enter key

I™ Fomat HTML source automatically

¥ Comect HTML syntax erars autamatically

Iﬁhﬂw warning message box j
I™ Delete the image or object in focus when test is entered
I™ Insert alayout frame at the cursar position
I™ Open the Athibutes dialog with double-click
™ Insent consecutive space characters with the Spacebar

™ Open the Attibutes dialog when a file s dropped

Default backaround
Dl 1| [Moma| Peset |

"Default image map farmat ‘

The Options dialog enables you to specify £ Mesa £ CERN o Gl

various settings related to Homepage

Builder. k. I Cancel I Sprly I Help I

2. Click the File tab.

EditSouce | Sie/GaleryView | Tage:s Mise. |

General I Appearance | Fants I Metwdk  File IAlecatans

r— File option:

End-ofine code: hd

Suff for HTML fles [fam )

¥ Inset DOCTYPE
|<!DDCTYF’E HTML PUBLIC "-/Aw3C//DTD HTML 4.0 Trans

W Include GENERATOR in HTML source:

— Save option:
W Create backup file

W Create autosave file for every |3 operations

I™ Specify character encading [&uta] -
with META tag

oK I Cancel | Lppll Help

3. Confirm that the Suffix for HTML files field is set to "htm." Change this to "html."

4. Click the OK button. All the pages you create hereafter have the file extension "html."
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Creating a framework of Web pages by
using a template

.

| Editing pages |

v

Previewing your pages without starting
a Web browser

Entering text

In the preceding sections, you have created a total of
five pages. Two of those pages, sub4.htm and
index.htm, are open in your page editing area. This
section explains how to enter text in each of these
pages.

1. Type Return in sub4.htm as follows:

Feturr)

2. Click Window --> 1 _index.htm on the menu bar.
(The Window menu lists all the pages currently
open.)

Window Help
e window
LCazcade
Tile
drrange lcons
Cloze aAll

Page List. ..

-ooking page
|7 2 =ubd hir - Herb teas *

1 indes. bt - |

Learning the basics

Editing pages

Homepage Builder provides a rich set of text-
editing functions. This section briefly explains
some typical editing operations. For details,

see Chapters 8 through 15.

The top page (index.htm) opens.

WELCOME TO MY¥ HOMEPACE

Cooking page

2
)

72
z

2
/)

&

2ata

Hﬁn{.l:.

Hetb teas
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Setting links

This section explains how to set a link to another
page—for example, from the top page to its sub-
page and from the subpage to the top page. Using

these links, the reader can jump between two pages.

A link to the < } A link to the
subpage top page
Top page Subpage

Example: Setting a link from the
top page to its subpage

In the following example, you will set a link on the text
"Herb teas" in the top page (index.htm) so that it is
associated with its subpage (sub4.htm).

a»\ Even if you set a link, you cannot jump to the
9/ link destination on the Normal tab. To check
the link, use the Preview tab (read "Preview-
ing your pages without starting a Web

browser" on page 33).

1. Select the text "Herb teas" by dragging it. The
selected text is highlighted.

2. Click Insert -> Link on the menu bar. The
Attributes dialog appears:

30

Attributes

Tay  |Link =l

1o URL| ToLabel | Edail | Add Label | To Unsaved Pt | ¥

—File nam
Get URL from Browser ‘l Browse... |
—Taget
[
Event... Siyle...

ak. I Cancel | Help |

. Click the Browse button. The Open dialog

appears:

. Select sub4.htm . The File name field shows

sub4.htm.

Open HE
Lookint | 3 st = =1

File namme: ( [subd.bim ) Dpen |

Files of type:  [HTHL fles [* bt bt % shiml* shim) =] Cancel

2|

. Click the Open button. The File name field

shows file:///...sub4.htm.

Attributes

Tay  |Link =l

TaFiie | ToURL | ToLabel| EMail | AddLabel | To Unsaved P41 |

— File: pame
file: #44C: My Documents/site /subd. htm )
N

Get URL from Browser |

—Taget
Event... Siyle...
ak. Cancel Help




6. Click the OK button. The text "Herb teas" is
underlined. This underline indicates that a link
has been set on this text.

Example: Setting a link from a sub-
page to the top page

In the following example, you will set a link on the text
"Return” in the subpage (sub4.htm) so that it is asso-
ciated with its top page (index.htm).

1. Click Window --> 2 sub4.htm on the menu bar.
The file opens.

2. Select the text "Return’ by dragging it.

N LR B

I etutt

3. Click Insert --> Link on the menu bar. The
Attributes dialog appears:

4. Click the Browse button, select index.htm , and
click the Open button. The File name field
shows file:///...index.htm.

Attributes

Tag: IL\nk j

TaFile | ToUAL | ToLabel | E-Mail | 4dd Label | To Unsaved P« | #|

File name:
Ili\e 40 My Documents/site1 findes. htm )
Get URL from Browser | |Ernwse|

Target

[ [~
Ewvent.. Style... |
oK Cancel Help

Learning the basics

5. Click the OK button. The text "Return” is under-
lined to indicate that a link has been set on this

text.

Inserting an image on a page

The following example shows how to insert an image

to the left of the text "Return.”

1. Place the cursor at the beginning of the text

"Return.”
ALLCLR

2. Onthe upper part of the Gallery tab, click Icon

under Image:

aller Bookmarlk Hiztary
% Image ;I
23 Animation

(23 Banner J

Click here.
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3. On the file list in the lower part of the Gallery

tab, click image p_ico015.gif . A frame appears

around the selected image.

J - ¥ 3

Im Image files [.gif;.ipg;.png;.bmp;.wmf;.emf;.tij
—~ | =l

AECIE

picol0.. p_icoll... p_icall... p_ico0l..

g LI"—J -"-‘-"::f % -

picoll... p_icoll... p_colT T plico0l...

&) e | &

picoll... p_icol1... p_ico01... picol2...

"HEE

picol2 . p_icol2.. p_ical2 . p_ical2. .

ﬁjl W i -El LI
BB - =] @ .

Wi Setup Inzert

4. Click the Insert button | & . The image is
inserted to the left of the text "Return.”

A%

4

o

Saving pages
To save all of the open pages, do the following:

1. Click File --> Save All on the menu bar. The
Save Files dialog appears.

2. Click the OK button.

T\ For detailed instructions on how to edit pages, see Chapters 8 through 15 of this guide.
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Previewing your pages without starting a Web browser

The page editing area has three tabs: Normal,
HTML Source, and Preview. By clicking a tab,

Creating a framework of Web pages by
using a template

=~ you can switch the view of the page. For exam-
| Fditing pages | ple, if you click the Preview tab, you can easily
Ey——— pag'es T check how your pagg looks on a Web browser
| aWeb browser | without actually starting a Web browser.
2. To check the link from sub4.htm to index.htm,
The Preview tab simulates a Web click the text "Return" in sub4.htm.
browser et

By using the Preview tab, you can simulate the
appearance of your page as if you were looking at it
on a Web browser. In the following example, you will
check the link you set in the previous section.

('\\ The Preview tab internally uses the Internet

Explorer functions. To use the Preview tab,
you must have Internet Explorer 40 or 50
installed on your computer.

1. Open file sub4.htm , and click the Preview tab.
The preview of the page is displayed as follows:

The link destination page (index.htm) appears.
1. Click here.

I 3 To check the link from index.htm to sub4.htm,
re [—F click the text "Herb teas" on the top page.

o

Lo Recipes
Heth teas

| )

&4

2. Preview of the page appears. i o
The link destination page (sub4.htm) appears.

This page, which uses the style sheet technol-
ogy; is displayed properly on the Preview tab
only if Internet Explorer 4.0 or later is installed
on your personal computer.

(=
N\

&
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Instead of using the Preview tab, you can
actually start a Web browser to view the page
you are editing. (You must save the page
before starting a Web browser.)

e |f you have Internet Explorer installed on
your computer, select Tools --> WWW
Browser --> Internet Explorer on the menu
bar.

e |f you have Netscape installed on your com-
puter, select Tools --> WWW Browser -->
Netscape on the menu bar.

Different Web browsers interpret HTML tags
differently. A tag that is interpreted correctly by
one type of Web browser might not be inter-
preted correctly, or might be ignored, by
another type of browser. Moreover, a page
might look different on different versions of the
same browser. To view a page that uses style
sheets or dynamic HTML, you must have
either Internet Explorer Version 4.0 or later or
Netscape Version 4.0 or later installed on your
computer.

Closing pages

To close all the pages that you have open, do the fol-
lowing:

1. Click File --> Close All on the menu bar. All the
pages close, and the page editing area
becomes empty.

o Yon S0 Toos b
[0S E a5 S = e [E 2 B ) o) & = e
| |
|

sop ot

Page editing area



Creating and uploading your site

This chapter explains how to create a virtual site on your computer and upload
all the files in that site to the provider's server. This chapter assumes that you

have done all the examples in Chapter 3.

=\ Evenif you already have Web pages on the Internet, read this

\\Q/ Chapter 4 and create a virtual site on your computer. Once you
create a virtual site, you can easily update your Web pages on
the Internet.

Before doing the tasks in this chapter

1. Start Homepage Builder.
2. Read Chapter 3 to create multiple pages.

To understand the basic flow of creating and uploading
a site, read the following sections in order:

* %% Creatingasite ....................... 36
% %% Uploading yoursite ................... 40
Yk Viewing your Web site on a Web browser . .43

Note: The number of stars indicates the importance of the task. The most important tasks are marked with k% .




| Creating a site

.

| Uploading your site

.

| Viewing your Web site on a Web browser

1. Click Site --> New Site on the menu bar. The
Create New Site (Specify Site Name) dialog
appears. The Site name field contains the text
‘New Site1."

Create New Site
Specily Site Name

Specify a name for the new site. ¥ou can specity any name

Site name

< BEGE I Mext » I

Concel | Help

2. Change the site name. In this example, rename
it "Cooking Site." (You can use the default site
name, but it is recommended that you rename it
so that it represents the topic of your Web

pages.)

Create New Site
Specily Site Name

Specify a name for the new site. ¥ou can specity any name

Site name

Cooking Sits

cpeee [ Hews | cancel Help
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Creating a site

The pages you created in Chapter 3 consist of
a top page and its subpages—a typical Web
page structure. You can make Homepage
Builder recognize this structure as a site. This
section explains how to create a virtual site on
your computer so that you can easily manage
all the files related to your Web pages.

3. Click the Next button. The Create New Site
(Select How to Create Top Page) dialog appears.

4. Select Use an existing page as the top page

Create New Site
Select How to Create Top Pags

Specily how to create the top pags for your site

.
j © Create a blank top page
y

" Create atop page from a template

@@ Use an visting page s the top page )

—— =)

Details

Select top page

To configure the details of a site, click [Details]

< Back I Mext > I

Concel | Hep |

5. Click the Browse button. The Open dialog

appears.
Open
Look in: |ﬁ sitel j gl l__
index.htm
subl.hitmn
subZ hitmn
sub3 htm
subdhtm
File name: || Open I
Filez of type: IHTML files [* hitenl;* htm;*. skt shitm] j Cancel |/
7

6. From the Look in field, select the folder that con-
tains the files related to your Web pages. A list
of HTML files saved in that folder appears.

" If you created a new folder in Chapter 3, select
it.



/. From alist of files, select the name of the top
page (generally, it is "index.htm" or "index.html").

Open

=l 2 =lk

Loak jn I 2 sitel

File name:

|indé><.htm

Open I
j Cancel y

Files of bupe: IHTML files [* html* htm;* shtml:* shtm)

a»\ |If the top page uses the frame function, spec-
W4 ify the frame-setting page (an HTML file that
contains the <FRAMESET> tag).

8. Click the Open button. The file name of the top
page appears in the Create New Site (Select
How to Create Top Page) dialog.

Create New Site

Create New Site
Select How to Create Top Pags

Specify how to ereate the top page for your site

.
" Creats a blank top page
5
é € Create atop page hom afemplate
@ @ Lise an gisting page 25 the top page
C Select top page

To configurs the details of  site, click [Details]

Ay Documentshsite\index him

) B |
Details...

<Back | Mews | Cancel | Helo |

a»\ You can click the Details button to set detailed
\74 information on the site—for example, the loca-
tion of files for each file type.

Learning the basics

9. Click the Next button. The Create New Site (File
Upload Settings) dialog appears.

Create New Site
File Upload Settings

Minimum settings for site canfiguration have been completed

You may naw canfigure file upload seliings that will be used when you upload fies to
the server.

If you want to corfigure the ssttings later, click [Site] - [File Upload Settings] from the
menu

< Back I Mext > I

Cancel | Hep |

10.confirm that Configure the file upload set-
tings now is selected, and then click the Next
button. The Create New Site (File Upload Set-
tings) dialog appears:

Create New Site

Create New Site
File Upload Setings

Specify whether you want to create new fils upload settings or uss sristing settings

ate new settings

" Use existing seftings

<Back [ Fnsh |

Carcel | Helo |

11.confirm that Create new settings is selected,
and then click the Finish button. The Create
New File Upload Settings (Specify Name of File
Upload Settings) dialog appears:

Create New File Upload Settings

Create Hew File Upload Settings
Specity Hame of File Upload Setfings

Mame the new file upload settings. You can specily any name.

ook | Mewr | Cancel Help
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12.Confirm that the name of the site specified in
step 2 is displayed, and then click the Next but-
ton. The Create New File Upload Settings
(Specify Information for File Upload Settings)
dialog appears.

13.Enter the destination server name, the user ID,
and the password as you have been instructed
by the provider.

Create New File Upload Settings

Cieate New File Upload Settings
Specily Information for File Upload Setings

Spesify information on the server ta which you willuplosd fles

Destination gerver nams

|np ibm. net

User [

Imyusend

Password

<Back [ Mewt> | Concel | Help |

e Only the provider or the server administrator
knows the server name, the user ID, and the
password. If you have any questions, ask
your provider or the server administrator.

e |f you enter incorrect information in this dia-
log, you cannot upload your files. Note that
lowercase and capital letters are treated as
different letters (for example, "a" and "A").

e Atypical error is that an incorrect server is
specified as the destination server—for
example, a server for network connection of
your Web browser or an e-mail server. Be
sure to specify a server that manages Web
pages.

14.Click the Next button. The Create New File
Upload Settings (Specify Destination Folder)
dialog appears.

15.Specify the destination folder name as
instructed by the provider.
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Create New File Upload Settings

Create Mew File Upload Settings
Specify Destination Folder —

Specily the folder into which you wart to upioad your files.

Allthe files in your site, including the top page, are upleaded to the specified folder and
its subfolders,

Destination folder

public_hianl Brovse.
Detais.

cBack [ Finsh |

Carcel | Help |

Be sure to type the name as instructed by the
provider. For example, if you have been
instructed to place your data in public_html,
type public_html  in the Destination folder
field (do not precede the folder name with a
slash). If you have been instructed to place
your data in /home/username, type /home/
username .

Optionally, you can do detailed settings—for
example, the transfer mode and the firewall on
the server—by clicking the Details button.

16.Click the Finish button. A site is created, and
the file structure of the site is displayed on the
Site tab.

°8 site Hggtrater] Site tab
Folder
EI--E Caoking Site Site name
=] Top Pagel/index htr]
subl.htm | TOp page
subZ htm
sub3.htm
subd. bt Sprages
Files Linked by indes htm =l
UAL | Title
B subd.htm Bicycle ==
B sub3.htm Recommend
B subZ.hitm Let's make tF
B subl.htm Kitchen uten
ﬁ cook_ml.gif tdail lcon .
[ cook_IZ.gi Line Files referred to from
[Qycook 11 gif Line the selected file
cook_iT.gif lean
cook_iT.agif lcan
ﬁ cook_iT.gif lean
& coak_bag.gif [Background
[ cook_b1 gif Barner  —d—1
KN I
a8 - Fea @l -
Wiew Site operation  Insert




If any file related to your Web pages has not
been saved, the site may not be created cor-
rectly.

How to change the site settings
To change the settings of your site:

1. Click Site --> Site List and Settings on
the menu bar. The Site List and Settings
dialog appears.

Site List and Settings
Top Page Sit siyle Tola T
S i Wndew e | et
Ep :
21 1op pags
Open Edit add. | peets | Duplcate. |
Close Help
2. Select a site name.
Site List and Settings
[ Tos T
i | o
E@
21 1op pags
Debte | Dupcats.. |
Close Help

3. Click the Edit button. The Site Settings
dialog appears.

The Basic Settings tab enables you to
change the site name, the file name of the top
page, and the set of file upload settings. By
clicking the Edit button, you can edit items
related to the selected set of file upload set-
tings.

Site Settings

Basic Settings | Detaied Folder Setings | Other Setings |

~Basic sefling:

These settings are required for site configuration.

Site name

Top page

|c WMy Dosumentshsite\inds: htm Browse..
File upload settings to be used

[acking Site =l Edit..

K I Cancel Help

Learning the basics

The Detailed Folder Settings tab enables
you to change the location of files for each file
type.

Site Settings [ ]

Basic Settinds  Detailed Folder Settings: |D erSemngs|

- Location by file typ:

IZ: bl D ocume

HTML fie: i1y Browse (1]
[rEe i lm e
Java applet [EMy Dooumentsisiel | Browse (3.
Script: lm Browse 4]
Sound file [y DocumentsiateTs  Biowss )
Styls shest lm Browss [B]

i~ Top folder

Specify the top folder for the site.

C:\My Documentshsitel' Brawse,

The default is set to the folder containing the top page:

0k | Cancel | Heb |

The Other Settings tab enables you to set
other detailed settings.

Site Settings [ x]

Basic Seltingsl Detailed Folder Gettinds ~ Other Settings |

Path of image files and link:

1+ Helative to the working document dadf

[Example: "../._fimage foo.gif"]
" Relative to the document joot

(Example: "/imagefoo.gif")

Document root:

Browse
Default URL
“nnax html ‘

Site styl
(IV Apply the site style to a new page ‘

ok | cadd | Hep |

4, Change the settings, if necessary, and
click the OK button. The settings are
changed, and you return to the Site List
and Settings dialog.

5. Click the Close button. The Site List and
Settings dialog closes.

How to refresh the site information

If you add or delete files in your site by using a
program other than Homepage Builder, the
information is not reflected correctly in the Site
tab. To refresh the site information—that is, to
reflect changes to the site—explicitly, click Site
--> Refresh Site Information on the menu bar.
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| Creating a site

.

| Uploading your site

.

| Viewing your Web site on a Web browser

1. Click site --> Upload Site on the menu bar. The
Upload Page or Site (Specify File Upload Set-
tings) dialog appears:

Upload Page or Site

Prepare to Upload Files
Specily File Upload Setlings

o
7 Corfigure new file upioad settings

Specily & name for the seltings

i [ e | canel | Helo |

2. Confirm that Use existing file upload settings
is selected.

3. Confirm that a correct name for the file upload
settings (usually the same as the site name) has
been selected.

Uploading your site

You can connect to your provider's server, and
upload the entire site—that is, all the files and
subfolders that compose a site—to make your
Web pages accessible on the Internet. This is
called the site upload. By using the site upload
function, you upload only the added files and
the updated files every time.

The name for the file upload settings and the
@ site name are usually the same; however, if
you specified a different name, select it.

4. Click the Next button. The Upload Page or Site
(Check Files to Be Uploaded) dialog appears.
On the right side of the dialog, the contents of
the file upload settings are displayed.

Upload Page or Site

Prepare to Upload Files
Check Files to Be Uploaded

; 7 | Uplaad seftings
Server name
Fies to Be Uploaded | | [rwiomnet
[Total e size 23 K bytes [ 14 s ) User ID:
myusend
Estimated uploadtims | | Password
88k | g | | [
S0k:|  dse | | Desinatnfoder
Public el
%00 | 23300
Browse...
T~ Show only this page next time Lriginting folder:
/\My Documentshatel

<Back [ Finsh | Concel | Hep |

am\ If you transfer files as the site, Homepage Builder uploads only the files that have been changed or added
4 since the last upload. (This is the default method.) This means that when you first upload your site, all the
files and subfolders that compose the site are uploaded; whenever you upload your site after that, only the

files newly created or changed since the last upload are uploaded.

If you already have your Web pages on the Internet

If you have already uploaded your files to the server by using an FTP application other than Homepage
Builder, you probably do not want to upload the entire site again. If you click Site --> File Upload Settings
--> Mark All Files as Uploaded on the menu bar, Homepage Builder recognizes all the files that are cur-
rently in the site folder as "the files that have been uploaded."
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<5 ¢ In this dialog, Files updated since previ-
ous transfer has been selected automati-
cally. Normally, you do not need to change
this setting. The first upload enables you to
upload all the files and subfolders in your
site.

e |f you click the Files to Be Uploaded but-
ton, a list of files to be transferred is dis-
played. Files selected in this dialog are
uploaded. You can select or deselect each
file as necessary.

® You do not need to type any value in the
Estimated upload time field. If you want to
estimate the time it takes for upload, type
the modem speed of your computer.

5. Click the Finish button. If your computer is not
connected to the Internet, a dialog, prompting
you to connect, is displayed. After connection,
the upload begins, and a dialog that indicates
the upload status appears as follows:

Now Uploading | x|

From:

C:AMy Documentshsite]\cook_1.gif
To
/home/public_htrml/cook_1.qif
(][]

Mumber of files left: 12

Tranzfening (Binary Mode]

When the upload is complete, a message that

indicates completion of the upload is displayed.

WebS5phere Homepage Builder

& Tranzfer complete.

6. Click the OK button.

Learning the basics

How to change the file upload set-
tings

If the upload fails, there might be an error in
the file upload settings. Do the following to
confirm the settings, and correct the informa-
tion if necessary.

1. Click Site --> File Upload Settings -->
Edit Upload Settings on the menu bar.

The File Upload Settings dialog appears:

Edit..
Creale
Delete

Close Help

2. Confirm that "Cooking Site" is selected
from the list.

File Upload Settings

Edit
Create
Delete

Close Help

3. Click the Edit button. The File Upload
Settings dialog appears.

The Basic Settings tab enables you to
change the name for the file upload settings,
server name, user ID, password, and the desti-
nation folder.

File Upload Settings
Basic Sottings | Jdvanced Saltings | Auto Mode Option |
Setfings name:
’VICookir\g Site ‘
- Server sefting
Server name
Illp.ibm et
User ID
Imyusend
Password
Destination folder
[pubic_btrl
Browse.
0K | Camced | Heb |
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The Advanced Settings tab enables you to
change the settings on the passive mode, port
number, and firewall. (The only supported fire-

wall type is "SITE hostname.")

File Upload Settings [<]
Basic Setting{ Advanced Settings | uto Mode Option |
Passive mod;
{" Eonnect using passiye mode ‘
Part number
[ 21 Restore Default ‘

Firewall host name:

User ID

Paszsword:

™ Use firewall

o]

Cancel | Help

O For the passive mode and port number
\= ) settings, follow the instructions of your

provider.

The Auto Mode Option tab enables you to
register the file extensions of the files that are

to be transferred in text mode.

File Upload Seltings =]
Basic Sellings | Advanced Sellifgs Auto hade Dption |
|
Add |
o] Remove
£s55
HTM Any file with an extension
HTML listed here is uploaded a5
v lest
Js
PL
SHTM
SHTML
T
Restore Default
0K | Cacdl | Hen |

4. Confirm the settings. If there is any error,

correct it.

5. Click the OK button.

6. Click the Close button. The File Upload

Settings dialog closes.




Learning the basics

Viewing your Web site on a Web browser

| Creating a site

~~

| Uploading your site

~~

| Viewing your Web site on a Web browser

1. Connect to the Internet.

. Start a Web browser.

3. Enter the URL of your Web site. The top page of

your site is displayed:

dkess[2) g i g s i

‘-E///

= r/

\o o vt l

WELCOME TO MY HOMEPACE
Cooking page

@

Mail

eeeee

N/RE

3| e

When the upload is complete, you can view
your Web pages with your Web browser on the
Internet. It may take some time for the server
to receive your files and upload your site. If
your site has not been updated, try again a little
later.
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Tips on using Homepage Builder

This chapter presents some tips that help you make good use of Homepage
Builder functions—for example, how to change attributes of elements, how to
use right-click and drag-and-drop operations, and how to cancel previous
operations.

% %% Changing element attributes . .. ......... 46
%% Using the pop-upmenu ............... 48
% Inserting elements by drag-and-drop . . . .. 49
%% Canceling and redoing operations .. ... .. 51
%%  Using the color palette ................ 52

Note: The number of stars indicates the importance of the task. The most important tasks are marked with k% .




1.

Changing element attributes

Each element inserted into a Web page has attributes. For example, a table has
such attributes as width and color, whereas an image has such attributes as width

and height. Attributes are used mainly for changing the appearance of an element.

When you work with elements, you first create or insert an element and then
change its attributes. For example, when you work with a table, you first create a
table and then change its width and color. When you work with an image, you first
insert the image, and then you change its width and height.

Most elements have their attributes, and you can change them in the same way. If
you want to change the appearance of an element, do the following:

Click an element whose attributes you want to
change. In this example, click an image. The
element is selected and is surrounded by a
frame.

& & Nomal | HTML Sourse | Previen|

Srded | G

WELCOME TO MY HOMEPACE

Cooking Page

A focus frame indicating the object of the operation

s»\ The frame that appears when you click an ele-
A4 mentis called the focus frame, which indi-

2.

46

cates that the element is the target of
operation.

Click Edit --> Attributes on the menu bar. The
Attributes dialog for the element appears. For
example, if the element you selected is an
image, the following dialog appears:

Name of the element

Attrbutes

Tag: { I Image ’ ﬂ

Image | Dthers |

~ Eile:
Icuukﬁkﬂ.g\f Browse...
Alternative text: IEannEl

— Layout

Alignment: tiddle h

Text flow: ™ Lekt I Right

Si Spacing

Widkh: I 480:: Huorizontal: _|::l
Height: I 390:: ‘ertical: _Ij
Set Size Clear |

EL] ]

- Border
™ Show border it

U_I:j pixels
Event.. Stle... |

o]

Cancel | Help I

Q The contents of the Attributes dialog depend

on which element has the focus frame.

3. Change the values of the attributes as you like.

For example, you can change the width and the
height of an image as follows:



Attributes [ %]
Tag: Ilmage j

Image | Others |

Files
[ouk_b1.gi Browse...
Alternative text IEanner
— Layout
Alignmest: IM\ddIe 'I
Test | Left I Right
Si Spacing
it 402 Horizantak _,::‘
Height: 150_% Werticak _lj
Set Size Clear
~ Barder
™ Show border Width: I U_|::[ pikels

Event... | Style,

OK I Cancel | Help |

4. Click the OK button. The attributes are

changed.

& & Hamal | HTML Source | Preview|

Strded | MG

The size of the image has been reduced by half.

Learning the basics
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the element.

Examples of the pop-up menu

With Homepage Builder, you can use the right-click
operation in various ways. For example, if you right-
click an image, a pop-up menu appears as follows.
If you select Delete from the pop-up menu, for
example, you can delete the image.

& & Nomal | HTML Seurce | Preview |

Standard IM&

Ctis |
CHisC
=%
CHikD

™ 5 Pagelpload
(5 InsentLirk.

(& Editimage.
< G Edit it webArt Desianer
&5 Edit with\Wieb drimator
Ed Inage Map.

Using the pop-up menu

The act of clicking the right mouse button is called right-click. 1f you select an ele-
ment and then right-click, you get a pop-up menu listing operations you can do to

If you right-click a file on the Site tab, a pop-up menu
appears as follows. If you select Rename from the

pop-up menu, for example, you can rename the file.
8 Site | & Galen |
&y

Link

=& Cooking Site
2 Tap folder (C:\My Documentshsite1)
Files to be transferred
22 Unused files
Files with broken links —
Edit
Open with Text Editor
k=] i Fll=A i) e
k=g Ll o e Pl ki) e
= Open with Browssr (3=
@ Upload Site.
| Upload Page.
codkInage DiplySize g Pop-up menu displayed
v Display Fie Name . Lo
(3 v P — by right-clicking on the
Cut .
o Lo Site tab
et
@ Delete
- Rename
cook
Refresh Site Information.
+ EloseSie
sub2 htm - sub3 htm
LI
BB - [51 >
View Site Operation Insert

Pop-up menu displayed by right-clicking in the
page editing area

If you right-click a material on the Gallery tab, a pop-
up menu appears as follows. If you select Insert on
Page from the pop-up menu, for example, the file is
inserted on the page displayed in the page editing
area.

8 ghe B Galery |

0 & £
Folder  Bookmak  Histoy
Sile folder S
Persanal folder

Image

| ] [l
{ InetonPage |
Insert as Background Image.

Show Driginal Size.
Edit{mege

v ShowFile Name
Shaw HTML a5 Thumbnail
—_ Change Backgiound Color.
p v Play Animation
‘Wwialpaper Test Mode
T2  StleShest Testbode
" ShowStalue

v Show Button Label
Cony b

ba Delete

| by right-clicking on the
Gallery tab

E Pop-up menu displayed

e b_anil00.gf =l

48

Menu bar versus pop-up menu

A pop-up menu displayed by the right-click opera-
tion contains items included in the menu bar.
Whereas the menu bar enables you to select all the
Homepage Builder functions, a pop-up menu
enables you to invoke only functions that are related
to the selected element or file. So, if you wantto do a
certain task on an element, a file, or a folder, use a
pop-up menu.



Learning the basics

Inserting elements by drag-and-drop

To move an object from one place to another by using the mouse to "grab” it and
pull it to its new location is called the drag operation. To drag an object, you posi-

tion the mouse pointer over an object, press and hold a mouse button, and move

the mouse. To drop the object, you drag it to the new location and release the
mouse button. This is called the drag-and-drop operation. The behavior of the

object depends on which mouse button you use to drag it.

Dragging-and-dropping an object
with the left mouse button

In the following example, you will drag-and-drop a file
from the Gallery tab onto the page you are editing.

1. Onthe Gallery tab, click & | and then click
Wallpaper under Image:
°8 sie & Galew |

Gallery

Histo

3
|
=
5

P bmp; il en

bsTbgl bis2bgl bls3bgi  blsdhgl

bleb g blabh git blue_pT.. blue_p2

o=

blue_p3... bue_pd... blue_p5.. blue_pb.

blucTbgh blusZbgi bue3b.gi blueth gi
-y =
BB - =] (I

View Setup Insert

2. Select an image file, and use the left mouse but-
ton to drag it to the page you are editing.

=laix

i i
B00P@ B8 0 | Zud-- SEE S

BEEEE I R e

2
%

3
)

2
F
4

3. Release the mouse button on the location where

you want to insert the image. The image is

inserted.

G & ona [ S P

[ Stondd | cENTER

Nl

A

WELCOME TO M7 HOMEPACE

Cooking Page
i

v,

3

Dragging-and-dropping an object

with the right mouse button

This time, you will use the right mouse button to

drag-and-drop the same file. When you use the right

mouse button, a pop-up menu appears, and you
can select an option for inserting the selected

object.

1. onthe Gallery tab, click
Wallpaper under Image:
°8 ste @b Gater |

Hatbal bla2boif bls3bgf bladbof

blaBb gl blafbgit blue_pl.. blue_pZ

H =

blue_p3.. biue_pé... blue_p5.. blue_p6.

buelb gt blue2bgh bluedb.gi bluedb.gh

2
View Sewp et

I e
8 . Fa .

, and then click
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2. Select an image file, and use the right mouse
button to drag it to the page you are editing.

B

‘ WELCOME TO MY HOMEPAGE

Cooking Page
B

=

Mala
]

3. Release the mouse button on the location where
you want to insert the image. A pop-up menu
appears.

4. Select Insert as Background Image from the
pop-up menu.

The image is inserted into the page as the wall-
paper.

50
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Canceling and redoing operations

[ | tions.

Canceling operations

To cancel the preceding operation, click Edit -->

Undo on the menu bar. The most recent operation is

canceled.

" You can cancel the last 30 operations.

Redoing operations

To do the canceled operation again, click Edit -->
Redo on the menu bar.

Examples

You can cancel any of your operations, such as
entering text or inserting an image. For example,
you can cancel image insertion as follows:

1. Insertan image into a page.
7S Nmma\lHTML 5mm:e| Pvavlew' Standard MG

WELCOME TO Ml HHOMEPACE

Cooking Page

Pl =

@J

An image is inserted at the cursor position.

Homepage Builder enables you to cancel operations or to redo canceled opera-

2. Click Edit --> Undo on the menu bar. The oper-

ation of inserting the image is canceled.
[ “Stendad [ TD

& & Nomal | HTML Source | Preview |

Cooking Page

@J

Mal 4
o

=]

The page returns to the state it was in before the
image was inserted.

3. Click Edit--> Redo on the menu bar. The image

is inserted again.
o & Nom | HTML Souce | Prvien| [ Sendad [ &

WELCOME TO MY HOMEPAGE

Cooking Page
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Using the color palette

The dialog for setting color is called the color palette. The color palette enables you
to set the color of your choice on the page background, table, cell, or text. This sec-

tion explains how to select a Web-safe color from the color palette, how to extract a
color on the monitor screen and apply it to your page, and how to register a color

with the color palette.

Web-safe colors
The color palette provided by Homepage

Builder contains a set of 216 colors called the
Web-safe colors. The Web-safe colors are a
set of colors among 256 8-bit colors that are
prepared for Web pages. These colors are
displayed properly on any Web browser that
supports Web-safe colors. Thus, if you select
a color from the color palette, you are assured
that it will appear as intended.

Selecting a color from the color
palette

The following example explains how to select a Web-
safe color from the color palette and apply it to the
page background. In the same way, you can change
the color of tables, cells, or text.

@ If you are using an image file for the page

Q/ background, or using a style sheet that speci-
fies the page background, you cannot change
the background color with the color palette.
For example, if you have inserted an image file
as the background image of a page, you can-
not change the background color with the fol-
lowing method.

1. Open the page on which you want to set the
background color.

& 5 Noms |HTML Sasce | Freview | Sndod [ G

WELCOME TO MY HOMEPAGE

Cooking Page
¥

e
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a»| ¢ To setthe color of a table or a cell, first click
\9/ the table or the cell so that it is focused.

¢ To change the color of text, select the text
string so that it is highlighted.

2. Click View --> Color Palette on the menu bar.
The color palette is displayed.

The color you select is

B ackground )
Cialor applied to the element

displayed here.

Applp
Add

,~=/
[ = |
]




3. Click the color you want to use. The selected
color appears on the left of J

Color Paletie

B ackground
Colar

#ff9393
Apply
Add

HiF333

L%
B

4. Click the Apply button. The selected color is
applied to the page background.
| Stendad | CENTER

& & Nomsl | HTML Saurce | Preview |

AELCOMME TOpL HOMEBISRCE

Cooking Page

Extracting a color on the monitor
screen

This section explains how to select a color from the
monitor screen and apply it to your page. This
method is useful when you want to use a color that
appears on your screen but do not know the RGB
value for it. The following example shows how to
pick up a color used in an image file contained in the
Gallery tab and apply it to the page background.

Learning the basics

1. Open the page you want to set color on.
[ Standad MG

@ £ Homal | HTML Source | Preview |

WELCOME TO MY FHOMEPACE

Cooking Page

L ) o I

&

a»| ¢ To setthe color of a table or a cell, first click
9/ the table or the cell so that it is focused.

¢ To change the color of text, select the text
string so that it is highlighted.

2. Click View --> Color Palette on the menu bar.
The color palette appears:

B ackground
Color
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. Click @ The mouse pointer takes on the

shape of a sampler.

. On the monitor screen, search for the color you

want to use.

S

o)

While the mouse pointer is shaped like a sam-
pler, the color of the location on which the
mouse pointer is positioned is displayed in the
color palette as you move the mouse pointer.
Thus you can check the color before you
select it.

5. When you have determined which color to use,
click the mouse button. For example, you can
click the mouse button on a photographic image
on the Gallery tab as follows:

>4

IQ Image files [.gif: jpa:.prg;. bmp;.wmf;j

phato001.jpg photol02.pa

phota03.jpg photal04.jpg LI

1B = B [

Wiew Setup Ingert

The selected color appears on the left of @ in
the color palette.

. Click the Apply button. The selected color is

applied to the page background.

Standard BODY

@ £ Homal | HTML Source | Preview |

Adding a color to the color pal-

ette

If you pick a color from the monitor screen and add it
to the color palette, you can easily select the color
the next time you want to use it.

1. Select a color from the monitor screen. The
selected color appears on the left of @

Color Palette B2

B ackground
Color
| #781478

Apply

Add

=
FEEEEm

You are going to add
this color.

2. Click the Add button. The Color dialog appears:

Color

Basic colars

CrrrrmeEs
O T
T
..
A ...
LIl

LCustom colars:
0 o
Y o o

DEfite Custonm Calars 55

Cancel

Hug: IEDD
Sat: |1 1 Green |20

| ColorlSalid | IK

2]

Eed[120
Blue: lﬁ

Add to Custom Colors |

A ELCOIMAE TOMAY HOMEFSRCIE

Cooking Page

. Click the OK button. The color is added to the

color palette and is displayed at the bottom of
the palette. The next time you want to use the
color, simply select it from the palette.

here.

Your color is displayed



Templates and materials

Homepage Builder provides a rich set of templates and materials that you can
use on your Web pages. This chapter lists these templates and materials and
explains how to use them.

m e You can use templates and materials only if you have installed

& Templates, Sample Images, and Sample Data. However,
depending on the installation option, not all templates and
images may be installed on your PC.

e Some images shown in this chapter may be different from
those included in the product.

template %% Templates for multiple pages ........... 56
=== Atemplate consists of an optimum k%% Templates for singlepages ............. 62
combination of elements that are
suitable for a certain category of *%* Bonustemplates ..................... 71
Web pages. For users who find it dif- ) )
ficult to create Web pages from *Jk Materials for Images .................. 76
scratch, Homepage Builder provides . .
N *%*  Materials for WebArt-format images . . . .. 100
res. %  Materials forsounds ................. 106
%%  Materials for stylesheets . .. ........... 108
materials
@ %%  Materials for Java applets . .......... 113
Image files, sound files, Java applets,
script files, and style sheet files %%  Materials for scripts . .. ............... 120

referred to from an HTML file.

Note: The number of stars indicates the importance of the task. The most important tasks are marked with sk .




Templates for multiple pages

Homepage Builder provides many templates that are composed of multiple pages.

A list of multiple-page templates

A multiple-page template consists of a single top page and several subpages. Links are set from the top

page to subpages, and from subpages to the top page.

Business: Cocktails
(Top page)

Business: Cocktails
(Subpage 1)

Business: Cocktails

R
SEm—— i

= -
= F
R
Welcome to
Our Homepage

!

Business: Boutique

Business: Computers
and communication

56

Welcome to
Our Homepage

Business: Direct store

Business: Global communication

Business: Cocktails

(Subpage 2) (Subpage 3)
a‘ & . Ly
- Rl <
- —

e el o
et B8 Flomepage
P

Business: General store

Business: Grocery store

Business: Human resources

ER RN

P~ Ay
¥ -
j " Y
b1 j (5
Welcome to
Our Homepage
Hapita
¥

g 49 @ 9 & 0 0 o

Business: Hospital



Business: Scheduling

Welcome to
Our HomePage

Business: Catalog 1

Waakave

Our HomePage

Business: Frame 2

€9 :

P

Personal: Cooking

Business: Money and graphs

Wcl?nmc

1O page

Business: Catalog 2

OurH

Business: Frame 3

PP ILPRPR@

Personal: Family

Learning the basics

E R R R e

o
3
"3
Welcome to
Our Homepage
Bpartuyg preds

o0 0000,
A
RN .. =

Welcome to
Our Homepage

Besmty saien

-

Business: Beauty salon

Business: Company profile

A A R

Personal: Christmas

Personal: Flea markets

e

weicame ta my hame page
5

<

Personal: Gardening

Personal: Photography
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Personal: Interior

4 @ 4 - - &3

SeT BN K

Personal: Sports

P
Weleome,.

=00 0]

Personal: Frame 2

BECOBTTUFY
n“g4 [} l
¥ §

School: Class introduction

58

Personal: Music

mw;awmgrmmcm S.:

iefel

Personal: Travel

Personal: Frame 3

e e e
Walcome 1o our home pags gy

School: Track and field

Personal: Outdoors

AALAAAALALAAS

Chad

Personal: Child care

Personal: Frame 4

Dy
E W WE l:li:i T(Dn.\:i ﬁ
‘Ggpt

Personal: Painting

o]
w HomePage

Personal: Frame 1

Personal: Frame 5

School: Club activities 1

o L (B e (B o BT

School: Club activities 2



School: Field trips

School: Observation

School: Summer vacation 1

FETrrrrrres

School: Summer vacation 2

OGS

School: Class newspaper 2

School: Frame 1

PEEPEELETECEE

TEiPw

fr—y

s
abcder gl kimarpyrsinnns re

School: My school

School: Classroom

School: Frame 2

§ e e B

School: Class newspaper 1
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How to use a multiple-page tem-

plate

By using a multiple-page template, you can create
multiple pages at once. These pages are a single

top page and several subpages (the default is

three).

A1

¢ |n the following steps, you proceed from one
dialog to the next by clicking the Next but-
ton. You can, however, click a dialog button

e During operation, you can reset the tem-
plate to its original setting by clicking the
Reset button.

to proceed directly to the desired dialog.

1. Click File --> Template --> New Page from

Template on the menu bar. The Template Wiz-

ard (Select Template) dialog appears:

Template Wizard (Select Template)

Select Select Select
Template  Background Color  Images

Page
Settings

=® 0 o

LCategory: Genre:

LY
gé Muliple pages

N
User templates

Pers
School

Pages with motion
St sheet
Others

Display
environment
Borus templates

Theme:

Boutique
Direct store.
Generalsiore

racery store
Computers and communicatic
Global communication
Human resources
Hospital
Scheduling
boney and graphs
Spaiting goods
Beauly salan
Morihiy calendar
Generic 1
Generic 2
Generic 3
Directions and map

K B

Finish

e Next > Cancel Help

2. Select Multiple pages from Category, and then
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select a genre and a theme. The selected tem-
plate is displayed on the right side of the dialog.

Template Wizard (Select Template)

Select Select Select Fage
Template  Background Color  Images Setiings
e >

Category: Genre Theme: Previen

Busingss Christmas
Flea markete

Schaol

5| User templates

Display
environment

Bonus templates

Firish cgeck [ mets | Cancal Help

3.

B

Click the Next button (or the Select Back-
ground Color button “g5"). The Template Wiz-
ard (Select Background Color) dialog appears.

Change the items selected in the Color Cate-
gory and the Text and Background Colors
fields. The background color of the template
changes accordingly.

Template Wizard (Select Background Color)

Select Select Select Page
Template  Background Color  Images Setiings
D D
Color Category: Tent and Background Colors: Preview
Grcen walpaper | Tes Text
[Velow
Velow walpaper W Lz
Orangs Vised Link Visked Link.
Orange walpaper
Red
Red wallpaper —
ik o=
Pirk wallpaper Test @
wiple
Furple walpaper
Blue
Blue wallpaper
Skyblue
Sky blue walpaper
[whie

white wallpaper

= Reset

< Back I Mewt I

Gray
Gray wallpaper
Black.

Corcel | Hep |

Finish

Click the Next button (or the Select Images but-

ton ). The Template Wizard (Select Images)
dialog appears.

Change the items selected in the Banner, Bor-
der Line , and the Icon fields as necessary.
Each element changes accordingly.

Banner: An image that represents the topic of the
Web page

Border Line: A ruler image inserted on the
page
Icon: An icon image inserted on
the page

Template \/izard (Select Imag=:

Seldet Select Select Fahe

Temflale  Background Cofr  Images setthos

5 B G
Banner Borde| Lie: leos Previer:
Painting =] [Paintha «| [Paifting
Track anf field Tracl| and field Tratk and field
Chid care Chid care Chld care
Cockials Cockiais Cocktale (342
Beauty salon Beauty salon Beauty salon et
(Class rtroduction Class intoduction (Class intoduction =
Hospial Hosphal Hospital
Bouiique Boulique Boutique e
Club activities 1 Club activities 1 Club ackivities 1 =
Club acivities 2 Club activiies 2 Clcb activies 2 3

Computers and comm | Camputers and comn | Camputers and conm

Direct stare. Direct stare. Direct store.

Famiy Famiy Family

Grocery store Grocary store Grocery store

Poitiolo ortiolio [ |Fartidio B
AT » A e AT e
I~ Mo banner I~ Mo border I~ Naigons

Beset

Concel | Hep |

I™ Textless banner

Firish

< Back I Hext I
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/. Click the Next button (or the Page Settings but- 10. To set a link on the mail icon on the top page,

Page

ton ). The Template Wizard (Page Settings) type your e-mail address in the E-mail address

dialog appears. This dialog shows the titles of field. This field is optional.

all pages created from this template, in a tree

structure. 11. Click the Finish button. The Specify Folder dia-
A tree structure from the top page log appears:

Select a folder by double-clicking it.

Template Wizard (Page Settings)

Ti::;\l;tls Back;:‘:ncd‘liu\m \E:weabg {SZSE;S Speci[}l FDldEl
/_)
i Folder:
:IJ add o4y documentzhagquarium
-;ue::gwithhevhs et @ ;:: C.\ —
“’;? * BI[Ea My Documgts _I |LI
vl @ Cancel |
S— 03 images
Lim‘add'm @ LI Create Folder |
Dirive:
cBock [ Fish | Concel Help I = j
8. To change the title of a page, select a page from
the Page list field, and then change the title in 12. Specify the location of each HTML file and
the Page title field. image file in the Web pages, and then click the
OK button.
9. Toadda subpage linked from the top page,
click the Add button to display the Add Page gy To distinguish the files related to the Web
dialog, select a page layout, type the title, and \ pages from other files, it is rgcommended that
then click the OK button. To delete a page, you create a new folder dedicated to your Web

pages. To create a new folder, do the follow-

select a page and then click the Delete button. -

1. Select a page layout.

A) Click the Create Folder button.

B) Type a new folder name in the Create
Freview: Folder dialog, and click the OK button.

it 1

P2 s C) Click the OK button in the Specify Folder

tgﬁgﬂ{ : dialog.
All the files related to your Web pages are saved.
The top page is displayed in the page editing
area.

Page fitle:

Mew pages

Ok I Cancel | Help |

2. Enter a title for the page.

L 3. Click this button.
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Templates for single pages

Homepage Builder provides many single-page templates.

A list of single-page templates

Business: Cocktails

Business: Grocery store

E O O B A N I A Y

Al .
& o
B onenage Y

Havpitsl
-~

o 49 0 o 0 9 0 O

Business: Hospital

62
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Business: Boutique

Business: Computers
and communication

Business: Scheduling

lcome to
Homepage o=

D ware

4

Business: Direct store

Business: Global communication

Business: General store

Business: Human resources

Business: Money and graphs

-_'w
Welcome to
Our Homepage
Bportug grode Py

Business: Sporting goods



Welcome to
Our Homepage a\

-

Business: Beauty salon

Business: Generic 3

Eip

@

Personal: Cooking

[T ——
5 =
__.l %
= «
&

Personal: Interior

Business: Monthly calendar

Business: Directions and map

RPRPRPOPR PR P

Personal: Family

Personal: Music

Business: Generic 1

Learning the basics

Business: Generic 2

Personal: Christmas

L

J 2 _
e
2xs. O
= s d -

=g 2 I

2 @

- 3

°

Q

@

2]

Q

=]

o

3

2

Personal: Flea markets e

@

%]

Personal: Gardening

Personal: Outdoors

@ (wQ

Photepsepiy
L
-

Personal: Photography

m = EE - Ewm

Personal: Painting
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(=]

B e A e

Personal: Sports

Personal: Travel

Personal: Generic 2

Personal: Generic 3

i
i
i
ety
it
Ly

Personal: Child care

Welcome to My
Home Page

Personal: Generic 1

FT

iy 12001

o o e o Sy T
Foms TomSmgs oSyt T
===

1,200

oo
e
o=

B swary 13000
S Do s P e T e Tt
b= it

g 2

Personal: Generic 4

Personal: Calendar 1

8 i R

Personal: Calendar 2

Personal: Notice

FRFREORORSRSR

@8 .

Welooms to by Homsbage | @@,

Clu wcivicy

ot BT o L o (BT LT

School: Class newspaper

School: Track and field

64

School: Club activities 1

School: Club activities 2

School: Field trips

B THDWE FACE:

School: Observation




PEECTECTELTE
o e A
4

My achaal

School: Portfolio

School: My school

vyoa0RSE A i@agggergm

‘Sego° &
G
m‘ thﬂ

&

]
msrasnasannEens eRsrEsas

School: Classroom School: Class introduction 1

QRS OHENEELY

\ &y J-I:amz?:gs,]
® @
® @

.

School: Generic 2 School: Generic 3

waluuiig t
sl Unieduye S00.

LY LT Y|
LLAL LLA.

Pages with motion: Bicycle

Pages with motion: Camping

Learning the basics

—% =
G&
e
i
=1

School: Summer vacation 1

feopan080
o

Welcome 1o My HomePage g9

School: Summer vacation 2

P

School: Class introduction 2

School: Notice

Qur HomePage

School: Generic 1

Pages with motion: Balloon

Sr%8E

Pages with motion: Computer shop

Bickom 1
b 7 T

Pages with motion: Cooking
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Pages with motion: Music

Style sheet: Art

Shopping Catalog

Style sheet: Shopping 1

66

Style sheet: Herb teas

Pages with motion: Piano

WELCOME

A5 8=
g -
2= »

Style sheet: General store

. Shopping Catalog

Style sheet: Shopping 2

W” 5
R
r A

Birds'
Library

Style sheet: Bird encyclopedia

ﬁv“lll‘ennla Team

Pages with motion: Tennis Pages with motion: Portfolio

Style sheet: Mobile phone Style sheet: Nature
conservation

20011Vol10 | Kol

Style sheet: Shopping 3

Others: Basketball Others: Honeybee garden



Others: Oval racing

Others: Flower shop 1

Others: News

Others: Weather

D ]
Pl

g B s s
LIRS T

ST

e . g g

Others: Indian cuisine

SEASONS

Others: Flower shop 2

Others: Pizza house

Others: Catalog (blue)

2 FLs. FrFas r

Others: Dolphin world

Others: Boutique

Others: Flight route

Learning the basics

Others: Film library

Others: Laptop computer

Others: Catalog (pink)

Others: Roll screen

Wl Wack Mreel Can

Others: Streetcars
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T-shirt

Hello!
P
==

e
e

Others: T-Shirt pink Others: T-Shirt yellow

Others: T-Shirt green

68



How to use a single-page tem-
plate

By using a single-page template, you can create a
Web page that already contains elements such as a
titte and images.

e During operation, you can reset the tem-
plate to its original setting by clicking the
Reset button.

A1y

¢ |n the following steps, you proceed from one
dialog to the next by clicking the Next but-
ton. You can, however, click a dialog button
to proceed directly to the desired dialog.

1. Click File --> Template --> New Page from
Template on the menu bar. The Template Wiz-
ard (Select Template) dialog appears:

Template Wizard (Select Template]

Select Select Select Pags
Template  Background Color  Images Sefings
B B =
Calegary B Preview
L g
_ 5 haol Dircot ore
[N Pages with motion [ General store
gé Multinle pages Shyle sheat Gracen store
Others Computers and communicatic
Global communication
Usar templates Human resources
Hospital
Scheduling
Display
~ o et Money and araphs
Sporiing geods
Beauly salon
§'| Bonus templates e
Generi: 1
Geneic 2
Generic 3
Directions and map
N (S

Finish < Bach I Nest > Cancel Help

2. Select Single page from Category, and then
select a genre and a theme. The selected tem-
plate is displayed on the right side of the dialog.

Template Wizard (Select Template)

Select Select Select Page
Template  Background Color  Images Seumgs

_)...

Gene: Preview:

usingss

choal
Pages with mation
Style sheet
Others

Ve

L 3

S
User templates

Display
envitorment

b Bonus templates

Finish N Cancel Hep

3.

Learning the basics

Click the Next button (or the Select Back-
ground Color button g5~

). The Template Wiz-

ard (Select Background Color) dialog appears.

Change the items selected in the Color Cate-
gory and the Text and Background Colors
fields. The background color of the template
changes accordingly.

Template Wizard (Select Background Color)

Select Select Select Fage
Template  Background Color I mages Settings
Color Category: Text and Background Colors: Previen
Green nalpaper [ 7ex Text
Yelow
Yelow wallpaper Wids Lits
Orange Visied Link Visked Link
Orange walpapsr
Fed
Red walpaps:
i
Pirk nallpsper e <
Furle
Purpls walpaper
Blue
Blus nallpsper
Sky blue
Sky blue wallpaper

ite:
[white walpaper
G

=l Berat

Finish <Back [ Newt> Cancel | Heb |

2
Gray wallpaper
Block

Clioks‘t‘he Next button (or the Select Images but-
ton ). The Template Wizard (Select Images)

dialog appears.

Change the items selected in the Banner, Bor-

der Line , and the Icon fields as necessary.
Each element changes accordingly.

Banner: An image that represents the topic of the

Web page

Border Line: A ruler image inserted on the

page

Template Wizard (Select Imaget
Selact, Selact Selact Pade
Terplatf  Background Colof  Images Setlidgs
nn |
e @
Banner Border ne: lcon: Preview:
Ia\m\ commumcalmnj 'mmuba\ cum-jmumcauun MNM cum-jmumcauon
Sumnmer vacation 1 Summes vacation 1 Summer vacation 1
Summer vacation 2 Summer vacation 2 Summer vacation 2
Interior Inkerior Interior J
Classrcom Classraom Classroam
Flea markets 1 Flea markets 1 Flesa markats 1
Money and Graphs Money and Graphs Money and Graphs
Music usic b usic.
Dudoars Duidoors Quiocrs
orap oo o0
Field tips Field trips Field trips
Class newspaper Class newspaper Class newspaper
Human zsources Human resauces Fuman resaurces
My school My school Iy school
Spoits ] |[5Ports <+ |5ports =
[y ) S Y 1 F
™ Mo banner I~ Mo border I~ Moigans
I™ Testess barmer | Bemt |
Fiish <Back [ New» cacd | Heb |

lcon: An icon image inserted on
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/. Click the Next button (or the Page Settings but- 13. Click the OK button. All the files are saved in the
ton ). The Template Wizard (Page Settings) specified folder.
dialog appears. This dialog shows the title of the
page created from this template.

Page title

Templite Wizard (Page Settings)

Select Select Select Pags
emplate  Background Colar  Image: eltings

Do

< Back I Finish Cancel Help

8. © change the title of the page, overwrite the text
in the Page title field.

9. To set alink on the mail icon on the top page,
type your e-mail address in the E-mail address
field. This field is optional.

10. Click the Finish button. A new page created
from this template is displayed in the page edit-
ing area. This page has not been saved.

# £ Nomal | ML S | Previen] [ Stondad | 60DV

welcome to my home page

Gardening

|

A new page created from the selected template

11. Click File --> Save As on the menu bar. The
Save As dialog appears.

12. Specify the location and the file name of the
HTML file to be saved, and then click the Save
button. The Save Files dialog appears.
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Bonus templates

Homepage Builder provides the following bonus templates.

m» You can access the image files included in bonus templates by double-clicking the
Q Bonus templates icon in the Site/Gallery View.

A list of bonus templates

MY HOMEPAGE B ﬁ ~ 7

L N weLcome TO
b- MY HOMEPAGE

¢
Sports: Baseball Sports: Tennis Sports: Bicycling Sports: Jogging
Tl Dl Doe
d 0 ey eseiys ' . oo o Ty
< - oy
3 . y irlin
Sports: Snowboarding Sports: Surfing Music: MIDI Music: Violin
I o1 1 b bt ol o
z 9 -
S 4 &=
PAGE! =
v
Music: Guitar Music: Piano 1 Music: Piano 2 Hobbies: Models
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Hobbies: Dogs

Hobbies: Reptiles

Travel and leisure: Bird-watching

Entertainment: Movie

72

e

Hobbies: Cats

Hobbies: Handicrafts

Travel and leisure: Angling

T IR

Entertainment: Amusement park

Hobbies: Birds

e komets
by Home Poge

Hobbies: Tropical fish

GGG

Hobbies: Flea markets

|

2
W

el

Wy Homepage

Fholegrush puge

Culture: Photography

--._-

Welcome 12
By Homepaye

R

)

[afury

Travel and leisure: Hiking

Travel and leisure:
Motorcycling and touring

Entertainment: Horse racing

Entertainment: Baseball



= = ik
= = P

= < &
E TO MY HOMEPAGE E .(.f:.»u lI"h
— Ty Homs

Entertainment: Games Health and beauty: Makeup Health and beauty: Walking Health and beauty: Walking
in the woods

; /
) ¢ ] ﬁ > % s
Diwy

~
N
Health and beauty: Health and beauty: Life: Diary Life: Child-rearing
Keeping fit Fashion and accessories

Q I"—'l * ‘ Wedcome ta My HomePage $
i L -

@ ;S ®

°e & ®

Life: Cakes and cookies Life: Life with green plants Life: Kitchen garden Ecology and nature: Dolphin

g
¥ WELCOME TO MY HOMEPAGE "“ 9 i': = ‘%I
h [*) 1

O e Sty
: Feveni sramereatine
Ecology and nature: Whale Ecology and nature: Ecology and nature: Ecology and nature:
Preserving wild animals Global environment Energy conservation
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Ecology and nature: Ecology and nature: Computer: Hardware

Computer: Software
Natural energy sources International exchange

Lalifraniliddis

Computer: Information exchange Computer: Hot list Computer: Free Computer: E-mail
predesigned templates

H@Hglie

e e e ——

[l

Computer: Mobile Computer: Multimedia Seasons: Cherry blossoms 1

® 3
E ]

'
@

Seasons: Rape blossoms Seasons: Verdure 1 Seasons: Verdure 2 Seasons: Clouds 1
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g

e
—ip:

Seasons: Clouds 2

w b
L
P4 Weicame o My HoiePae |

: ssianal L

Seasons: Autumnal tints 2

General: Gallery 1

Seasons: Sunflower 1

rrrecerrrrrrerere

=r £
g_
e Welcome to My HymePage

Seasons: Sunset

General: Gallery 2

Learning the basics

Seasons: Sunflower 2

General: Whale watching club

General: Gallery 3

Seasons: Autumnal tints 1

General: Modern dance

Pages with motion: Canoe club
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Materials for images

Homepage Builder provides many sample image files. They are included in either
Sample Images or Templates.

In addition to the sample images listed in this section, you can use the images contained
in the bonus templates. To access these images, double-click the Bonus templates
icon in the Site/Gallery View.

A list of image files

Animations
- F 4 b
» C W | #
b_anil0l.gif b_ani002.gf b_ani003.gf b_ani004.gf b_ani005.gf b_ani006.gf  b_ani007.qf  b_ani008. gif
| #
b_ani009.gf b_an10ogf b_an0ll.gf b_ani0lZ.of b_ani0l3.gf b_ani0l4.gf b_an15of b_ani0lB.of
TOP Y 9 |F |%. |
=N \ N e N B N
b_anil17.gf b_anid18.gf b_anidl9.gf b_ani020.gf b_ani021.gf b_anil22.gf b_ani023.gf b_ani024.gif
il g Az || A || oxt v‘ - ﬁ
b_ani025.gf b_ani02E.gf b_ani027.gf b _ani023.gf b_ani023.gf b_ani030.gf b_ani031.gif  g_ani00. gif I
g_anillz.gf g_ani003.gf g_ani004.gf g_ani005.gf  o_ani006.gf o_ani0d7.gif  o_ani008.qgf  g_ani009. gif
A i
g_and10.gf g an11.gf p_an0M.gf p_ani002.gf p_ani003.gf p_ani004.gf  p_an005.gf  p_ani00B. gif
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= 2, -
) ¢ || ¥
p_anil07.gif  p_ani003.gif p_ani009.gif p_ani10.gf p_ani0l1.gf p_ani012.gf p_ani0l13.gf p_ani0l4.gif
L U iy
hﬁ‘.’nﬁ‘,y bm&y M ‘g‘p ‘ri.w;uy :&j £epe i:ﬂ
s r
g_aml.gif = _ani002.ogf =_an003.qf z_am00d.gf s ani005.gf s _ani006.gf  s_am007.gf  =_am008.of
50 |+ P
A | I 3 L F ”” _ -}:
0 ' x oA ,{"", —_—
g_ani0l9.qgif z_anid10agif =_ani11.af = anillZ.agf s anil3.agf s anill4.gf s anillb.of  z_ani0l6.qif
oL | &l Il
r T _ u} il &l m .. u}
& b ) il | NSV | O N | BT O T | RCR:0=5
oY || e
g an gl = anl8.af = _an0l9.af z_aml20.gf s anl2l.gf = _an0Z22.gf _aml23.af s aml24.gif
Banners
] il Enms |
b_band01.qgf b_banl0Z2.qf b_ban003.gf b_ban004.gf b_ban00%.qf b_banld06.qf b_banl07.gif b_ban008.of
) e e =5 | e s
b _ban009.qf b_ban010.gf b_ban1.gf b_bandlZgf b_ban0l3.qf b_ban0l4.gf b_ban015.gif b_ban01E.gif
A= = | | | S | —
b ban017.gf b_ban018.gf b_banM9.gf b_ban020.gf g _ban001.qf g_ban00Zgf g_ban003.gif g_ban004.gif
%_@m___!_ : | -

q_ban005.gif g_ban00&.qgif g_ban007.gf g_ban008.gf g _ban009.gif g_ban010.gf p_ban001.gif p_ban002.gif
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|| ot ¥ il e R | L B | e
p_ban003.gif p_ban004.gif p_ban005.gf p_ban006.gif p_ban007.gif p_ban003.gf p_ban003.gif p_ban010.gif
p_ban011.gif p_ban012.gif p_ban3.gf p_bandl4.gf p_ban015.qgif p_ban016.gf p_ban017.gif p_ban013.gif

: | P g . e e =

= amEF amr S B | —
p_ban019.gif p_ban020.gif p_ban021.gf p_ban022.gif p_ban023.gif p_ban024.qgf p_ban025.gif _ban001.gif
. g Bl e
,# :l : BT ) R - gl .““ E — :
Wl :I 7 o e - IE" _\FE?E_ rE.l_[E",
g_ban00Z2.qf = _ban003.of =_banl04.gf =_ban005.of  art_bl.gf at_bZ.af  athle_bl.gif  athle_bZ.agif
] i
L 5 | i lyi & .f‘ 3 oo 3 I
,!:,":;.'j",;':_fq# {JuLIIJmu-rp-.'u.'u.
baby _b1.gif baby_b2af  bar_b1.gf bar_bZgf  beau_bl.gf beau bZgf class bl.ogif  clags_b2 qif
TE—
- - v .
M| A T | e | 68| @S | 313 || gD
-.':.'-'.mr\-‘\ﬂ }I'. 3 l.r:.-\n:nin \ TI\.;*—"" b Grie w""'m."“.' =
LER Jc IR T Uur Hemnpayre
chn_bl.gif chin_b2agf  cloth_bl.af  cloth_bZaf cluba_bl.gf cluba_bZaf clubb_bl.gif clubb_bz2 gif
e | e |5
Zp | & |8
T T Lt e
Tinr Hamepags
compu_bl.aif compu_bZ.aif cook_bl.gf  cook_bZ.af  direc_bl.gf direc_bZ.gif  fami_bl.gif  fami_bZ.qif
i = ._' » Bl :'|'I''‘'I1l;:-|!|m'|-t'm|:I1 '-.;I L3 -Fi._'? il:-‘_tl * * :.-I :
;r'::x:.-lrx;.-!ﬁ%? ?-_:-:ﬂ:_ Ljﬁhb m:'rliwlrr.'r:rlli'ﬂ" i > _ g
food _bl.gif  food b2gif  gal_bl.aif gal_bZ.agf garde_bl.gf garde_bZgif globa_bl.gif globa b2 qif
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ain I o
A IS
AT || A _
___ﬁh-’ ,_&i .: ek mar b Ty Hemr e wanes te S
halil_b1.gif  holi1_b2.gif  koli2_b1.qif inte_b2.gif  les1_bl.gf  les1_b2.gif
é LA S S ﬂ
mar_bl.gif  mar_bZgf money_bl.gif money_bZaif music_bl.aif music_bZ2.gif  out_b1.qif aut_b2.gif
RS L oaniy| Bk, || D e Ca
w3 - 'ﬁ . _ig & e.l & e.l
P s e L5 oo g
photo_b1.gf  photo_b2.gif  pic_b1.gif pic_bZaf presz_bl.gf press b2dgf  res_bl.qif rez_b2. qgif
LT e, 5
o | |B
Mt b g P " “ il -
aa Wb ma vy . _'_3- 5
I.llerlllnH]mal- - -
gscho_bl.gif  scho_bZ.gf  zpart_bl.gif spoz_bl.gif  spos_b2gf  tme_bl.gf  time_bZ gif
gl [
1 , , ¥ * -, %
Uinz Foomie oy ‘2":'5
trav_bl.gif  hawv_bZagf  wane_bl.gif wane_bZ.gf watch_bl.gif watch_b2 gf  =masz_bl.gif =maz_b2 gif
Buttons
il | |1 e (e |, s (e |C | [
b_btnO01.gf b btn00Z.gif b btn003.gif b bin004.gif b_bin005.gif b_bin0O0E.gif b_bin0O7.qif  b_btn00S. gif
s | | | s | e |05 | LIS
b btmO09.gf b btnd10.gf b btnd11.gif b btn012.gf b_bin013.gf b_bin0l4.gif b_bin015.gif b_btn01E.qif

b_btn017.gif

b_btn01 8. gif

b_btn013.qif

b_btr020.gif

b_btn021. qif

b_btn022. qif

b_btn023. qif

b_btn024. gif
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b_btn025.gif

b_btr026. gif

b_btn027. qif

b_btn025. gif

b_btr023.gif

b_btr030. gif

b_btn031. gif

b_btn032. gif

|_?\ (e F

m'\ [iFH

e
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pliz9.aif  p_lis020.gif  p_lis021.gf  p_lis022.0f p_li=023.0f p_i=024.0f p_iz025.0f  p_liz026. qif
O & S & @ 'y & B
p_lis027ogif  p_lis028.0if  p_lis029.0gf  p_lis030.aif  p_liz03.gf  p_lis032.0f  p_lis033.aif  p_liz034. gif
7 N & T & & @ ||
p_lis035.gif  p_ls036.af  p_lis037.gf  p_lie033.af  p_h039.qgf p_le040.gf  p_lie0dT.af  =_Le007. qif
|| _ || || o & .

g s002.gf 2 _he003.gf = he00d.gf = he00%gf = _li=006.gf = le007.gf = _heO08.qf  =_Le009.qif
i P o8 b
g liz0gf  z_liz011.gif = lie012gf = liz013.qif
Photos

photo001.jpg

photo002.jpg

photo003.jpg

photo004.jpg

photo007 . jpag

photo002.jpg

photo003.jpg

photo010.jpg

photol11.jpg

photoll 2.jpg
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phatol17.jog Chatol18.jpg

e

photol23.jpg photo024.jpg

photo013.jpa photo014.jpg

photo019.jpg photo022.jpg

photol25.jpg photo026.jpg photol27 jpg photol28.jpg photol29.jpg photol030jpg

photo031.jpg photo032.jpg photo033.jpg photo034.jpg photo035.jpg photo03E.jpg

U intme

phiotal37.jpa phatal33.jpg phioto039.jpa

Wallpaper

bla1b. gif blazb. gif bla3b. gif bladb. gif blaBb. gif blagb.gif  blue_plb.gif  blue_pzb.aif
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e ¥
st
blue_p3b.gf  blue_pdb.gif blue_pbb.gif  blue_pBb.gif  bluelb. gif blue2b. gif blue3b. gif bluedb. gif
| -
bluebb. gif blueBb. gif ql1b.gif gzb.gif q3b.gif gdb. gif gbb. gif
a

arl b.aif ar2b.aif ar3b.gif ardb.gif arab. gif gr&b. gif ol b, gif o2b. gif
o3b.gif odb.gif obb.gif obb. gif plb.gif p2b. gif p3b. gif pdb. gif
pab.gif phb. gif pur b.gif purZb.gif pur3b.gif purdb.gif purab. gif purib. gif
b, aif r2b. gif rab. gif rdb. gif rSb.gif rEb. gif w1 b, gif w2b. gif
v 3b, gif wib, gif wib, gif wib, gif w1b. gif b, gif wab.gif wab.gif
whb.gif wBb.gif b_begO01.gif b_beglDZ2.gf b_begl03.gf b_bogO04.gif b_bogl05.gf b_bogOOE. gif
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b_bcgl07 aif

b_bcg0s. qif

b_bcg003. oif

b _becgd10.qif

b_becg017.aif

b_beg0l2.aif

b_bzgll 3.aif

b _bzgll 4. qgif

b_bcgl15. aif

b_bcgl16. aif

b_begd17.aif

b _begd18.aif

b_bcg019.aif

b_becg0200aif

b_bzgl21.aif

b_bzgl22.aif

i

b_beglz23.gif

b_boglz2d.gif

b_bogl2h. gif

b_beogl26. gif

b begl27.gi

b_boglz28. gif

q_bcg007 . agif

g_bcol02 qif

g_beg003. aif

q_bzg004. gif

q_bcg005. gif

g_bcg06. gif

b_bogl29. gif

g_begl07. aif

b_beogl20. gif

q_bzg083. gif

q_bcg009.gif

g_bco10.qif

g_becgl17. aif

q_bzg 2.aif

q_bcg013.aif

p_bcg07 . aif

p_begl02. gif

p_bzg03. gif

p_beg004. gif

p_bogO05. gif

p_bogO0E. gif

p_begO07 . gif

p_begO08. gif

p_bog003, gif

p_bog010. gif

p_beg0l1.gif

p_becgll 2.a0if p_beogll3gif p_bealld.gif p_bogll5.gif p_bogll&.oif p_bogll7.aif p_beagll8.of p_begll 9. gif

]
p_beg20. gif
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p_breglz22.agif

p_bzoglZ23. gif
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p_beol26. gif

p_bzglZ7. aif



Learning the basics

p_beogO2a. gif

p_begl29. gif

p_bog030.gif

p_begl31. gif

p_bog032. gif

p_beog033.gif

p_bog034. gif

p_beg035. gif

p_bregE6. gif

p_bzg37. gif

p_bcg038. aif

p_bzo033. gif

p_bcol40 oif

p_bzo0471 . aif

p_bcol42 aif

z_boo007 . aif

z_beo02. gif

z_bool03. gif

z_beg04. gif

z_bcol05. gif

z_bcg06. gif

z_boo007. agif

z_bcgl03. aif

£_bco009. gif

£_beg0l0.gif

#_bog0l7. gif

g_bogll2af 2 _bogll3.af = _boglld.gf & bogbgif  aid_bgaf  athle_bg.gif

baby_bog. o

bar_bag. aif

beau_ba. gif

clazz_bo. gif

clin_bg. gif

cloth_bog. oif

cluba_ba. gif

clubb_ba. gif

compl_bag. aif

cook_ba. qif

direc_ba. qif

farni_ba.qif

foad_bag. qif

qal_bag. aif

garde_baq. aif

dlaba_ba. aif

holil_bg, gif

holi2_bag. gif

inte_bog, gif

les1_bo.gif

mar_bag. gif

money_bg, gif

ruzic_ba. gif

out_bg, gif

phioto_ba. gif

pic_bg. gif

prezs_bog. gif

res_bog. gif

zcho_bg. oif

zpart_bog. qif

zpoz_bog.gif

tirme_bg. gif
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trav_bo.qif
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varne_bog. oif

watch_bg.oif

wmaz_bo. gif




How to insert an image file from
the Gallery

To insert an image included in the Gallery into your
page, do the following:

@. <IMG src= >

1. onthe Gallery tab in the Site/Gallery View, click
the Gallery button |G . On the upper part of
the Gallery tab, a list of categories for the mate-
rials provided by Homepage Builder appears.

2. Under Image, select a category of images. On
the lower part of the Gallery tab, the thumbnails
of images in the selected category appear.

Gallery tab

o8 sie @ JaHEL\'I

Gallery button —JiEl o,

+— To select a cat-
=|  egory, click the
name of the
category.

— A list of
images is dis-
played.

3. Click the image you want to insert into your
page.

L3 Image fes i pg: ong: me e uJ

npmpm

gupl
&

+——_Click animage
to select it.

— Insert button

Learning the basics

4. Click the Insert button| @, . The selected
image is inserted at the cursor position on the

page being edited.

Standard CENTER

& & Nomal | HTML Source | Preview |

welcome to my home page :

Gardening i Flowers i scasen |

The selected image has been inserted.

7\ ° Thereis another way to insert an image file
from the Gallery: Click Insert --> Image File
--> From Gallery on the menu bar.

e To insert an image file not included in the
Gallery: Click Insert --> Image File -->
From File on the menu bar; or click the
Folder button on the Gallery tab, and then
select an image file.

* To load an image file from a TWAIN-compli-
ant device (such as a digital camera): Click
Insert --> Image File --> From TWAIN
Device on the menu bar.

¢ To insert an image file on the Internet: Click
Insert --> Image File --> From URL on the
menu bar.
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special file format called WebArt format.

For instructions on how to use WebArt Designer, see Chapter 17

Materials for WebArt-format images

Homepage Builder includes many sample image files created by WebArt Designer,
one of the image creation tools provided by Homepage Builder. These files are in a

A list of image files in WebArt format

Logos
Taadas || [TV : Bs Attention 00Nt
loga010 loga20 logo030 logo040 [ogo0a0 logol0&0 logoE3 logo70
11| (|| profive || QLA = &gs Whssics B || What's New
logol75 logol77 logo07a logo0an logo0an logolas logol96 logo033
el 19 || Prssmsssse el e | [l vy T iWeloomel | | Sholeeaod
logo39 [ogo 00 logol105 logo110 [ogo111 logol1Z2 logol 31 logo 40
I vv Prodesals LAY _-_I'__'_,-'-__.-L‘-_.l_._}]"'.'___‘_-_,g PH O PEr e
logol &0 logol 52 logo153 logo155 logol 56 logol 80 logo200a logo200b
L SR Pag g | - - .\_ \ .2 oA '-«.-\.'\-\. [ et e, ‘:-"-':“"". -. "\‘}
logo2 00 logo10a [ogo:1 b [ogo1 O logodl 0a logot Ob [ogo3t Oc [ogoi3t 0d
logod15 logod 20 |ogod20b |ogod 20 [ogof00 logof10 logof30 logo540
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lagoB00a |agoB000 [ogoB00c |ogo&00d |ogoR00e [ogoRO0f lagoB0dg logoB15
News e f A
[ogoB20 [ogoEa0 [ogoE40] logoy10a logoy10b logoy10c logoy 20a logo720b
LYy || A
lago¥ 20z |ogo¥20d logo#30a logo 300 logo¥ 30 logo¥30d logo?30e logo¥ala
logoy/S0b [ogo/S0c logo?®la logoyS1h logoySlc logo8lha logod20a [ogo320b
bout us | [ 4] rofile Feeple & T | el e | TSR ]
lago320c logn330a logo330h0 logo340 lagoa70 [agoa7 logoS72 lngo330
i ray e | | - 5 Mt "
07 || N ||COOL| H OT| it ew | |Profile H@%ﬁ
logo3En logo382 logo3a3 logo3a4 logo3ah logo3aE logo3a7 logo38a
aRc B8 it *k
logo98a [ogoSan [ogoSE
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Buttons

btn009a btn003t btn003: b0 Oa b0 Ob btn01 O btn11a btni1 16
;’l m; : fm : r},ﬁ =Eil=k:
I:utr;lil\{: Etn01 22 bt 26 bt 2 bt 32 btnd1 3k btnl 3 Etni1 45
: / s | [ R | | P |
I:utnE;1 4h btn0 4c: b0 5a b0 5b b0 Se: btn017a btn01 b btni 7
mact Ferm Ton
btni30a btn030b btr030c btr032a btn032b btn032c btn041a btn041b
e e | o s e ) ﬁ%ﬂﬂ
btn041c btn042a btnd42b btn042c btn051a btn051b btn051c btn0G0a
s | Q_ﬂ T (T (T ] [ o0 o [0
BtrOB00 btrO60: btr0B1 & btr0B1 b btr0E1 & btn071a btn0716 Btri71c
Eaen ) |_omw )| |__wer ) |eines | s m@"ﬂ’% Niaat
btr0&1 & btr0&1b btn0&1c btrl 01 a btrni101b btrni01c btrl15a btrl150
Il"f gear o (TEEEy s :'EW‘—_.--’ ‘am:-w. .NE‘I:T @ TR m
btr115c btn121a btn121b btnl121c btn131a btn131k btn131c btn132a
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e

[ o
btrl13z2b btnl32c btrn141a btr141b btnldlc btn1E1a bin1B1hb btn1B1c
btr171a btr171b btr1 7l btr181a btn1E1hb btn18lc btni191a btn191b

BACH ' TEE « Back " | H:u:F) ’ M \")
NEWS
btrn191c btn201a btn201b btn2e btn290a btn290b btn290c btn300a
I -J d _|'_ PAELPS ¥ IR ' _?_ E t-‘l
N | —— — || MATIL || . || oIS
TS T e S MNEIG
btn300b btn300c btn300d btn300e btn300f btn400a btr400b btr400c
e . Bl vews |9 san |[i] nome ‘ Iru:{ox S News
btrd01a btnd01b btn4il btn402a btn40zb btn402c btndl3a btnd03b
Tﬂplcﬁ o Index \';r' Home v Menu L & * "7'__.-
btnd 03 btnd04a btnd04hb btnd0dc btnd05a btra050 btrd05e btnd0Ga
= Index |= Home (|~ Menu m } ﬁ@‘ﬁw_&j‘- LN
btnd0sh btnd06c btn407a btn407h btn407 btn405a btnd08b btnd08c
btrd09a btrd 09k btn405e btr410a btrd10b bt O AR bind11b
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T : Contents |||[ proe WEhck |
btnd11c btnd12a btnd12b btnd12c btnd13a btrnd13b btrnd13c btnd14a
L
btrnd14b btnd14c btnd15a btnd15k btnd15c

Rollover images

O

over button on the WebArt Gallery tab.

The following images are displayed when you start WebArt Designer and click the Roll-

(en |77 T E=X
B | o | A
roll010 roll020 roll020 roll040 roll050 rolld70 roll0an o110
o o o -
e w - ' E - I—J ‘
rall120 rolll 22 roll1 23 roll1 24 roll1 26 roll1 28 roll211 roll215
| E—— [y v -
S P !
e o | | o || P g % )
rall220 rall230 roll231 roll232 roll24 roll250 roll261 roll2 70
V(|| @ ||| 2| 2| =
o b x : achk i
-I"'J @ @ _.:-"'r} b B b - r—
rall310 roll315 roll316 roll317 roll320 roll330 roll340 roll350
. -y -,
[ 9’ t _’mrlm oy ) BACK $
L I L ’ T ——— g g BT
?‘ ,t A L Stk ) 3 f‘
rall360 rall 370 rall330 rall330 rall400 ralld10 rall510 rall520
T 1 T lr.‘"' ¢ BACK ER=X A E
/ [FAAIL T 2 — e N g fude
f | = A =] I IIJ : b I
4 it || oI wmﬁn @ |G N 'V
roll540 roll570 roll5a0 rollg30 roll340 roll350 roll360 rall370
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4. Click the Insert button| @ . The selected

Insert

How to insert a WebArt-format image is inserted at the cursor position on the
image page being edited.

. . . . . & & Nomal | HTML Source | Preview | [ Stndsd | CENTER
To insert an image file in WebArt format into your E

page, do the following: .
@. <IMG src= >

1. onthe Gallery tab in the Site/Gallery View, click
the Gallery button |2 | On the upper part of

Gallery

the Gallery tab, a list of categories for the mate- welcome to my home page | |
rials provided by Homepage Builder appears. Gardening g
2. Click WebArt. On the lower part of the Gallery ?u g
tab, thumbnails of WebArt images appear. 5 o
Gallery tab
l The selected image has been inserted.
o2 gie @ ”ew|
Gallery button m o % e s»\ °* Thefile format of the WebArt image inserted
i| ) is automatically converted from WebArt
5 — Click here. (*.mif) to GIF or JPEG.
5] Style shest
S j e There is another way to insert a WebArt
- = image file from the Gallery: Click Insert -->
2 o e s et 2] Image File --> From Gallery on the menu
3 bar.

btn003..  btn009..  bn009..  btr010,

el
bin010. bte010. bin017 btril11 | A ||St Of
4 WebArt

images is

displayed.

Yiew Setup Inseit

3. Click the image you want to insert into your
page.

[ Image fies L.t ing: png; bops it e i x|

3

btn003...  btnOO3..  btnd03..  bind10

¥

btn010...  bn010... btnd11.. btnO11..

\V:-Vn

‘_'_ 3 ¢ E +— Click animage

bn011 BROTZ . b1z bwd12 to select it.

btn3.. bin013. bik3. bin014, LI

8. =] wl—0y~— Insert button

Yiew Setup Insert
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Materials for sounds

Homepage Builder provides several sample sound files.

A list of sound files

Type of sound File name
Personal Sports sports1.mid
Casual casual.mid
Relax (piano) relax.mid
Travel travel.mid
Hobby hobbymid
Cooking cooking.mid
Baby (music box) baby.mid
Pet pet.mid
Mystery mysterymid
Business Presentation presen.mid
Information info.mid
Event event.mid
Manufacturing, technology factorymid
News news.mid
School Athletic meet (sports) sports2.mid
Picnic picnic.mid
Science experiment science.mid
History history.mid
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How to insert a sample sound
file

To insert a sound file from the Gallery as background
music, do the following:

OMHIME  <EMBED src=>

1. onthe Gallery tab in the Site/Gallery View, click
the Gallery button & . On the upper part of
the Gallery tab, a list of categories for the mate-
rials provided by Homepage Builder appears.

2. Click Sound. On the lower part of the Gallery
tab, thumbnails of sound files appear.

°8 sie @ aauew{— Gallery tab

Gallery button -E Folder Boa%nalk Hlstoly
11 Line =
(23 Listmark.
(20 Phate
3 Walpager J
BEer — Click here
=l
[ & Sound fies (mid: wav) =
Tabymd casusl.. cooking.. evertmid |
factony history hobbymid infomid A list of
mystery. newsmid  petmid  picnic.mid displayed.
presen.. telnmid science... sporsl...
View Sewp  Ineat

3. Click a sound file.

Learning the basics

[& Soundies Lmid: wav) - |

BEEE:

babymid casudl.. cocking.. evertmd ||

&]a]a])

factor...  histo.. hobbpmid info.md

&]a]a])

myster. newsmid petmid  picricmid

EOEIET St

Click a file to
select it.

presen.. relmmid soience.. spotts]

oo
oo

Wiew SEND In

Insert button

4. Click the W button next to the Insert button
& and then select Play from the pop-up
menu. A program associated with the selected
sound file is started, and you can play back the
selected sound file.

)
0

5. Repeat steps 3 and 4 unii you find the sound
file you want to use.

To play back a sound file, you need a sound
card installed in your computer.

6. Select that sound file, and then click the Insert
button ' &, . The selected file is inserted into
your page as background music.

@\ °© Thereis another way to insert a sound file from the Gallery as background music: Click Insert --> Back-

¢ Toinsert a sound file not included in the Gallery: Click Insert --> Background Music --> From File

ground Music --> From Gallery on the menu bar.

on the

menu bar; or click the Folder button on the Gallery tab, and then select a sound file.
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Materials for style sheets

A style sheet controls the appearance of elements on your page—such as the font
and color. You can either embed a style sheet into your page (HTML file) or pre-
pare a separate style sheet file and set a link to it from your page. Homepage
Builder provides several sample style sheet files.

s\ For details on style sheets, see Chapter 15.
N\

@ The following are examples of various style sheet files applied to a sample page. The

actual appearance of a page to which a style sheet is applied is determined by the con-
tents of the page.

A list of style sheet files

b01.css b02.css b03.css b04.css

b05.css b06.css b07.css b08.css

Heading | Heading |

Heading | Heading |

b09.css b10.css b1l.css b12.css
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[eewra—

Heading 1 Heading 1
He

—TTET—
T Bt bonc e
[m e

c04.css

c08.css

Heading 1 Heading 1

b14.css

c05.css

c09.css

[ Feading 1 Heading 1

g03.css

b15.css

b16.css

Heading 1 Heading 1
Heading 2 Heding 2
kg3 adon 3
[

c02.css

Heading 1 Heading 1
Heading 2 Heding 2
kg3 adon 3

c06.css

c10.css

Heading | Heading 1
Heading 2 Hending 2
v 3 o3

c03.css

c07.css

pOt.css

SRR e Enerars

gOt.css
R
FITTTEETETTITES

e e e e o8 A R R e e e e e

p02.css
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Heading 1 Heading |

Heating 2 Headuos 2

p03.css

pQ7.css
BT
YT
I

t03.css

5

(o4}

t07.css

Heading | Heading 1

110

Heading i Heading |

teaing 2 Heading 1

pR—r—

t08.css

Heading 1| Heading |

Hoadiag 2 Heating 1
B g g

t01.css 102.css

t05.css t06.css

e

109.css t10.css



How to apply a sample style
sheet file

To apply a style sheet file included in the Gallery, do
the following:

<LINK rel="stylesheet" href=>

1. onthe Gallery tab in the Site/Gallery View, click
the Gallery button & | On the upper part of

the Gallery tab, a list of categories for the mate-
rials provided by Homepage Builder appears.

2. Click Style sheet . On the lower part of the Gal-
lery tab, a list of style sheet files appears:

Gallery tab

°8 sie @ Galey |
Gallery button JE & . 8

|1 Manual materials
|_1 Bonus templates -

[ swie sheet fes (oss)

blloss  bO02ess  bD3.css

— A list of style
sheet files is
bil.ess displayed.

B . R 3

View Setup Insert

3. Click the Setup button ﬁ and then select
Style Sheet Test Mode from the pop-up menu.
Homepage Builder enters style sheet test mode.
By clicking a style sheet file while in this mode,
you can preview how the selected style sheet
changes the appearance of your page.

4. Click style sheet files one by one until you find
the one you want to use.

Learning the basics

i e
JSEIET)

BIuU &x8]| -] FalmE
ol

= |
stie e

T ol —

If you click a
style sheet file...

you can preview the page with
the selected style.

Selup

select Style Sheet Test Mode again to clear the
check mark. Homepage Builder exits from style
sheet test mode.

use, click the Setup button ' J | and then

. Select a style sheet file, and then click the Insert
button 2, . A link from the page being edited

to the selected style sheet file is set, and the
style is applied to the page.

welcome to my home page

If you click this button, the style is
applied to the page.

111
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Using the style sheet preview
function

If, for example, your page is still blank or does not
have much content yet, use the style sheet preview
function instead of using the style sheet test mode.

1.
2.

Select a style sheet file.

Click the down-arrow button W next to the
Insert button, and then select Preview Style
Sheet from the pop-up menu. In the Preview
Style Sheet dialog, a sample page that uses the
selected style sheet file appears.

. Click the style sheet files one by one until you

find the one you want to use.

. When you have decided which style sheet file to

use, click the Apply to Page button. A link from
the page being edited to the selected style
sheet file is set, and the style is applied to the

page.

a»\ |If a site is being opened, you can apply the

112

selected style sheet file to the entire site—that
is, all the pages in the site—by clicking the
Apply to Site button.




Learning the basics

Materials for Java applets

A Java applet is a program written in the Java language. Homepage Builder does
not offer functions for creating your own Java applets, but it does provide many
sample Java applets. By changing the parameters (the options that are passed to
the program) of an applet, you can change the background and behavior of the
applet, and the text to be displayed.

A list of Java applets

overlaid on the shuttle body in the background.

Name Description Typical parameters
Airplanes fly in formation across the window and then Text, scroll width, sound,
E leave. Your text is constructed from smoke trails in the | background color, ...
clear blue sky. All text is displayed in capital letters.
AirShow
Many small images float on the screen. If you click an | URL of the image files, URL of
image, a new window opens, and the page you asso- the link destination for each
X ciated with that image is displayed. By changing the image, ...
parameters, you can create your own link pages or
Flylmage album pages with motion. @ For best results,
4 specify about 20
image files.
This applet causes a foreground image to blink. Com- | Foreground image, back-
B bining blinking foreground images with nonblinking ground image, blinking inter-
- background images can make your Web page presen- | vals, ...
tation more fun and attractive. In this sample applet,
ImgBlink the blasts from a space shuttle in the foreground are

ImgFade

The images you specify fade in and out in succession.
This applet is effective when you want images to be
presented in order, like a slide show. In this sample
applet, four images are specified, each displaying a
seasonal landscape. One season fades in, fades out,
and is replaced with the next season.

URL of the image files, image
file names, time span for dis-
playing an image, ...
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Description

Typical parameters

ImgPlay

A succession of images is displayed in an animated
series. For example, pictures of your face taken from
different angles can be displayed, giving the appear-
ance of rotation.

How to use the jog shuttle:  The jog shuttle enables
you to play your animation frame by frame, or even
backwards, with a simple mouse operation: Click the
jog shuttle and move the mouse pointer in a circle on it
(do not drag). If you move the mouse pointer clock-
wise, the animation plays forward as the jog shuttle
rotates clockwise. If you move the mouse pointer
counterclockwise, the animation plays backward as
the jog shuttle rotates counterclockwise. To cancel the
jog shuttle, click again.

URL of the image files, image
file names, the number of
frames displayed while the
jog shuttle makes a turn, ...

An image and text scroll together horizontally. For
example, you can scroll your favorite portrait and its
title. Also, you can scroll an image by itself or text by
itself.

Image, text, color of the text
board, scroll width, ...

3
@
7]
T
-

The specified image is split into pieces which are then
gradually rejoined, restoring the original image.

Image, number of splits, time
span for displaying each
piece of an image, ...

ImgWhirl

An image rotates.

Image, sound, time span for
displaying each angle of an
image, ...

e

An image zooms in and then zooms out.

Image, sound, time span for
displaying each image, ...

ImgZoom
A message scrolls from right to left; the text can Text, color of the text board,
change color or blink. scroll width, ...
MsgBoard
You can add flashing lights around a plain signboard, Text, color of the text board,
foozeg like those you would see at the entrance of a movie blinking intervals, ...
T theater.
SgnBoard
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Description

Typical parameters

A message appears character by character on plac-
ards, held by fans in a baseball or football stadium. All
text is displayed in capital letters.

Text (up to 4 characters),
color of the text, background
color, ...

Stadium
A message emerges from a central point and spreads Text, text color, background
to left and right until it relaches the sides .Of a bulletin color, ...
board. You might use this applet as the title of your top
page.
Stretch

WaveText

The text moves up and down as though on a wave.
Specify colors only for the first and last characters. The
colors for the rest of the characters are automatically
assigned tints, gradually changing from the color of the
first character to the color of the last character.

Text, color of the first letter in
the text, color of the last letter
in the text, ...
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How to insert a sample Java
applet

Though you cannot create Java applets with Home-
page Builder, you can modify, or customize, the size
and movement of the sample Java applets provided
with Homepage Builder. This section describes how
to insert and customize a sample Java applet that
Homepage Builder offers.

ORIME <APPLET code= codebase= width= height=>
<PARAM name= value=>

Inserting a sample Java applet

The following example explains how to insert the
sample Java applet named MsgBoard into your
page. This applet displays a message in which the
letters change color and blink.

1. onthe Gallery tab in the Site/Gallery View, click
the Gallery button B . On the upper part of
the Gallery tab, a list of the categories of the
images provided by Homepage Builder

appears.

2. Click Java applet . On the lower part of the Gal-
lery tab, thumbnails for the sample Java applets
appear.

58 st @ Gaer)—————— Gallery tab

Gallery bution B &, o &

|1 Wallpaper =]
L Webdnt

+— Click here.

— A list of Java
applets is
displayed.

= |

B - =]

View Setup Insert

3. Clickan applet. For example, click MsgBoard .
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[ Java applet files =

— Click an applet
to select it.

- |
B - fa =l

View Setup Insert

4. Click the down-arrow button W next to the
Insert button &), , and then select Preview
Applet from the pop-up menu. A Web browser
starts, and you can view the behavior of the
selected Java applet. The MsgBoard applet, for
example, shows a message "Welcome to my

Web page!!" in a frame.

5. When you have decided which applet to use,
select it (for this example, select MsgBoard ),
and then click the Insert button & . The

selected Java applet is inserted at the position

of the cursor on the page being edited. The

Java applet is indicated by an alternative image

as follows:

Standard APPLET

& £ Nomal | HTHL Source | Preview |

welcome to my home page

Garaeiimng,
Message Bulletin Board

0L L[ Ir [ [ [ 1L
fetioffctiofictrt{etioq fenio fetio] fetio ettt i

.

3 \ P

L3 |

The selected Java applet is inserted into your page
(this is just an alternative image).



e You cannot run Java applets in the Home-
page Builder page editing area. (An alter-
native image is displayed instead of the
actual Java applet.) Java applets run only
on a Web browser that supports them.

@

e |f you insert one of the sample Java applets
and cannot check its movement with the
Preview tab, save the Web page that con-
tains the Java applet. The files composing
the Java applet are copied from the folder of
sample materials into the Web page sub-
folder. You can then check the movement
with the Preview tab.

A single Java applet is composed of several
files. If a Java applet has been inserted as
described in this section, a subfolder for the
Java applet is automatically created when
you save the Web page you are editing, and
all the required files are copied into it. When
you upload your files to the provider's
server, you must also upload the subfolder
for the Java applet and the files in it. If your
provider does not permit the use of subfold-
ers, move the entire content of the Java
applet subfolder to the top folder and erase
the codebase attribute of the <APPLET>
tag.

Changing the size of a Java applet

To change the size of a Java applet you have
inserted, click it, and drag one of the eight black
square knobs around it.

Drag like this...

Gardening Ei Flowers in seaso:

| Fgﬁ?ﬁ'i-li'ﬂ?!irﬁﬂe"li"'f!!ﬁ-'igluﬂ|-|e||on||-|e||o"||-|e||on||-|e||o"||-|e||o"|E
|'Ie||o!!||'Ie||o!!|I‘Iello!!”’lello!!”‘lel:i!l|-Ie||o!!”-|e|lo!1| petioffieiiot]fd

¥

Learning the basics
...to change the size like this:

Gardemng

:; Flowers in season

Bulletin Board

fotoffetoBettof etoffetoetioq o etotfienodfs
TP ) e e e e

Customizing a Java applet

You can easily customize a Java applet by changing
its parameters, such as the image or text used in the
applet, the text or background color, and the speed
of movement. Change them according to your own
personal taste.

s»| How to view detailed information on
applet parameters

To view detailed information on the parameters
of an applet, do the following:

1. Click the Gallery button on the Gallery
tab, and then select Java applet . A list of
applets appears.

2. Select the one you want to use.

3. Click the down-arrow button next to the
Insert button, and then select See
Applet Explanation from the pop-up
menu. A Web browser starts, and the
HTML file that contains an explanation of
the applet is displayed.

In the following example, you will change the param-
eters of the applet called MsgBoard to display the
text of your choice.

1. select the Java applet that has been inserted
into your page.

2. Click Edit --> Attributes  on the menu bar. The
Attributes dialog appears.

3. Click the Parameters tab. A list of parameters
for the applet appears.
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Attributes

Tag IApplet j

—fpplet p

MName | WValue -
text Welcome to hblue my Sre
board_colors

seroll_width 10

fant

zound

sound_mode -
2 B

Hame: Itexl

WValug: IW’eIcnme to Ablue my red'w'eb page \blink\bla

Add | Eeplace Dielete Clear

Cancel | Help |

o]

Click the parameter you want to change. The
parameter name is displayed in the Name field,

and the parameter value is displayed in the
Value field.

Change the parameter value in the Value field,
and then click the Replace button. For exam-
ple, change the value of the 'text' parameter as

follows:

\blue Purchase our pet supplies and
\red get a free coupon \blink now!

Altributes
Tao: IApp\el j
Applet  Parameters I
i Applet p
Mame | Walue -
text wielcome to Yblue my e
bgard_colors
saroll_width 10
sound_mode -
Lo =
q | ij
Hame: Ilekt "
Walue: I\blue Purchase our pet supplies and Yred gst a f
Add | Feplace | Delste | Clear
ak _I Cancel | Help |

Change the parameter value.
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Insert a single blank space after an attribute
such as \blue (blue), \red (red), or \blink
(blink).

6. Click the OK button.

/. Click Tools --> WWW Browser on the menu bar
to start a Web browser. (If a message asks you if
you want to save files, click the Yes button.) The
message, "Purchase our pet supplies and get a
free coupon now!," appears in a frame.

File Edi View Go Favorites

|8 Gardening - Microsoft Internet Explorer I[=] S

- I D

> 3
E2of Fonerd Stop Fefiesh  Home

Ful

Search  Favortes  History  Channels

Addkess [€] C:AMy Documents'newpage2 hm | “ Links

. .J*u‘_j‘_r-' W ow LT

B A R BB Al B g B N
BN ol B

Y
welcome to my home page ‘
Flowers

Gardening in

season

Purchase our pet supplies anl

2] Openin| [ [ [E1Hy Computer

L =
£

The text of the message has been changed.
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How to insert your own Java applet

To insert your own Java applet (rather than one
of the sample Java applets provided by
Homepage Builder), do the following:

1.

2.

Create a subfolder for the Java applet in
your site folder.

Copy all the files that compose the Java
applet to the subfolder you created,
including, for example:

e Class files (*.class)

e |mage files and other files specified in
the class files

Click Insert --> Others --> Java Applet
on the menu bar. The Attributes dialog
appears. Confirm that Applet is dis-
played in the Tag list box.

Type the class file name in Code, the Java
applet subfolder name in Code base, an
explanation of the Java applet in Alterna-
tive text , and the size of the Java applet

in Width and Height .

On the Parameters tab, enter the param-
eter name in Name and the correspond-
ing value in Value, and then click the Add
button. Repeat this step for the number
of parameters.

Click the OK button to insert the Java
applet. The applet is indicated by an
alternative image. (You can view the
actual Java applet on a Web browser or
the Preview tab. To view the applet on
the Preview tab, first save the Web page
where you inserted the Java applet.)

SOVUU

The selected Java applet is inserted
(this is an alternative image).

Learning the basics
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Materials for scripts

You can create a script program by using the script editor that Homepage Builder
offers, and insert it into your Web page.

By inserting a program written in a script language, you can achieve various effects
on your Web pages. For example, a script enables you to do the following:

» Gradually change the background color of your Web page
* Display the current time
+ Display a scrolling message in the status bar of a Web browser

Homepage Builder provides several sample JavaScript files as follows:

A list of script files

File name Description
bgchange.js Gradually changes the background color of your Web page.
lastupdt.js Displays the date and time the page was last modified.
scroll.js Displays the scrolling message "Hello everyone. Welcome to my Web page..." on the
status bar of a Web browser.
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How to insert a sample script
file

You can insert a JavaScript program from the Gallery
into the page you are editing. The following example
explains how to insert a program that displays a
scrolling message on the status bar (generally, the
bottom line) of a Web browser.

OMHIME <SCRIPT language=>

1.

On the Gallery tab of the Site/Gallery View, click
the Gallery button & . On the upper part of

the Gallery tab, a list of categories for the mate-
rials offered by Homepage Builder appears.

. Click JavaScript . On the lower part of the Gal-

lery tab, thumbnails of the JavaScript files are
displayed.

Gallery tab
°8 ste & Gl |
Gallery button -8Rl 2 £, &,
[0 Walpaper ;l
-
| Click here.
|2, JarvasSeipt fes () =
bgohan. lastupdtjs  scroll js
— A list of script
files is dis-
played.
B 2] &1

3.

View Setup Inseit

Select file scroll.js , and then click the Insert
button 2, . The selected JavaScript program
is inserted at the cursor position on the page
being edited. The inserted JavaScript is indi-

cated by the & mark.

. Click the Preview tab to check the movement of

your page. On the status bar of the Preview
tab, the message "Hello everyone. Welcome to
my Web page..." is displayed.

Learning the basics

5. Asthe last step, view your page with a Web

browser. Click Tools --> WWW Browser on the
menu bar, and then select a browser name from
the submenu to start a Web browser. (If a mes-
sage appears, asking you if you want to save the
files, click Yes.) Your Web page is displayed on
the Web browser. On the status bar of the
browser, the message "Hello everyone. Welcome
to my Web page..." is displayed.

a5\ To change the text of the message, click the
A4 & mark that has been inserted into your

page, and then click Edit --> Attributes on
the menu bar to display the Script dialog.
Then change the text string as you like.
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Part 2. Applying Homepage Builder

T
For experienced Homepage Builder users

Part 2 explains Homepage Builder functions in detail for users who
are now acquainted with the basic operations explained in Part 1
and want to use more advanced methods.

Part 2 contains the following chapters. Chapter 7 summarizes all
the functions provided by the main program of Homepage Builder
and by the tools offered by Homepage Builder—WebArt Designer,
Web Animator, and File Transfer. Chapters 8 through 15 describe
operations for the typical tasks in detail. Chapters 16 through 18
explain the major functions provided by each tool.

Chapter 7. Summary of Homepage Builder functions.. . . . . 125
Chapter8. Pagesandsites......................... 189
Chapter 9. Editingtext........... ... ... ..., 203
Chapter 10. Creatingtables. ... ...................... 219
Chapter 11. Insertingimages . .........c.uviiureennn. 231
Chapter 12. Settinglinks . . ........ ... ... .. ... .. ... 249
Chapter 13. Creating sophisticated pages .............. 259
Chapter 14. Creating pages withmotion................ 289
Chapter 15. Using stylesheets . .. .................... 301
Chapter 16. Uploadingfiles.......................... 321
Chapter 17. WebArtDesigner . ............ ... 329
Chapter 18. Web Animator ............. ... ... 351
Chapter 19. Other useful functions . ................... 363

Chapter 20. Creating Web pages accessible to everyone .. 375
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I Summary of Homepage Builder functions

This chapter summarizes all the functions provided by the main program of
Homepage Builder and by the accessory tools offered by Homepage
Builder—WebArt Designer, Web Animator, and File Transfer.

Some of the basic functions provided by the tools are also offered by the main
program—for example, editing images or uploading files. If, however, you
want to use a more advanced method or do more specialized tasks, these
tools are for you. WebArt Designer assists you in creating images such as
logos and buttons, or even a rollover image—an image that is replaced by
another when the mouse pointer is placed over it. Web Animator helps you
create animated GIF files. File Transfer enables you to upload individual files
related to your Web pages and to delete files from the server.

Homepage Builder functions .......... 126
WebArt Designer functions .. .......... 163
Web Animator functions . ............. 177

File Transfer functions . ............... 185




Homepage Builder functions

You can access all of the Homepage Builder functions from the main window. This
[ | section explains each component in the main window—the Site/Gallery View, the
page editing area, the menu bar, and the toolbar.

Homepage Builder main window

The main window of Homepage Builder has the following components:

Site tab Normal tab Menu bar
Gallery tab HTML Source tab Toolbars
Preview tab
Button for
4. WebSphere Homepage Builder- [index.htm - Cooking >age *] i
Fil du Vie! gval Insert Table Fame Site u\s Window |Help (&) x| Changlng
|ofzB8s seae o mERH 2 e|aeo]@u— =2F 5 S| attributes of an
| e = element
M= el LS e
Mo sitd s open al | HTML Source | Preview| | Stepaand oDy
o sie & el |
m |
Folder Bookmark Histary
Site folder - ° Button for
vl | ———————— switching the
3 Animation
£ Bommer target browser
(21 Button

WELCOME TO MY AOMEPACE

Cooking page
ban0... b_ani0l... b_an0l... b_anill.. 2
— —
HOME | 'NDEX @4
o | —
ban1... b_ani0l... b_an0l... b_anill.. Mail o
— !
i@ & 1.
B . Fa & .
\iew Setup Insert
== [C:\My Documents'steTNindss htm
Status bar Page editing area

Site/Gallery View

" For instructions on using the functions of Homepage Builder, see Chapters 3 through 6, 8 through 16, 19,
{ and 20.
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Site/Gallery View

You can use the Site/Gallery View to confirm the link status of your site and to insert materials into your page.

The Site/Gallery View contains two tabs: the Site tab, for checking the site status; and the Gallery tab, for

inserting materials.

Site tab

Gallery tab Separation button
‘Nosile i open. | &8 x———— Close button

——D[E Site @ Galleny |

&

Folder Bookmark. Histary

Site folder -
Personal folder
Image

3 Animation

(3 Barner

(2 Button

23 leon -

- —— |
I_m Image files [ aifjpg:]pna bmp;. wrlf:.emf:. tij

N

- .L;‘/ ' ‘i/j

b ani00.. b ani00.. B ani00.. b ani00..

<o | %2 %

b_ani00... b_anilD... b_ani00.. b_aniO0...

| i

b_ani00... b_ani01... b_ani0l... b_ani01...

Bt e

b_ani0l... b_ani01... b_ani01... b_ani0l...

e 29 9 14
=] ]

oo
oo - -

Wiew Setup Inzert

The separation button and the close button

On the top-right corner of the Site/Gallery View are the following two buttons:

If you drag this boundary line, you
can freely change the position of the

boundary.

If you click this part on the Gallery

tab, you can move up the boundary
line to the top. If you click here again,
the boundary line is reset to its origi-

nal position.

dow, allowing you to place it anywhere you like. To rejoin the separated Site/Gallery

QI If you click this button, the Site/Gallery View will be separated from the main win-

Separation button

View with the main window, double-click the title bar of the Site/Gallery View.

If you click this button, the Site/Gallery View closes. To display the Site/Gallery View
x again, click View --> Site/Gallery View on the menu bar.

Close button
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Site tab

The contents of the Site tab appear only when a site is open. The Site tab contains the following two buttons.
The contents of this tab depend on which button you select.

2y

Lirk.

e

Falder

128

If you click this button, you can view a list of files included in the site and their link
status. If you select a file from a tree of files in the upper part (called the link tree),
a list of files linked from that file (or a list of files that links to that file) is shown in the
lower part (called the file list area).

Link button

[Garden ax
8 Site |G Gallery |

2

Folder
=-43 Garden

You can select either Files
linked by yyy or Files
linked to yyy. Suppose
you have selected file
ABC from the link tree. If
you select Files linked
by ABC, the former
choice, a list of files linked
from file ABC appears in
the file list area. If you
select Files linked to
ABC, a list of files that link
to file ABC appears in the
file list area.

Files Linked by index htm =]

URL

L sub3him

[ sub2him

[ subT him

[ 0arde_mi gi Mail lsan

(2 garde 12 Line

(@0l gt Line
garde_il.gf Icon

[ garde_il. g [
garde_il.gf Icon

&, garde_bo.of

[ aarde_b1.gF Banner

N L]

oo - =]
Wigw Site Operation  Insert

Site tab (Link button)

Site name

= [ Ton Pagelfindss htm)
%iﬁim L— The files linked from the top
sub3.htm

page are listed in a tree struc-
ture. If you click the [+] sign
on the left of a file name, the
list is expanded to show the
names of files linked from the
file. The [ sign indicates a
correct link, and the & sign
indicates a link error.

s\ To change the types of files displayed on this tab, click Tools --> Options on
the menu bar to display the Options dialog. Next click the Site/Gallery View
tab, and then select the file types you like.

If you click this button, you can view the file status of your site when it is open. A list
of all subfolders and files is shown in tree structure in the lower part of the Site tab.
To make files easy to find, files are categorized as follows:

Category name

Description

Files to be transferred

Files that are to be uploaded when you click Site -->
Upload Site on the menu bar to upload the entire site.

Unused files

Files that are in the site folder but are not used in any
pages. Files in this category are not uploaded. To
move a file from this category to the Files to be trans-
ferred category, select that file from the list on the Site
tab, click the right mouse button, and then click Add
to Upload List on the pop-up menu.




Applying Homepage Builder

Category name

Description

Files with broken links

Files that contain link errors.

All files

All the files contained in the site folder.

Files not yet trans-
ferred

Files that have been changed since the last upload.

Folder configuration of the
site (if subfolders have
been created, the folder
hierarchy is shown in tree
format)

cat-

[Garden ax
B8 site | G Galley|
el
Link.
Er- Site name
3 Tap folder (C:\My Documents' gardent
Fles o be anslened
2 Unused fles
Files with broken ks
s If you select a category...
Files nat yet transferred
K F |
Name [ Title
[ index.htm Gardening
[y arde_I1.git
garde_b1.gif
garde_i1.git
[ garde_mi.gf
[y aide_2 gt
[ sublhtm New ltems
[ garde_tp.git H ]
it onty G A list of files for each
[y oeide_2 it i
sub3 hitm Flowers in Seasor, egory 1S ShOWﬂ.
[ garde iz gt
1 .
8 - )
View Site Operation  Insert

Site tab (Folder button)

¢ To change the categories displayed on this tab, click Tools --> Options on
@ the menu bar to display the Options dialog, click the Site/Gallery View tab,

and then select the file types you want.

® Between the site name and a list of categories in the upper part of the Site
tab, the folder configuration of the site is shown in tree structure. To move a
file from one folder to another, drag the file from the file list in the lower part
of the Site tab to one of the folders shown in the upper part. The file is
moved, and the Update Links Automatically dialog appears. Click the OK
button; the links set to the file are automatically corrected.
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The Site tab contains three buttons: View, Site Operation , and Insert .

oo You can use this button to switch the view of the file list displayed in the lower part
oo of the Site tab. As you click this button, the view toggles among the Thumbnail
Wi View, the Thumbnail View (Image Only) , and the List View. By clicking the

down-arrow next to this button, you can select a view directly.

" L Name [Tl
@ &“ a‘ |E| [ index him Gardening
. - (21 garde_N git
gade_. gaidei.. garde_i. gardei. oude_. gardei. gardei. garde i (@) gards b1 i
(& garde_it gif
(& garde_ml gif
1l Tlogl B
garde | garde | garde_. gardet arde . gadel. gade.. gardel. %;:"’;Eh:’p” P Hew liems
- sub2 him Monthly Cares
afale]e)] |-
[ subi3 htm Flowers in Seasar
indexhtm  subT.htm  subZhtm  sub3 htm indexhtm sublhtm  subZhim  sub3htm &galde_iﬁ aif
= = [ R 0|
View Site D’:.:.aunn ||:§n - View ey Dﬁratinn ||ign - vien She Dperation  Insent
Thumbnail view Thumbnail view List view
(images and HTML files) (images only)
1 There are no thumbnails for frame-setting pages.
>
%’ If you click this button, a menu containing the following items appears. (Depending

on whether the Link button or the Folder button is being selected, the menu con-

iz L islicl) tains different menu items.)
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Menu item

Description

New Site

Creates a site.

Site List and Settings

Lists all the sites you have created. You can change
their settings.

Upload Site

Uploads only files that have been updated since the
last upload. When you upload your site for the first
time, all the files are uploaded. If the files are already
on the server, you can upload only the updated ones
by selecting Mark All Files as Uploaded from the
File Upload Settings submenu.

Upload Page

Uploads only the page being selected.
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Menu item

Description

File Upload Settings

Creates, changes, or deletes the file upload settings—
the server name, the user ID, the password, and the
destination folder. Select one of the following from the
submenu:

e New Upload Settings:
settings.

¢ Edit Upload Settings:  Displays a list of file
upload settings. You can change or delete exist-
ing file upload settings.

e Mark All Files as Uploaded:  Sets all the files in
the site as "already transferred." If the server
already contains your latest files, you can upload
only the updated files by selecting this menu
item.

Defines new file upload

Change Permission

Changes the access permission of a file on the server.
Some servers might not allow you to use this function.
(See Note)

Add to Upload List

Adds the selected file to the list of files to be uploaded
to the server. (See Note)

Delete from Upload List

Removes the selected file from the list of files to be
uploaded to the server. (See Note)

Convert File Name into
Lowercase

Converts the name of the selected file to lowercase
characters. (See Note)

Site Style

Sets the style of the entire site. Select one of the fol-

lowing from the submenu:

e Set Site Style: Sets a new style for the site. Fol-
low the instructions on the wizard that appears.

e Remove Site Style: Cancels the style set by the
above menu.

e Edit Site Style:
above menu.

Edits the site style set by the

Refresh Site Informa-
tion

Refreshes the site information to reflect its latest status.
If you changed files in the site but the changes are not
reflected in the Site tab, refresh the information using
this menu item.

Close Site

Closes the currently open site.

Note: This menu item is displayed only when the Folder button is being selected.

131

suonouny Japjing abedawoH jo Alewwns H



132

2]

Inzert

If you select a file and then click this button, the selected file is inserted into the
page you are editing. If you select a file and then click the down-arrow button next
to this button, the tasks you can do on the selected file appear on the menu:

Inzert on Page

Inzert as Background Image
Show Qriginal Size

Edit Image...

Open with Image Editor

Open with 'Webdrt Designer
Open with *eb Animatar

Open with Browser >

Copy
Delete

Bename b_ 3w gif

The menu contains the following menu items. Depending on the type of file being
selected, the menu contains different menu items.

Menu item

Description

Edit

Opens the selected HTML file as a page.

Open with Text Editor

Opens the selected HTML file with a text editor.

Insert This File into
Page

or

Insert into Page

Inserts the selected file to the page being edited.

Insert Link to This File
into Page

Inserts the text "Link to (filename)" or "(title)" on the
page being edited, and a link to the selected file is set
on the text.

Insert as Background
Image

Inserts the selected image file as the background
image of the page.

Insert as Background
Music

Inserts the selected sound file as the background
music.

Show Original Size

Displays the image file in its original size. The Show
Original Size dialog appears.

Edit Image

Edits the selected image file. The Edit Image dialog
appears.

Open with Image Editor

Starts the image editor program registered on the
Applications tab of the Options dialog, and opens
the selected image file for your editing.

Open with WebArt
Designer

Starts WebArt Designer, and opens the selected
image file.

Open with Web Anima-
tor

Starts Web Animator, and opens the selected image
file.




Gallery tab

Applying Homepage Builder

Menu item

Description

Open with Browser

Opens the selected file on a Web browser. You can
select the type of Web browser you want to use.

Play

Plays the selected sound file.

Stop

Stops playing the selected sound file.

Preview Style Sheet

Displays the Preview Style Sheet dialog. This dialog
enables you to check the layout of the selected style
sheet, and apply the style to the current page or the
entire site.

Style List Displays the contents of the selected style sheet. The
External Style Sheet dialog appears.

Cut Cuts the selected file and copies it into the Clipboard.
(See Note)

Copy Copies the selected file into the Clipboard. (See Note)

Paste Fetches the file from the Clipboard and pastes it in the
selected folder. (See Note)

Delete Deletes the selected file. (See Note)

Rename Renames the selected file. (See Note)

Note: This menu item is displayed only when the Folder button is selected.

You can use the Gallery tab to insert materials—images, sounds, scripts, applets, and other files—on your

page.

Folder button

Bookmark button

[Garden
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Gallery button_lﬁ B e A History button
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View button

Setup button
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)
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Insert button

Gallery tab
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There are four buttons at the top of the Gallery tab: Gallery, Folder, Bookmark , and History.

When you click this button, the contents of the Gallery appear by category. To
ﬁ insert a file on your page, select a category from the upper part and a file from the
Gallery lower part, and then click & .
‘Gelden ax
o8 sie @ Gal\evyl
= &
Folder Bookmark: History
[0 Banner | B
[Z Button
S Paton Select a material category.
B bk =

[ g files .gitipa: g bmps s et 2]

El

—— A list of sample materials appears.

View Setup Insert

Gallery tab (Gallery button)

When you click this button, all the folders and files you can access are displayed.
|:| To insert a file on your page, select a folder in the upper part and a file in the lower
Falder part, and then click [ & |. You can insert not only the materials offered by Home-

page Builder, but also any materials you can access from your personal computer.

[Garden ax

58 sie @B Gakey |

Gallery Bookmak  Histary

; LR A From the list of folders displayed,

gﬁ o select the folder that contains the

_8 ot o file you want to insert.
R

5 auies ) = Select the type of files you want to

display. If you want to display all
types of files, select All files .

B
(owmction

b_ouD.. b_oul. b_cull. b_cut

EE38

boul.. bowd. b_cull. b_cut

&l S

b_cul. b_oull.. b_cull)

——— A list of sample files appears.
b_outD.. b_cull. b cutd. b_cutfl
=

[ ][ .. -4
- Bo@) .

Wigw Setup Insert

Gallery tab (Folder button)
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Applying Homepage Builder

You can use this button to add bookmarks and use them. This button offers a func-
1 tion similar to the Favorites or Bookmarks function offered by a Web browser,
Bookmark enabling you to easily select the folders you frequently use.

To register the current folder as a bookmark, click this button and select Add
Bookmark from the pop-up menu.

£ €«

B ookmark. Higtaory

E dit BDkaarks...Eg

C:hkdy Documents
C:hkdy DocumentzhSITEZ

To select a folder you have registered as a bookmark, click 2. | and then select
the folder you want. A list of the files in that folder appears in the lower part of the

Gallery tab.

£ €«

Bookmark. Higtary

Add Bookmark,
Edit Bookmarks...

C:sMy Documents

C: Ak DocumentzhSITE 2

To edit bookmarks, click |2, | and the select Edit Bookmarks from the pop-up

menu to display the Edit Bookmarks dialog. You can then add, change, or delete
bookmarks as necessary.

Edit Bookmarks

Title | Path [ File type |
CAMyD... C\My Documents Allfles 7]
CAMYD.. C\My Documents\SITE2 Alfles (+4)

[
Title: C:\My Document ts
Paih My Diocument s Eor

File type; Al e () -

o e |

K| Caod | Hem |

If you click this button, a list of folders you have recently selected appears. If you
i, click the name of a folder, a list of files in that folder appears in the lower part of the

=y
History
1 C:hwANDOWSAD esktophOnline Services .
CAWINDOWS Desktop A list of folders you
Etmp have recently
C:MProgram FileshIntemet Explorer
oMy Download Files selected appears.
C:hMy Docurmentsihy Family
C:AMy Documents\Aquarium
C:hMy Documents

Gallery tab (History button)
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The Gallery tab contains the following three buttons at the bottom: View, Setup, and Insert .
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Wiew

Setup

You can use this button to switch the view of the file list displayed in the lower part
of the Gallery tab. As you click this button, the view toggles between the Thumb-
nail View, the Thumbnail View (Image Only) , and the List View. By clicking the
down-arrow next to this button, you can select a view directly.

M 4 oy - " Mame [ Tite
&";;: P s (4 indexhim Gardening
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[ subZhtm Manthly Cares
= [el]&)]e]e)] = |
S [ sub3hm Flowers in Seasar
inder htm subl.him b2 him  sub3 him indeshim sublhim subZhim  subdhim [ garde_i3.gil
= =l N I |
oo
ag o & oo B .
8 - B 8B -
View Site Operation Insert View Site Operation  Insert View Site Operation  Insert
Thumbnail view Thumbnail view List view
(images and HTML files) (images only)

There are no thumbnails for frame-setting pages.

When you click this button, a menu that contains the following items appears. For
some menu items, you can switch the settings on or off.

Menu item Description
Image Frame Size Changes the display size of image files in the thumb-
nail view.
Show File Name If you clear this menu while in the thumbnail view, file

names are not displayed.

Show HTML as Thumb- If you select this menu, HTML files are displayed as
nail thumbnails. This menu is applicable only to the
thumbnail view.

Change Background Changes the background color of the file list area.
Color This menu applies only to the thumbnail view.
Play Animation If you select this menu, you can see the movement of

the animated GIF files. This menu applies only to the
thumbnail view.




2]

Inzert

Applying Homepage Builder

Menu item

Description

Wallpaper Test Mode

If you select this option, the display will change to
show you what your page will look like if the selected
image file is inserted as wallpaper. Itis recommended
that you leave this option off, and select it only when
you want to insert wallpaper.

Style Sheet Test Mode

If you select this option, the display will change to
show you what your page will look like if the selected
style sheet is applied. It is recommended that you
leave this option off, and select it only when you want
to apply a style sheet.

Show Status

If you select this menu, the path (location) of the folder
or file currently selected is displayed at the bottom of
the file list.

|C: Wy Documentshaquariumcover hinm

Show Button Label

If you clear this menu, captions for the buttons on the
Gallery tab are not displayed.

If you select a file and then click this button, the selected file is inserted into the
page you are editing. If you select a file and then click the down-arrow button next
to this button, the tasks you can do on the selected file appear on the menu:

Inzert on Page

Inzert az Background Image
Show Original Size

Edit Image. ..

Open with Image E ditor

Open with Webdart Designer
Open with ‘Web dnimator

Open with Broveser 3

Lopy
Delete

Rename b_3w. gif

The menu contains the following menu items. The contents of the menu depend on
the type of file you have selected.

Menu item

Description

Insert This File into
Page

or

Insert into Page

Inserts the selected file into the page being edited.

Insert Link to This File
into Page

Inserts the text "Link to (filename)" or "(title)" into the
page being edited, and sets a link to the selected file.
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Menu item

Description

Insert as Background
Image

Inserts the selected image file as a page background.

Insert as Background
Music

Inserts the selected sound file as background music.

Show Original Size

Displays the image file in its original size. The Show
Original Size dialog appears.

Edit

Opens the selected HTML file as a page.

Edit Image

Edits the selected image file. The Edit Image dialog
appears.

Open with Text Editor

Opens the selected HTML file with a text editor.

Open with Image Editor

Starts the image editor program that has been regis-
tered on the Applications tab of the Options dialog,
and opens the selected image file for your editing.

Open with WebArt
Designer

Starts WebArt Designer, and opens the selected
image file.

Open with Web Anima-
tor

Starts Web Animator, and opens the selected image
file.

Open with Browser

Opens the selected file on a Web browser. You can
select the type of Web browser you want to use.

Play

Plays the selected sound file.

Stop

Stops playback of the sound file.

See Applet Explanation

Displays an HTML file that contains a detailed descrip-
tion of the selected Java applet.

Preview Applet

Displays the selected Java applet.

Edit Parameters

Edits the parameters of the selected Java applet.

Preview Style Sheet

Displays the Preview Style Sheet dialog. This dialog
enables you to check the layout of the selected style
sheet. In this dialog, you can apply the style to the
current page or the entire site.

Style List

Displays the contents of the selected style sheet. The
External Style Sheet dialog appears.

Copy

Copies the selected file into the Clipboard. (See Note)

Delete

Deletes the selected file. (See Note)

Rename

Renames the selected file. (See Note)

Note: This menu item is displayed only when the Folder button is selected.
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Applying Homepage Builder

Page editing area

The area on the right side of the main window is used to edit your pages. You can open more than one page

at a time.

You can select any of three views for the page you have opened: Normal, HTML Source , or Preview. If you
open a page that uses the frame function, two additional choices are offered: Frame HTML Source and No

Frames.

Normal tab

If you drag and drop——
this icon onto another
page, a link to this

page is set.

HTML Source tab

Preview tab

Frame HTML Source tab

No Frames tab

Button for switching the tar-
get browser: If you click this
button and select a target
browser, the size of the page
editing area and a set of avail-
able tags are determined
accordingly.

é? 1 1
f  Mormal | HTML Source | Preview | Frame HTML Sowce | Na Frames

| Stondad | BODY

WELCOME TO MY HOMEPAGE |

Cooking page

suonouny Japjing abedawoH jo Alewwns H

Style sheet indicator:  This icon is
highlighted when a page that uses
style sheets is open. If you click this
icon, the Style Sheet Manager dialog
is displayed.

Page editing area

Button for changing attributes of an element:

The HTML tag associated with the element on the
cursor position is displayed. If you click this but-
ton and select the name of an element from the
pop-up menu, the Attributes dialog for the tag
associated with the selected element appears,
and you can change the attributes as necessary.
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Normal tab

You ordinarily edit pages on this tab. Unless specified other-
wise, this guide assumes that you are using this tab for editing

pages.

HTML Source tab

Use this tab only when you want to edit HTML tags directly. Tags
and their attributes are distinguished by colors.

Preview tab

The Preview tab is displayed only if Internet Explorer 40 or 50
is installed on your personal computer. If you click this tab, you
can check how your page looks on the Internet without starting
a Web browser.
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Proceeds to the next page.
same as the Forward button on a Web browser.

You can preview the movements of animated GIF files,
rollover images, dynamic HTMLs, and script files.
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Frame HTML Source tab

If you view a frame-setting page on the Normal tab or the HTML
Source tab, all the pages defined in the frames are shown
simultaneously in separate panes. The Frame HTML Source
tab, on the other hand, shows the HTML source of the frame-set-
ting page (an HTML file that defines the frames). If you click the
Normal tab and click Frame --> Frame Attributes on the menu
bar, and then change the frame settings in the Attributes dialog,
the content of this tab is changed automatically. Instead of
using the Attributes dialog, you can also directly edit the HTML
source shown on this tab.

No Frames tab

Some Web browsers do not support the frame function. If you
try to open a frame-setting page on such a browser, the content
of the No Frames tab is displayed instead. For users who can-
not view frames on their Web browsers, always prepare a page
that does not use frames. You can operate the No Frames tab
in the same way as you do the Normal tab.

Applying Homepage Builder

[ DocTYRE HTHL PUBLIC -/ /s - fitional //EN">
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Cooking page

Menu bar

From the menu bar, you can access all the functions provided by Homepage Builder. Depending on the status
of the main window, some menu items are not displayed. For example, the Edit menu is displayed only when

a page is open.

Eile Edit “iew Fomnat Inzert Table Frame Site Tool: ‘wWindow  Help
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File menu

Use the File menu to manipulate files.

@
Im

dit Miew Format |nsert Tat

7Y Now o Menu item Description
ek ¢ New Creates an HTML file. A blank page is open in the
& Open. EikD page editing area.
\? Open URL
EEZ: ;hrijain\%v}}mow , Template Creates new pages by using a template. Select one
Openin Frame... of the following submenu items:
] Save Dhi+& e New Page from Template: Uses a template
Save fs... Clrksf offered by Homepage Builder to create one or
= :“e’é" X more pages, each consisting of an HTML file and
o - the related files. Follow the instructions on the
€ Stop Download wizard.
Close * New Frames from Template: Creates a frame-
Close Al setting page by using one of the templates
Duplicats Page offered by Homepage Builder.
2ave i Fersenal Eclder e Add This Page to User Template: Adds the
L ¢ page you are editing as a user template. To use a
pen fpening D10, user template, click File --> Template --> New
1 index.htm
2 C:MProgram Filesh. .. \index htm Page from Template on the menu bar'
Esubl him e Add This Site to User Template: Adds all the
4 CAMy Documentsisubl.him pages in the open site as user templates. To use
5 C:\Program Files\... \cover. him . .
i o a user template, click File --> Template --> New
= Page from Template on the menu bar.
e User Templates: Displays a list of user templates
that have been registered.
Open Opens an existing HTML file. When the Open dialog
appears, select a file and then click the Open button.
In addition to HTML files, you can also open external
style sheet files in the same way to change their set-
tings. If you open an external style sheet file with the
menu, however, the style sheet is not linked with the
page.
Open URL Downloads and opens a page from the Internet.
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When the Open URL dialog appears, specify the URL
and then click the OK button.

Open This Link

Opens the link destination page if a link is set on the
text or image in focus.

Open in New Window

Opens the current page in another window. You can
select the view of the page—Normal, HTML

Source , or Preview. By using this function, you can
open the same page in two windows—one in the Nor-
mal view and the other in the HTML Source view, for
example—and compare them with each other as you
work on the page.




Applying Homepage Builder

Menu item

Description

Open in Frame

Displays an existing HTML file within the frame on
which the cursor is placed, if a frame-setting page is
currently open. The Open dialog appears, and you
can select a file and then click the Open button.

Save Saves the page you are editing. If the page is to be
saved for the first time, the Save As dialog appears.

Save As Saves the current page as a new file. The Save As
dialog appears, and you can specify the destination
folder and the file name.

Save All Saves all the pages open in the page editing area.

The Save As dialog appears for the page that is to be
saved for the first time.

Save Frames

Saves the frame you are editing. Select one of the fol-

lowing from the submenu:

e Save Frames: Saves the frame-setting page (an
HTML file that defines the frames) you are editing.
If the page is new, the Save As dialog appears. |If
a page in one of the frames is new, a message
asks you if you want to save the page.

e Save Frames As: Saves the current frame-set-
ting page as a new file.

Reload

Reloads the current page from the file. If the page has
been changed, a confirmation message asks you if
you want to save the changed version first.

Stop Download

Stops reading a file on the network.

Close Closes the page being edited. If the page has been
changed, a confirmation message asks you if you
want to save it first.

Close All Closes all the pages open in the page editing area. If

any page has been changed, a confirmation message
asks you if you want to save the changed version first.

Duplicate Page

Makes a duplicate of the file being edited. The dupli-
cate page is not saved unless you explicitly save it.

Save in Personal Folder

Saves the selected area of the current page in the Per-
sonal Folder. Once a page has been saved, you can
used it by clicking the Gallery tab, the Gallery but-
ton, and Personal folder .
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Menu item

Description

Print

Prints the page being edited, or previews a print
image of it. Select one of the following from the sub-
menu:

e Print: Prints the page being edited. If a frame-
setting page is open, Homepage Builder prints
the page on which the cursor is placed. The Print
dialog appears, and you can start printing by
clicking the OK button.

e Print Preview: Displays a print image of the
page being edited.

Open Opening Dialog

Displays the Welcome to WebSphere Homepage
Builder dialog. If a site is open, you cannot select this
menu item.

(Recently used files)

Selects a file from a list of files you recently opened.

Exit

Exits Homepage Builder. If the current page has not
been saved, a message appears, asking if you want to
save the page.

Edit menu

Use the Edit menu to edit pages.

Edit iew Fomat Inset Table Frame Site

Description

Cancels the most recent operation and restores the
edited object to its previous status.

Performs the operation previously canceled with the
Undo menu.

Cuts the selected area from the page you are editing
and copies it to the Clipboard.

Copies the selected area from the page you are edit-
ing to the Clipboard.

e U oulz Menu item
<u Redo Culs¥
& Cut Cirl+ UndO
3 Copy ClisT
& Paste Cul+y
Paste As 3
& Delete Ctrl+Dr RedO
Select 4l Crl+hy
Capy Text Atiibutes
Capy Background and Test Colors
Find Ci+F Cut
Find Nest F3
Replace CtrleH
Link. »
Image » Copy
Image Map »
Rollover Image »
Page Propetties P
aste

Frame Attributes..
Edit Style...
Edit Ewent..
Activext Control Propeties
(&1 Aftributes Al+Erter

Pastes the contents of the Clipboard at the position of
the cursor on the page you are editing. If you selected
an area before choosing Paste, that area is replaced
by the contents of the Clipboard.
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Menu item

Description

Paste As

Pastes the contents of the Clipboard by specifying
how to treat the tags in it. Select one of the following
from the submenu:

e HTML: Treats the contents of the Clipboard as
HTML tags. For example, if the string <P>abc
</P> is on the Clipboard, only the text abc is
pasted into the page as a new paragraph,
because <P>and </P> are recognized as HTML
tags.

e Text: Treats the contents of the Clipboard as text.
For example, if the string <P>abc</P> is in the
Clipboard, the entire string <P>abc</P> is pasted
into the page, because <P> and </P> are recog-
nized as text.

Delete

Deletes the selected area of the page. If no area has
been selected, the tag associated with the element in
focus is deleted.

Select All

Selects all the contents of the page.

Copy Text Attributes

Copies only the tags used for emphasizing the text at
the position of the cursor to the Clipboard. The tags to
be copied by this menu include, for example, <B>,
<I>, and <SUP>. To emphasize another text string
with the same tags, select the text string and then
click Edit --> Paste on the menu bar.

Copy Background and
Text Colors

Copies the background color, the background image,
and the text color of the page to the Clipboard. To
paste these attributes to another page, move the cur-
sor to the target page, and then click Edit --> Paste
on the menu bar.

Find

Searches the page or the site currently open for a text
string. The Find dialog appears, allowing you to spec-
ify the search conditions.

Find Next

Searches for the next matching text string after you
closed the Find dialog or when the dialog does not
have a keyboard focus.

Replace

Replaces a text string on the page with another one.
The Replace dialog appears.

Link

Sets a link or cancels a link you have set. Select one

of the following from the submenu:

e Edit Link: Changes the attributes of the link. If
the cursor is positioned on the element having a
link, the Attributes dialog for the link appears.

e Remove Link: Cancels the link that has been set
on the element where the cursor is positioned.
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Menu item

Description

Image

Edits the image file where the cursor is positioned.

Select one of the following from the submenu:

e Edit Image: Edits the image by using the image
editing function of Homepage Builder.

e Edit with WebArt Designer:  Edits the image by
using WebArt Designer, the image-editing tool
offered by Homepage Builder.

e Edit with Web Animator:  Edits the image by
using Web Animator, the tool for creating ani-
mated GIF files offered by Homepage Builder.

e Edit with Image Editor:  Edits the image by using
any image editor program specified in the
Options dialog.

Image Map

Edits or deletes the image map. Select one of the fol-

lowing from the submenu:

e Edit: Sets an image map for the selected image.
If the cursor is positioned on an image, the Image
Map Editor dialog appears.

¢ Delete: Removes the image map set for the
selected image. If the cursor is positioned on the
image with an image map, the Delete Image Map
dialog appears.

Rollover Image

Applies or cancels the rollover effect on the selected

image. Select one of the following from the submenu:

e Setup Rollover Effect:  Applies the rollover effect
on the selected image or changes the rollover
settings.

e Remove Rollover Effect: Removes the rollover
effect that has been applied to the selected
image.

Page Properties

Sets properties on the page, such as the page title
and the background in the Attributes dialog.

Frame Attributes

Enables you to change the attributes of the frame. If
the page being edited is using the frame function, the
Attributes dialog appears.

Edit Style

Sets a style on the page by using a style sheet.

Edit Event

Defines an event and an action (script) for the tag
associated with the element on which the cursor is
positioned. For example, if the cursor is placed on an
image (that is, the <IMG> tag) and if you select
OnClick as the event and "Display a message box"
as the action, a message box appears when a visitor
to your Web page clicks the image.
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Menu item

Description

ActiveX Control Proper-
ties

Displays the attributes of the selected ActiveX control.

Attributes

Changes the attributes of the selected element. If the
cursor is positioned on an element, the Attributes dia-
log for the element appears.

View menu

Use the View menu to change the view of the page or to display or hide the components in the main window.

View Fomat Inset Table Frame Site Iook

Description

Toobar 8 Menu item
[T Site/Galery View
[&] Color Paletts
$] Stule Sheet Manager Toolbar
[v  Status Bar

Displays or hides a toolbar. Any toolbar marked with a
check is currently displayed.

Page Sige...
Layout Frame List. .

Site/Gallery View

Mamal Shift+Alt+L
HTML Sowrce Altell
PBreview Alt+P
Frame HTML Source

Displays or hides the Site/Gallery View. You can use
the Site/Gallery View to manage your sites and to
paste materials into your page.

Mo Frames

Color Palette

Displays or hides the Color Palette. You can use the
Color Palette to set color on the elements of your
page.

Style Sheet Manager

Displays or hides the Style Sheet Manager. You can
use the Style Sheet Manager to edit styles.

Status Bar

Displays or hides the status bar.

Page Size

Displays the size of the page—that is, an HTML file
and all the related files. The Page Size dialog displays
the size of each file, the total size, and the estimated
download time.

Layout Frame List

Displays or hides a list of layout frames if the page
being edited is using the dynamic HTML technology:.

Normal

Displays the page in WYSIWYG (what-you-see-is-
what-you-get) mode on the Normal tab.

HTML Source

Displays the HTML source of the page on the HTML
Source tab.

Preview

Displays the page as if it were viewed on a Web
browser. You can use the Preview tab only if Internet
Explorer 40 or 50 is installed on your computer.

Frame HTML Source

Displays the HTML source of the frame-setting page if
the frame function is being used.
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Menu item

Description

No Frames

Displays the content of the <NOFRAMES> tag in
WYSIWYG mode. You can use the <NOFRAMES> tag
to prepare your page for the Web browsers that do not
support frames.

Format menu

Use the Format menu to change the format of text.

Format Insert Table Frame Sie T

Menu item
Physical Emphasis 3

Description

Logical Emphasis 3

1 Font...

Bemove Format

Physical Emphasis

Align 3
Indent 3

Paragraph...
List...
Style...

Page Properties...

Set Background and Text Colors...

Changes the face of the selected text. You can set the
following faces:

¢ Bold: Makes the text bold.

e |talic: Makes the text italic.

e Underline: Makes the text underlined.

e Fixed: Uses a fixed-width (monospace) font for
the selected text.

e Overstrike: Strikes through the selected text.

¢ Blink: Makes the selected text blink.

e Superscript: Displays the selected text in super-
script characters.

e Subscript: Displays the selected text in subscript
characters.

¢ Style (SPAN): Sets a style for the selected text
through the Set Style dialog. If you select text
and then select this menu, the <SPAN> and
</SPAN> tags are inserted around the text; then
you can set a style for the selected text only.

Logical Emphasis

Changes the logical emphasis on the selected text.

The view of the logical emphasis differs among Web

browsers. Select one of the following from the sub-

menu:

e Emphasis: Emphasizes the selected text, usually
in italics.

e Strong: Further emphasizes the selected text,
usually in bold.

e Code: Marks the selected text as program frag-
ments, usually by displaying it in a monospace
font (such as a typewriter font).
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Menu item

Description

Logical Emphasis
(continued)

e Sample: Marks the selected text as a sample.

e Keyboard: Marks the selected text as the text to
be typed from the keyboard, usually by displaying
it in @ monospace font (such as a typewriter font).

¢ Variable: Marks the selected text as a variable
name, usually by displaying it in italics.

o Definition: Marks the selected text as a descrip-
tion of a term, usually by displaying it in bold or
italic bold.

e Citation: Marks the selected text as the title of a
book or an article, usually by displaying it in ital-
ics.

Font

Changes the size, the color, and the face of the
selected text. The Font Attributes dialog appears.

Remove Format

Cancels the emphasis you put on the text by use of
the Physical Emphasis or Logical Emphasis
menu.

Align

Aligns the selected paragraph to the left, center, or
right. You can also align a paragraph in a table to the
top, middle, or bottom.

Indent

Indents the selected paragraph or cancels the inden-
tion of the paragraph.

Paragraph

Changes the type or the alignment of the selected
paragraph. If the cursor is positioned on a paragraph,
the Attributes dialog for the paragraph appears.

List

Changes the type or the numbering of the selected
list. If the cursor is positioned on a list, the Attributes
dialog appears.

Style

Displays the Style Sheet Manager. You can use the
Style Sheet Manager to set a style on your page.

Page Properties

Changes the page properties—for example, the page
title, the background color, or the meta information
(special information embedded into an HTML file;
meta information is not defined by HTML grammar).

Set Background and
Text Colors

Changes the color of the page background or text.
The Background and Text Color  tab of the
Attributes dialog appears.
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Insert menu

Use the Insert menu to insert such elements as links and images.

Insert Table Frame Site Tools 'win

[& Link... Chil+
Image File »
B ackground Image File 3
Backaround Music 3

m Rollover Image...

B Logo..

ﬁ Fhata Frame...
Paragraph 3
List 3

B Table...

— Horizontal Rule Chrl+k

FEorm and Input Fields 3

71 Layout Frame

Line Break... Ctrl+Erter
Special Characters...
File...
3l Date and Time...
Others 3

150

Menu item Description
Link Sets a link on the selected text string or image. Spec-
ify the link destination in the Attributes dialog.
Image File Inserts an image file at the position of the cursor. You

can insert an image from a file, from the Gallery, or
from a TWAIN-compliant device, or by specifying a
URL.

Background Image File

Inserts an image file as the page background. You
can insert an image from a file or from the Gallery.

Background Music

Inserts a sound file as the background music for the
page. You can insert a sound file from a file or from
the Gallery.

Rollover Image

Applies the rollover effect to the selected image file.
The Image Rollover Effect Wizard dialog appears.

Logo

Creates and inserts a logo. The Logo Wizard dialog
appears.

Photo Frame

Creates a photo frame for the selected image. The
Photo Frame Wizard dialog appears.

Paragraph

Creates a paragraph. Select one of the following from
the submenu. Each submenu item name represents
the type of paragraph as follows:

e Normal: Used for a normal paragraph.

¢ Heading 1-6: There are six levels of headings, 1
through 6. These are often used for the titles of
chapters and sections. Heading 1 appears in the
largest font.

e Address: Used to describe addresses, company
names, and school names. This type of para-
graph is usually displayed in italics.

¢ Block Quotation: Used for a paragraph of
quoted matter, to set it off from the body of the
text.

o Preformatted: Used to display a space and a
line break "as-is," using a fixed-width font.

List

Creates a list. Select one of the following from the

submenu, which offers three choices:

¢ Bulleted List: A list whose items are preceded
by circles or square marks.

e Ordered List: A list whose items are preceded by
numbers (for example, 1, 2, 3 or i, ii, ii).




Applying Homepage Builder

Menu item

Description

List (continued)

e Definition List: A list that consists of pairs of
items. Each pair consists of a term and its
description.

Table

Creates a table. In the Insert Table dialog that
appears, specify the number of rows and columns. If
you have selected an area, a table that encloses the
area is created.

Horizontal Rule

Creates a horizontal rule.

Form and Input Fields

Creates a form. First select Form from the submenu
to create a frame for the form. Then select one of the
following from the submenu to create components for
the form—that is, input fields. An input field may be
created only inside a form frame.

e Push Button: Select one of the following types:

- Submit Button: A button that causes the
information entered into input fields to be sent
to the CGl program on the server.

- Reset Button: A button that restores the infor-
mation entered into other fields to their initial
values.

- Image Button: A button with an image.

- General Button: A button that is not associ-
ated with any predefined action.

- Extended Button: A button that can be gen-
erated from the area you select.

¢ Radio Button: One of several buttons in a group
from which the user can make a selection.

e Check Box: A field that the user can select or
clear.

e Text Area: A field in which the user can enter
multiple lines of text.

e Text Field: A field in which the user can enter
one line of text.

e List Box: A field that offers the user a choice of
two or more items. The user clicks the down
arrow or up arrow to scroll the list, and clicks the
item to be selected.

¢ Option Menu: A field that offers the user a choice
of two or more items. The user clicks the down
arrow and selects an item from the drop-down list.

e Group Box: A field in which two or more related
fields are grouped.

Layout Frame

Creates a layout frame used for dynamic HTML.

Line Break

Inserts a line break.
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Menu item

Description

Special Characters

Inserts a special character—for example, a space or a
copyright mark. In the Insert Special Characters dia-
log that appears, click the character you want to
insert.

File

Inserts a text file, a table data file, or an HTML file. In
the Open dialog, select the file you want to insert.

Date and Time

Inserts the current date and time. Select the date for-
mat in the Insert Date and Time dialog.

Others

Inserts an element that uses advanced technology.
Select one of the following from the submenu:

e Script: Inserts an existing script file or enables
you to write a script in your page. In the Script
dialog, specify the file name of the script file you
want to insert, or write your own script.

Java Applet: Inserts a Java applet. In the
Attributes dialog, specify the class name of the
Java applet and its parameters.

Plug-ins: Inserts a plug-in object. In the
Attributes dialog, specify such attributes as the
file name and the location of the object.

e ActiveX Control: Inserts an ActiveX Control. In
the ActiveX Control dialog, select the control you
want to insert.

Object: Inserts an object for capturing any
image, ActiveX Control, or HTML file at the posi-
tion of the cursor. In the Attributes dialog, specify
the URL of an executable program (such as Java
or ActiveX) and the object parameters.

Style Container (DIV): Inserts the <DIV> tag. If
you select a range of text or images before you
select this menu, the selected area is enclosed
with the <DIV> tag and the </DIV> tag. You can
then specify a style for the <DIV> tag by use of
the Attributes dialog.

Comments: Inserts comments. In the Edit Com-
ments dialog, type your comments. They are not
displayed on Web browsers, but you can view
them in the HTML source file.

HTML Tag: Inserts an HTML tag. In the HTML
Tag dialog, enter the HTML tag you want to insert.
You can even enter a tag that is not supported by
Homepage Builder.

Example: <MARQUEE>Hello!!</MARQUEE>




Table menu

Applying Homepage Builder

Menu item

Description

Others (continued)

¢ Table of Contents: Inserts a table of contents by
using the headings included in your page. Inthe
Insert Table of Contents dialog, specify the
options (such as the type and the destination) for
the table of contents.

e SSI: Inserts an SSI (Server Side Includes) com-
mand. This menu is applicable only if you are
using a server that supports SSI. You can insert
one of the following commands: Insert File , Exe-
cute Command , Show Last Update Time ,
Show File Size , ECHO, or CONFIG.

Use the Table menu to create and edit tables.

Table Frame Site Tools

Ingzert Table Eody...

Menu item

Description

Inzert T able Caption...

Add Bow
Add Colurnn

i

k!

»

Delete Row

Delete Column

Insert Table Body

Creates a table. In the Insert Table dialog, specify the
number of rows and columns for the table. If you have
selected an area before selecting this menu, a table
that encloses the selected area is created without a
dialog being displayed.

Delete Table

Insert Table Caption

Adds a caption at the top (or bottom) of the table. In
the Insert Caption dialog, enter the table caption.

Split Cell

Join Rows

Join Columms

Join Selected Cells

Copy Row
Copy Column

Fazte Row

Pazte Column

Add Row Adds one or more rows to the table. From the sub-
menu, select one of the following:
e Add Above: Adds a row above the cell where the
cursor is positioned.
e Add Below: Adds a row below the cell where the
cursor is positioned.
¢ Specify and Add: Adds the specified number of
rows at the specified position.
Add Column Adds one or more columns to the table. From the sub-

menu, select one of the following:

e Add to Left: Adds a column to the left of the cell
where the cursor is positioned.

¢ Add to Right: Adds a column to the right of the
cell where the cursor is positioned.

¢ Specify and Add: Adds the specified number of
columns at the specified position.
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Menu item

Description

Delete Row

Deletes the row the cursor is in.

=»\ [f you clear the Delete cell contents when

J)| atableis deleted check box on the Gen-
eral tab of the Options dialog, the contents
of the row are not deleted.

Delete Column

Deletes the column the cursor is in.

z»\ [f you clear the Delete cell contents when
.2 atableis deleted check box on the Gen-
eral tab of the Options dialog, the contents
of the column are not deleted.

Delete Table

Deletes the table the cursor is in.

z»\ [f you clear the Delete cell contents when
.2 atableis deleted check box on the Gen-
eral tab of the Options dialog, the contents
of the table are not deleted.

Split Cell

Splits the cell the cursor is in. From the submenu,
select Column to split the cell horizontally, Row to
split the cell vertically, or Specify and Split to specify
the number of output cells and the direction to split.

Join Rows

Joins the selected cell with the cell above or below it.
From the submenu, select With Cell Above or With
Cell Below .

Join Columns

Joins the selected cell with the cell to its left or right.
From the submenu, select With Cell on Left or With
Cell on Right .

Join Selected Cells

Joins the cells you have selected by dragging the
mouse.

Copy Row Copies the selected row, and places it on the Clip-
board.

Copy Column Copies the selected column, and places it on the Clip-
board.

Paste Row Pastes the row you have copied to the Clipboard into

the table the cursor is in. From the submenu, select
Above to paste the row above the cursor, or select
Below to paste the row below the cursor.

Paste Column

Pastes the column you have copied to the Clipboard
into the table the cursor is in. From the submenu,
select On Left to paste the column to the left of the
cursor, or select On Right to paste the column to the
right of the cursor.




Frame menu

Use the Frame menu to create and edit frames.

Applying Homepage Builder

Frame Site Tools Window Help

Description

Creates a frame-setting page by using a template. In
the New dialog, select the template you want to use.

Menu item
Mew Frames...
Split Frame g New Frames
[X] Delete Frame
Frame Attributes...
Save Frames Sp'lt Frame

Save Frames fs...

Frame-5 etting Page Properties...

Feload Frames

Splits a page or a frame into multiple frames. From the
submenu, select Split Vertically to split the page or
frame vertically, Split Horizontally to split the page
or frame horizontally, or Specify and Split to specify
the number of output frames and the direction in
which they are to be split.

Delete Frame

Deletes the frame you have selected.

Frame Attributes

Changes the attributes of the frame you have
selected.

Save Frames

Saves the frame-setting page (an HTML file that
defines the frames) you are editing. If the page is to
be saved for the first time, the Save As dialog
appears. If any of the pages within the frames has
been changed, a confirmation message appears.

Save Frames As

Saves the frame-setting page with a new file name.

Frame-Setting Page
Properties

Changes the properties of the frame-setting page. In
the Attributes dialog, specify the frame attributes—for
example, the title of the frame-setting page.

Reload Frames

Reloads the frame-setting page being edited. If the
page has been changed, a confirmation message
appears.
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Site menu

Use the Site menu to manage or transfer your sites.

Site Tool: Window Help

Description

Opens an existing site. In the Site List and Settings
dialog, select a site and then click the Open button.

Closes the currently open site.

Menu item
Open Site... -
Close Site Open Site
”[E Hew Site. .
Site List and Settings... Close Site
[E}‘ Upload Site. .. New Site

Creates a site.

g? Upload Page...

Fie Upload Seltings  » Site List and Settings

Site Style 3

Displays the site information in the Site List and Set-
tings dialog. In this dialog, you can create, duplicate,
or change the settings of your site.

Find...
Create Site Map
Site Check....

Upload Site

Befrezh Site Information

1 Agquarium

Uploads only the files that have been updated since
the last upload. If you are uploading your site for the
first time, all the files are uploaded. If, however, you
have already uploaded your files by using an FTP
application other than Homepage Builder, it is recom-
mended that you click Site --> File Upload Settings
--> Mark All Files as Uploaded on the menu bar so
that you can upload only the files you have changed
since then.

Upload Page

Uploads only the files related to the selected page.

File Upload Settings

Creates, changes, or deletes file upload settings (a set
of information that Homepage Builder maintains for
the server access—for example, the server name, the
user ID, the password, and the destination folder).
Select one of the following from the submenu:

¢ New Upload Settings: Defines new file upload
settings.

¢ Edit Upload Settings: Displays a list of file
upload settings. You can change or delete exist-
ing file upload settings.

e Mark All Files as Uploaded: Sets all the files in
the site as "already transferred." If the server
already contains your latest files, you can upload
only the updated files by selecting this menu
item.

Site Style

Sets a style for the entire site. Select one of the follow-
ing from the submenu:

e Set Site Style: Sets a style for the site. Follow the
instructions on the wizard.

e Remove Site Style: Cancels the style you have
set on the site.

e Edit Site Style: Edits the contents of the site
style.

156




Applying Homepage Builder

Menu item

Description

Find

Searches the files in the site for the specified text
string.

Create Site Map

Creates a page that shows the site hierarchy. The cre-
ated page is automatically opened and displayed in
the editing area.

Site Check

Does an accessibility check and a spelling check on
all the files in the site.

Refresh Site Informa-
tion

Refreshes the information on the currently open site.
If you added or deleted files in your site by using a
program other than Homepage Builder and the
update is not reflected correctly, select this menu to
explicitly refresh the information.

(Recently used files)

Enables you to select and open a site from the list of
sites you have recently opened.

Tools menu

Use the Tools menu to use one of the tools and functions provided by Homepage Builder.

Tools Window Help

Description

 Viebdt Designer Menu item

i3 web animator

& Ele Transfer .
— - WebArt Designer

URL Editor
Heading Editor

Starts WebArt Designer, which is used for creating
and enhancing images.

Attibute Edtor... Al

Web Animator

Insert Tag.

Spel Check.. F7

Starts Web Animator, which is used for creating ani-
mated GIF files.

HTML Syntax Check.
Accassibllty Check 3

File Transfer

Create Channel 3

Starts File Transfer.

Open Imags from TWAIN Device

WWW Browser

Target Brovwser 3

Dptions:

Starts a Web browser and displays the page you are
editing.

e Internet Explorer: Starts Internet Explorer.

¢ Netscape: Starts Netscape Navigator.

URL Editor

Changes the URL of a link, an image, a plug-in object,
or a background image, as well as allowing you to edit
the alternative text for all the images on the page. The
URL Editor dialog appears.

Heading Editor

Enables you to change the heading level of each
heading on the page by use of the Heading Editor dia-
log.

Attribute Editor

Enables you to directly edit attributes of a tag in your
page by use of the Attribute Editor dialog.

Insert Tag

Inserts an HTML tag. In the Insert Tag dialog, click the
name of the tag you want to insert.
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Menu item

Description

Spell Check

Corrects the spelling on your page. If a spelling error
is found, the Spell Check dialog appears.

HTML Syntax Check

Checks for errors in HTML syntax. If an error is found,
the HTML Syntax Error dialog appears, and you can
correct the error.

Accessibility Check

If you select Check, the page is checked for accessi-
bility, and the HTML tag errors are listed in the Acces-
sibility Check dialog.

If you select Set Options , you can select which items
to check in the Set Options for Accessibility Check
dialog.

Create Channel

Creates a file used for registering your Web page as a
channel.

Open Image from
TWAIN Device

Loads image files from a TWAIN-compliant device.
The Open Image from TWAIN Device dialog appears.

Target Browser

Enables you to create a page that is suitable for the
target Web browser (the Web browser you intended
your visitors to use). Select one of the following from
the submenu:

e Tag Check: Checks for any tags or attributes that
are not supported by the specified Web browser.
The Check Tags dialog appears.

e Settings: Enables you to set the size of the page
editing area or the tag check options as needed
for the target Web browser. The Target Browser
tab of the Options dialog appears.

e Standard: Indicates the assumption that a visitor
to the page will use a general type of Web
browser, such as Internet Explorer or Netscape
Navigator.

e (Target browser name ): Enables you to select a
target browser from a list of target browsers. If you
select a special browser type, the size of the
page editing area is adjusted to match the
browser.

Options

Enables you to set Homepage Builder options in the
Options dialog.




Window menu

Applying Homepage Builder

Use the Window menu to change the view of the page displayed in the page editing area.

| window Help
Mew Window
Cascade
Til=
Armange lcons
Cloge all

Page List...

Menu item Description
New Window Opens another window and displays the page you are
editing in it.
Cascade Arranges the open windows in a cascaded form (the

windows overlap, but all their captions are visible).

1 index htm - Gardening
|7 2 newpage? htm - Untitled

Tile

Arranges the open windows like tiles.

Help menu

Arrange Icons

Arranges icons, which indicate minimized pages.

Close All

Closes all the open pages.

Page List

Displays or hides the Page List dialog, which lists all
open pages. If you click a page in this dialog, the
page is displayed in the topmost window.

(Pages currently open)

Enables you to select a page from the list of pages
currently open and display the page in the topmost
window.

Use the Help menu to view various useful information about Homepage Builder, such as the online tutorial, the
online help, and the version information.

Help

Start Tutorial

Menu item

Description

[l Help Topics

Web Page

@ About WebSphere Homepage Builder...

Start Tutorial

Starts the online tutorial, which introduces the overall
functions and operations of Homepage Builder.

Help Topics

Displays the online help. In the Help Topics dialog,
look for the topic on which you want to display online
help information.

Web page

Starts a Web browser, and displays the Web pages for
WebSphere Homepage Builder and the WebSphere
family.

About WebSphere
Homepage Builder

Displays the version information of Homepage Builder.
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Format toolbar
Insert toolbar

can perform operations just by clicking a button. Some toolbars appear or hide according to the status of the

main window. For example, the Frame toolbar is shown automatically when frames are being used.
You can use the Insert toolbar to insert such elements as images and tables. The toolbar also contains but-

A toolbar contains buttons that correspond to the menu items that are used often. By using the toolbar, you
tons with which you can change element attributes or edit images.

The General toolbar contains buttons for the functions that are used most often.

You can use the Format toolbar to change the format of your pages.

General toolbar

Toolbars
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Frame toolbar

The Frame toolbar is displayed only when frames are being used.

| BmE(E =

URL toolbar

The URL toolbar is displayed only when the page being edited contains links.

n Summary of Homepage Builder functions
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Form and Input Fields toolbar

The Form and Input Fields toolbar is displayed only when the page being edited contains forms.

e M= MR N o
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Style Class toolbar

You can use the Style Class toolbar to apply a style class at the position of the cursor on your page. You can
apply style classes defined on the page or in an external style sheet linked from the page.
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Status bar

The status bar is at the bottom of the main window. The status bar displays information according to the status
of the main window.

The file name of the image currently focused. While you are
resizing a table or an image by dragging it, the current size
of the table or image is displayed.

[t top.aif [¥0.1 KB] |C:AMy Documentshaquariumbcover. htm

The path of the page you are editing. To view other information, click
Tools --> Options  on the menu bar, click the Appearance tab in the
Options dialog, and specify which information you want to view.
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WebArt Designer functions

WebArt Designer is one of the accessory tools provided by Homepage Builder. It
assists you in creating and editing images. By using this tool, you can easily create
logos and buttons for your Web pages. Although the Homepage Builder main pro-
gram also enables you to edit GIF or JPEG images, WebArt Designer offers you a
richer set of functions on image editing. This section explains each component in
the WebArt Designer main window and the operations you can perform by using
the menu bar and the toolbar.

WebArt Designer main window

The main window of WebArt Designer consists of the following components:

Menu bar Toolbar

3: Untitled - WebSphore WebArt D ssigner
Fle Edi View Obiect Tooks Help

logo70 logoS71

logo%E0  logo3E1

N | cooL HOT|

logo®89  logodB  logoTE

logo332.

bgo36  logoF7  logo3n8

BBS

logo383

logo340 lngo931

Setup Insert

For Help, press the [F1jey.

Template Gallery Object Stack

Status bar

For instructions on using WebArt Designer, see Chapter 17
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Template Gallery

You can create images by using the sample materials in the Template Gallery.

—— Gallery tab

Separation button

ax Close button

WebArt Gallery a8 wiehtn Gallery |G Gallery |

Button Logo Rallover

|»

bitnD03a binD03b bitn003e

i . Y
\UEgSte | EOBIRS

bitn010a bin010b bin010c

X LKL X

bin011a bin011b bitn011c

vy

bin012a bin012b bin012c

o

| bn0i3a 013 be01 7

Setup Insatt

The separation button and the close button

At the top-right corner of the Template Gallery are the following buttons:

dow, allowing you to place it anywhere you like. To re-join the separated Template

pI If you click this button, the Template Gallery will be separated from the main win-
Gallery and the main window, double-click the title bar of the Template Gallery.

Separation button
If you click this button, the Template Gallery closes. To display the Template Gallery

}::I again, click View --> Template Gallery on the menu bar.

Close button
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WebArt Gallery tab

Applying Homepage Builder

The WebArt Gallery tab lists several sample images created with WebArt Designer. These images are saved
in a special file format called WebArt files (*.mif). You can paste one of these sample images on the Canvas,

edit it, and save it in another file format.

The WebArt Gallery tab contains the following three buttons:

»

Button

N
Logo

Clicking this button displays a list of sample buttons. Type text in the Text field,

select the thumbnail of the button you want, and then click the Insert button. To
change the shape or color of the button, click Edit --> Edit Object on the menu

bar.

Type text here.

bin00Sa

birD0sh

bin010a

bin010b

bind11a

bir011b

btnD03c

|

Select a sample button, and
click the Insert button.

Clicking this button displays a list of sample logo files. Type text in the Text field,

select the thumbnail of the logo you want, and then click the Insert button. To

change the font size or color of the logo, click Edit --> Edit Object on the menu

bar.

- Type text here.

logo010

logo020

Attention||wa

logol140

logo050

IogoDBD

LINR

logallE3

logoll70

logoll75

Profile

QdA

logo07?

logo078

logol130

logo035

Setup

IogoD36,

=l

L Select a sample logo effect,
and click the Insert button.

Inse

=3
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E} Clicking this button displays a list of sample rollover images. Type text in the Text
field, select the thumbnail of the rollover image you want, and then click the Insert
Fiollover button. The Create Rollover dialog appears. Specify the two images used for the
rollover—the original image and the image that replaces the original one when the
mouse pointer is moved over it—and then click the Save Rollover button. Follow

the instructions on the Rollover Wizard dialogs.

ax

B websnaley | & Galery |

Type text here.

—F
1ol010 1ol020 101030
Ton NEXT
| [ 3 LIy —
rall040 rallos0 1al070

| Select a sample rollover effect,

i

. T and click the Insert button.
G || o= E

tal122 1ol 22 roll124
=

1ol126 1ol128 rol211 =l

Setup Insert

Gallery tab

The Gallery tab provides mostly the same functions as those provided by the Site/Gallery View in the main pro-
gram of Homepage Builder, except that the Gallery tab provides only image files.

&3 webdit Gallery ﬂEaHew|
Folder Bookmark  Histary
Personal folder -
Image
24 Animation )
8 Banmer Select a type of materials—such as
iton ) :
[ leon illustrations, buttons, or wallpaper.
(1 Mustration =l
[ Fites = |
e
® (& || -
b_ani00T gi  b_ani00Z.gf  b_aniD03.gif
2le|¥ , ,
—— Select an image, and click the Insert
b_ani004.gif  b_ani005.gif  b_anil08.gif .
e button to paste it on the Canvas.
2% 7
b_ani007.gf  b_ani008.gf  b_aniD03.gif
o el o
B - =] @ -
Miew Setup Insert
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Canvas and Object Stack

% Unlitled - WebS phere WebArt Designer

Fie Edt View Object Took Help

[RaN=2 = YRR e

logo®70 logad?1

logo30  logo®B1 _Iogo3B2

logo3% o038 Iogo388

logo383

loge®0 logad91

Sep Inse

For Help, press the [F1] key.

Object Stack

The blank rectangular area at the center of the main window is called the Canvas. The Canvas is the area for
editing objects.

On the right of the main window is the Object Stack, which displays thumbnails of the objects on the Canvas.
In the Object Stack, the last object in the stack is shown at the bottom, and the first object at the top. An
image in the Object Stack might be marked with one of the following icons:

Indicates an image object—that is, an image file pasted on the Canvas or an object
E converted into an image object.

Indicates a hidden object. If you select an object and then click Object --> Hide
H on the menu bar, the object is hidden from the Canvas, and the thumbnail of the
object in the Object Stack is marked with this icon.

Indicates the object currently being edited.
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Menu bar

From the menu bar, you can access all the functions provided by WebArt Designer.

File menu

File Edt iew Object Toolz Help

Use the File menu to manipulate files, create a Canvas, and save objects.

le Edit View Object Tools Help

=
1] MewCanvas
Mew Canvas with Specified Size.
(= OpenCanvas...
£ SaveCanvas

Save Canvas As.

Chrl+H

Chl+0
Chil+s

Menu item

Description

Send Object Ta
Save Object...
By Save Wizard for Web

New Canvas

Creates a new Canvas. If changes have been made
to the Canvas currently open, a confirmation message
appears.

Preferences

Recent Files

Exit

168

New Canvas with Speci-
fied Size

Creates a new Canvas with the specified size. The
Canvas Settings dialog appears, and you can specify
the size of the Canvas. If changes have been made to
the Canvas currently open, a confirmation message
appears.

Open Canvas

Opens a Canvas that has been saved. The Open
Canvas dialog appears, and you can specify the file
you want to open. You can open a file with any of the
following file formats:

e WebArt files (*.mif)

e GIF files (*.gif)

e JPEG files (*.jpeg, *.jpg, *.jpe)

¢ PNG files (*.png)

e Bitmap files (*.bmp)

¢ Windows Metafile files (*.wmf, *.emf)
o TIFF files (* tiff, * tif)

* FlashPix files (*.fpx)

e Photo CD files (*.pcd)

¢ DCM files (*.dcm)

Save Canvas

Saves a Canvas. If you save a Canvas in the WebArt
file format, you can open it again with the Open Can-
vas menu and edit it. If you save it in another format
(for example, as a GIF file or JPEG file), the object
information is not retained. Therefore, if you want to
edit the Canvas later, be sure to save it in WebArt file
format. When you have finished with the Canvas, save
it by selecting the Save Wizard for Web menu
instead of this menu.

When you save a Canvas for the first time, the Save
Canvas As dialog appears. Specify a location and a
file name for the Canvas.




Applying Homepage Builder

Menu item

Description

Save Canvas As

Saves a Canvas with a new name. In the Save Canvas
As dialog, specify the location and the name of the file
to be saved.

You can save a file in any of the following file formats:

e WebArt files (*.mif)

e GIF files (*.gif)

e JPEG files (*.jpeg, *.jpg, *.jpe)
¢ PNG files (*.png)

e Bitmap files (*.bomp)

Send Object To

e Homepage Builder: Inserts the selected object
at the position of the cursor in the page editing
area of Homepage Builder.

¢ Personal Folder: Saves the selected object in
the Personal Folder.

Save Object

Saves the selected objects in WebArt file format
(*.mif). Select this menu if you do not need to save
the Canvas or if you want to reduce the file size.

Save Wizard for Web

Saves the selected objects in GIF, JPEG, or PNG for-
mat. Select this menu if you want to save the objects
in a format that can be easily handled by Web pages.

Preferences

Enables you to set WebArt Designer options.

(Recent files)

A list of files that have been recently used appears at
this position. If you click the name of a file, that file
opens.

Exit

Exits WebArt Designer. If the Canvas being edited has
not been saved, a message appears, asking if you
want to save the Canvas.
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Edit menu

Use the Edit menu to edit objects on the Canvas.

Edit Yiew Object Tools Help

Description

Cancels the most recent operation and restores the
edited object to its previous status.

2 Undo Chil+Z Menu Item
cu Redo Chil+y

& Cut Chlst Undo

[ Copy CHi+C

2 Paste Chl+

Paste Object Attribute »
& Delete Delote Redo
I Duplicate Ctr+ll

aa] Paste from File...

Performs the operation previously canceled with the
Undo menu.

& Paste hom Galler .

Cuts the selected object and copies it to the Clip-
board.

Copies the selected object to the Clipboard.

Paste from TwiéIN Devics Cut

Select Al Chil+dy

Cancel Selection Ctil+E

Select Nest Tab

Select ;regmus Shift+T ab Copy
1% Edit Object

Canwas Settings. PaSte

2 et Page Backgiound Infomation  Clil+B

Pastes the content of the Clipboard onto the Canvas.

Paste Object Attribute

Applies an attribute of the selected object (color, size,
text, font name, edge outline, or effect) to the copy
destination object. Use this menu when, for example,
you want to match the color of two objects.

Delete

Deletes the selected object. You can delete one or
more objects at once.

Duplicate

Makes a duplicate of the selected object. You can
duplicate one or more objects at once.

Paste from File

Opens an image file and pastes the objects in that file
onto the Canvas.

Paste from Gallery

Loads a file from the Gallery and pastes the objects it
contains onto the Canvas.

Paste from TWAIN
Device

Loads an image from a TWAIN device and pastes it
onto the Canvas as an image object.

Select All

Selects all the objects on the Canvas.

Cancel Selection

Deselects all the selected objects on the Canvas.

Select Next

Selects the next object in the Object Stack.

Select Previous

Selects the preceding object in the Object Stack.

Edit Object

Enables you to edit the selected object. If you have
selected a logo, a button, or a photo frame object, a
dialog for editing such attributes as text, color, outline,
effect, shape, position, and size appears. If you have
selected an image object, you can edit its size and
position only.

Canvas Settings

Changes the size and color of the current Canvas.
The Canvas Settings dialog appears.
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View menu

Applying Homepage Builder

Menu item

Description

Get Page Background

Information

Obtains the page background color (or image) from
the page open in the page editing area of Homepage
Builder, and uses it as the background color (or
image) of the Canvas. Use this menu to check how an
object looks on the page background.

Use the View menu to change the view of a Canvas or to show or hide the components in the main window.
Even if you use this menu to change the size of a Canvas, the actual Canvas size, or file size, is not changed.

Yiew Object Tools

Zoom [n
Zoorm Dut

Actual Size

H
C

]

Show Grid
Snap to Grid

Standard T oolbar
Image Toolbar

Statuz Bar

(2] [ o) <) <l<l} | el

Template Galleny
Object Stack

LColor Palette

Menu item Description

Zoom In Zooms in on the Canvas. From the submenu, select
the power: x 2, x 3, or X 4.

Zoom Out Zooms out from the Canvas. From the submenu,
select the power: X 1/2, x 1/3, or x 1/4.

Actual Size Displays the Canvas at actual size.

Show Grid Shows or hides a grid on the Canvas. A grid is a set of
horizontal and vertical lines that helps you align and
size objects.

Snap to Grid Adjusts objects to the grid. If you select this menu and

then move or resize an object on the Canvas, the posi-
tion and size of the object is adjusted to the grid.

Standard Toolbar

Shows or hides the Standard toolbar.

Image Toolbar

Shows or hides the Image toolbar.

Status Bar

Shows or hides the status bar.

Template Gallery

Shows or hides the Template Gallery. The Template
Gallery is used for pasting objects on a Canvas.

Object Stack

Shows or hides the Object Stack. The Object Stack is
used for changing the stack level of an object.

Color Palette

Shows or hides the Color Palette. The Color Palette is
used for setting a color when a line or figure is drawn
with a brush.
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Object menu

Use the Object menu when you edit objects. WebArt Designer supports five kinds of object: the logo objects,
the button objects, the photo frame objects, the clipart objects (Windows metafiles), and the image objects on
which you can paint or add an effect.

Obiect Locls Help Menu item Description

B Logowizard...

) Bl Wizl Logo Wizard For use in creating a logo object. Follow the instruc-

LY et Feme wizard. tions on the wizard dialogs to specify such information

lut} Create Roliover as the logo text.
Select az Rollover Image 3

Hide CtrleH Button Wizard For use in creating a button object. Follow the instruc-
Muve to Front tions on the wizard dialogs to specify such information
Mave to Back as the shape and color of the button to be created.
Move Forward
R Photo Frame Wizard For use in creating a photo frame object. Follow the
Fip Verticaly instructions on the wizard dialogs to specify such
e S information as the shape and color of the photo frame
Riotate 30 Lef to be created.
EZ::: ?gnﬁlght Create Rollover For use in creating an image having a rollover effect.
Rotate Speciied Angle... A rollover effect switches an image to another when
Al , the mouse pointer is placed over the original image.
e Before selecting this menu to create a rollover image,
Duplisate and Carbine you must first create two images on the Canvas.
Rasterize . . . .
Duplicate and Flasterize Select as Rollover For use in creating a rollover image by using the
e Image selected object as either the original image or the

replacement image. When the Create Rollover dialog
appears, select the other image on the Canvas and
then click the Select button. Then click the Save
Rollover button and follow the instructions on the wiz-
ard dialogs.

Hide Hides the selected object. The hidden object is
marked with an X at the bottom left of the image on
the Object Stack. To show the hidden object, select
the object and this menu again.

Move to Front Moves the selected object to the front of the Object
Stack.
Move to Back Moves the selected object behind the other objects in

the Object Stack.

Move Forward Moves the selected object forward one position in the
Object Stack.
Move Backward Moves the selected object backward one position in

the Object Stack.

Flip Vertically Flips the selected object vertically.
Flip Horizontally Flips the selected object horizontally.
Rotate 90 Left Rotates the selected object 90 degrees to the left.
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Menu item

Description

Rotate 90 Right

Rotates the selected object 90 degrees to the right.

Rotate 180

Rotates the selected object 180 degrees.

Rotate Specified Angle

Rotates the selected object the specified number of
degrees. In the Rotate Object dialog, specify the
angle and the direction.

Align

Aligns the selected objects. Select one of the follow-

ing from the submenu:

e Left: Aligns the left edges of the objects to the
left edge of the selected area.

e Horizontal Center: Aligns the horizontal center of
the objects to the horizontal center of the
selected area.

¢ Right: Aligns the right edges of the objects to the
right edge of the selected area.

e Top: Aligns the top of the objects to the top of the
selected area.

e \ertical Center: Aligns the vertical center of the
objects to the vertical center of the selected area.

e Bottom: Aligns the bottom of the objects to the
bottom of the selected area.

e Center: Aligns the center of the objects to the
center of the selected area.

Combine

Converts the selected objects into a single image
object.

Duplicate and Combine

Makes copies of the selected objects and then con-
verts the copies into a single image object. Use this
menu when you want to keep the original objects sep-
arate.

Rasterize

Converts a logo object, a button object, or a photo
frame object into an image object. Once an object is
rasterized, you can no longer change its attributes.
You can, however, paint it or add an effect on it.

Duplicate and Rasterize

Makes a copy of the selected object and then con-
verts the copy into an image object. Use this menu
when you want to keep the original object.

Remove Extra Space

Removes any extra space around the selected image
object.
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Tools menu

Use the Tools menu to edit image objects. If an object other than an image has been selected, a dialog
appears, asking you if you want to convert it into an image object. Click the Yes button if you want to convert
it into an image and then edit it.

After an object is converted into an image, you can no longer change its attributes.

Toolz Help

. Menu item Description
ﬁf} Paint....
'[1 Crop.. Paint Enables you to paint on an image object. Select a
[ Efrect paint tool in the Paint Tool dialog, select an image
;‘: ghez'" Eifoct object on the Canvas, and then use the tool on the
300 BCL... f
= image.
. [] Button Effect...
[l Color Tone.. Crop Enables you to crop a part of an object to create an
e Bright;ess and Contrast image object. In the Crop Tool dialog, select the
H‘ iE shape of the area to be cropped. Then, on the Can-
o Al vas, specify the area of an object to be cropped. A
. Gradatian... duplicate copy of the specified area is created as a
’ B web Animator new image object.
Effect Applies an effect to an image object. In the Effect Pal-
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ette dialog, select an effect.

Shadow Effect

Adds a shadow to an image object. In the Shadow
Effect dialog, specify the direction and distance of the
shadow.

Button Effect

Applies a button effect to an image object. In the But-
ton Effect dialog, select Concave or Convex, and
specify the darkness of the shadow for the button by
moving the slider.

Color Tone

Adjusts the color tone of an image object. In the
Adjust Color Tone dialog, adjust the saturation, color
balance, and brightness of the object.

Brightness and Con-
trast

Adjusts the brightness and contrast of an image
object. Inthe Correct Brightness and Contrast dialog,
adjust the brightness and contrast of the object.

Red Eyes Corrects red eyes on a photographic image. In the
Correct Red Eyes dialog, specify the correct color of
the eyes and then click the red eyes.

Gradation Creates a gradation of your own. The gradation you

have created can be saved as a file and be applied
on a logo, a button, or a photo frame.

Web Animator

Starts Web Animator, one of the Homepage Builder's
accessory tools, for use in creating animated GIF files.




Help menu

Applying Homepage Builder

Use the Help menu to read the online help or to refer to the version information of WebArt Designer.

Help

Bl Help Topics

3 About \webSphere 'wabdrt Designer...

Menu item Description
Help Topics Displays the online help. In the Help Topics dialog,
look for the topic on which you want to display online
help information.
About WebSphere Displays the version of WebArt Designer.

WebArt Designer
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Toolbars

A toolbar contains buttons that correspond to the menu items that are used often. By using the toolbar, you
can perform operations just by clicking a button.

Standard toolbar

The Standard toolbar contains the buttons that are used most often.

Q}%
¥ o« o
S & §F
Q2 90
& IS
& & & &
O O 3 RN
o 2P Lo S
& o ST IT T 688D
s o & S I LTI F
2 F ¢ P2 P FIIT I T 5T ELSEEFS
FRFT P T T FIIFTE IS S S TR I @E S
DSB8 4 adolos @ D0 odh i

Image toolbar

The Image toolbar contains buttons used for editing image objects.

Q
&
N N Y &
S O Q& N
*~ O o
& K S S
E F G o
g T2 @
SRR & g o
S & & 9 F 9
S
S S S S QSO E
I mA s S e

Status bar

The status bar is at the bottom of the main window. If you move the mouse pointer over the main window, infor-
mation about the window component on which the pointer is placed is shown on the status bar.

For Help. prezs the [F1] kew. [153.118 |79:27 S
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Web Animator functions

Web Animator is a program for creating animated GIF files. An animated GIF is a
series of image files in GIF format, displayed sequentially to give the appearance of
an animation. You can insert an animated GIF into a page in the same way as a

regular GIF image file. You can create an animated GIF from either multiple

images or a single image. This section explains each component in the Web Ani-
mator main window and the functions you can invoke from the menu bar and the

toolbar.

Web Animator main window

The main window of Web Animator has the following components:

Menu bar Toolbars

5. WebSphere Web Animator - birth. gif

File

Edit Wiew Effect Play Window Help

Y = = =N = |

ol

- B

Ei birth.gif

HEEE BRI

Abtribute

1: Image 2 Image 3 Image 4 Image 5: Image

E b fs o I Il It Ioeb

Abtribute

1; Image 2 Image 2 Image 4; Image 5: Image £ Image 7

4

| I

Press the [F1] key ta show the help. | [Total number of images: 8 (3.750sec) |/

Status bar

é For instructions on using Web Animator, see Chapter 18.
&

—— Animation windows
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Animation window

An animation window is used for editing an animation. This window is displayed when you create a new ani-
mation or edit an existing one. A single animation window corresponds to a single animated GIF file. By open-
ing multiple animation windows, you can edit multiple animated GIF files at the same time.

An animation window is composed of two parts: the image display window (the upper part) and the frame dis-
play window (the lower part). Each element in an animation is called a frame.

newimagel =]

—— Image display window:
The frame selected in the
frame display window is
displayed here.

h W w: We vl | Frame display window:
The elements, or frames,
that compose the anima-

Attribute 1: Image 2 Image 3 Image 4: Image 5 Image

4 | D tion are displayed here in
the order in which they
are shown.

Menu bar

From the menu bar, you can access all the functions provided by Web Animator.

File  Edit “iew Effect Play ‘wWindow Help
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File menu

Use the File menu to manipulate animated GIF files. For example, you can start a wizard that enables you to
create an animation with easy operations.

File Edt Yiew Effect Play ‘windo

] Hew Ctrl+M

(= Open.. Cirl+0
Cloge

= Save.. Ctrl+5
Savefg..
Send Ta 3

FE Sawe Frame
ﬁ Simplified O ptimization

Custamized Optimization. .

”ﬁ, Animation YWizard...
b Open from Gallery...

Preferences...

Becent Files

E xit

Menu item

Description

New

Creates a new animated GIF file.

Open

Opens an existing animated GIF file. In the Open dia-
log, specify the file you want to open.

Close

Closes the current animated GIF file. If changes have
been made, a message appears, asking if you want to
save the changes.

Save

Saves the current animated GIF file. If the animation
has never been saved, the Save As dialog appears.

Save As

Saves the current animated GIF file with a new name.
In the Save As dialog, specify the file name.

Send To

¢ Homepage Builder: Inserts the current animated
GIF file at the position of the cursor in the page
editing area of Ho